
M obile Analysis
Guide

MicroStrategy ONE



M icr oSt r at egy ONE

Apr i l 2024

Copyright © 2024 by MicroStrategy Incorporated. All rights reserved.

Trademark Information

The following are either trademarks or registered trademarks of MicroStrategy Incorporated or its affi l iates in the United States and certain other
countries:

Dossier, Enterprise Semantic Graph, Expert.Now, Hyper.Now, HyperIntelligence, HyperMobile, HyperVision, HyperWeb, Intelligent Enterprise,
MicroStrategy, MicroStrategy 2019, MicroStrategy 2020, MicroStrategy 2021, MicroStrategy AI, MicroStrategy Analyst Pass, MicroStrategy Architect,
MicroStrategy Architect Pass, MicroStrategy Auto, MicroStrategy Cloud, MicroStrategy Cloud Intelligence, MicroStrategy Command Manager,
MicroStrategy Communicator, MicroStrategy Consulting, MicroStrategy Desktop, MicroStrategy Developer, MicroStrategy Distribution Services,
MicroStrategy Education, MicroStrategy Embedded Intelligence, MicroStrategy Enterprise Manager, MicroStrategy Federated Analytics, MicroStrategy
Geospatial Services, MicroStrategy Identity, MicroStrategy Identity Manager, MicroStrategy Identity Server, MicroStrategy Insights, MicroStrategy
Integrity Manager, MicroStrategy Intelligence Server, MicroStrategy Library, MicroStrategy Mobile, MicroStrategy Narrowcast Server, MicroStrategy
ONE, MicroStrategy Object Manager, MicroStrategy Office, MicroStrategy OLAP Services, MicroStrategy Parallel Relational In-Memory Engine
(MicroStrategy PRIME), MicroStrategy R Integration, MicroStrategy Report Services, MicroStrategy SDK, MicroStrategy System Manager, MicroStrategy
Transaction Services, MicroStrategy Usher, MicroStrategy Web, MicroStrategy Workstation, MicroStrategy World, Usher, and Zero-Click Intelligence.

The following design marks are either trademarks or registered trademarks of MicroStrategy Incorporated or its affi l iates in the United States and certain
other countries:

Other product and company names mentioned herein may be the trademarks of their respective owners.

Specifications subject to change without notice. MicroStrategy is not responsible for errors or omissions. MicroStrategy makes no warranties or
commitments concerning the availability of future products or versions that may be planned or under development.



CONTENTS

Using MicroStrategy Mobile 5

Common business scenarios for MicroStrategy Mobile 5

Overview: Creating documents for mobile 7

Overview: Creating apps with MicroStrategy Mobile 12

Viewing demo apps and dashboards: Restoring default settings 15

Getting Started with MicroStrategy Mobile for iPhone 1

Introduction 1

Analyzing Reports and Documents on an iPhone 20

Introduction 20

Getting Started with MicroStrategy Mobile for iPad 42

Analyzing Reports and Documents on an iPad 59

Introduction 59

Getting Started with MicroStrategy Mobile for Android 86

Introduction 86

Analyzing Reports and Documents on an Android device 106

Introduction 106

Designing Reports and Documents for Mobile Devices 119

Prerequisites 120

Best practices for designing reports and documents for mobile devices 120

Creating documents for mobile devices 127

Allowing users to filter data: prompts 173

Allowing users to filter data using filter panels 190



Organizing transactions with tables on iOS devices 191

Displaying data as interactive visualizations: Widgets 206

Adding widgets and visualizations to documents for mobile devices 206

Displaying widgets using the entire screen on mobile devices 283

Displaying widgets on iOS devices with a dark or light theme 284

Using links in documents 286

Opening a device's installed applications from documents 287

Linking to reports and documents from a mobile document 294

Using links to access features within the MicroStrategy Mobile application 312

Linking from documents with buttons and tab bars 316

Storing links on NFC tags on Android devices 326



Copyright © 2024 All Rights Reserved 5

Using M icr oSt r at egy M ob i le
Use MicroStrategy Mobile to distribute the power of analytics within your
enterprise. You can create a powerful custom mobile app that allows users
to view, analyze, and write-back information to your database or you can use
MicroStrategy Mobile simply as an extension of your MicroStrategy project
to view project documents, dashboards, and reports on mobile devices.

For an overview of what you can create with Mobile and how, see the
following:

l Common business scenarios for MicroStrategy Mobile, page 5: This
section provides examples of the kinds of documents and apps you can
create.

l Overview: Creating documents for mobile, page 7: This section provides a
workflow for creating documents for mobile devices and outlines the
considerations to take into account while creating documents for mobile
devices.

l Overview: Creating apps with MicroStrategy Mobile, page 12: This section
provides a workflow for creating mobile apps and outlines the
considerations to take into account while designing apps for mobile
devices.

l Viewing demo apps and dashboards: Restoring default settings, page 15:
This section provides steps to restore your app to MicroStrategy's default
settings.

Common business scenarios for MicroStrategy
Mobile

MicroStrategy Mobile can be used to support business activities, including
the following examples:

Mobile Analysis Guide
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l Instantly view data from any existing report or document to answer your
questions. If you are in a business meeting, Mobile ensures that the data
is up-to-date. Examples of documents and dashboards you can create with
Mobile are:

l A dashboard used to explore data in a strategic business meeting.
Dashboards allow users to change the graph used to display data and
create their own filters, thresholds, and metrics.

l A dashboard-style document that displays data on a business' bestselling
products and stores. Users can view inventory on bestselling products as
well as data on other products that are similar. The information in the
document is updated weekly.

l Instantly write information to your database. Transaction Services allow
you to create forms that automatically send information to your database.
Examples of how you can use Transaction Services are:

l A Corporate Request Center (CRC) app with selectors that allow users to
approve or deny time off, expenses, and purchase order requests. The
approvals and denials are automatically written to the database after
processing.

l A customer satisfaction survey document that asks customers to rate your
business on a scale and leave comments. You can ask customers to
complete the survey after a transaction.

l Distribute mobile apps within your organization, or in the Apple App Store
or Google Play. Mobile apps can support any recurring business needs
you have. Examples of apps you can create are:

l An app for your CFO with a high-level overview of your company's
performance that refreshes with up-to-date information biweekly.

l An app that displays product, sales, and inventory information for your
business and maps all items to store locations. Users can dril l down into
graphs and widgets for deeper analysis and also scan product barcodes to

Mobile Analysis Guide
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view item information. The data in the app is automatically refreshed on a
weekly schedule.

l Link together multiple mobile devices with MicroStrategy Mobile installed
on them to create a Command Center. You can use any of the linked
devices to control the data that displays on all other linked devices.
Changes made on one device, such as filtering or dril l ing, update the
display of the other linked devices. For steps, see the MicroStrategy
Developer Library.

l If you have Apple TV, you can display the output of each device on an
HDTV.

Overview: Creating documents for mobile

Dashboard-style documents form the basis of the apps and dashboards you
can create with MicroStrategy Mobile.

The following workflow describes the process of creating a document for
viewing on a mobile device. It assumes that you are familiar with designing
MicroStrategy reports and documents and have the necessary privileges to
do so.

Mobile Analysis Guide
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If users want to be able to create their own filters, thresholds, or change the
graph style used to display data, consider creating a dashboard instead of a
document.

To view sample RS documents created for each mobile device, in the
MicroStrategy Tutorial project, navigate to the Shared Reports folder. Click
MicroStrategy Platform Capabilities, then click MicroStrategy Mobile.
Select the folder to open based on the device you are using. The folder
displays with a list of reports and documents designed for that device.

To create a document for a mobile device

1. Based on how users will interact with the document, decide what
objects to add to the document.

• If users want to be able to see different subsets of data
depending on the situation, consider using a prompt or including
a table of selectors. Examples of how prompts and selectors can
be used are:

l Viewing data on a specific product. Create a prompt that asks the
user to type or scan the product's barcode. The data in the document
is filtered based on the product scanned.

l Searching for hospitals within a certain distance from the user.
Create a prompt that asks for permission to obtain the user's location
from their mobile device and a selector the user can use to define the
maximum distance of a hospital. The data in the document is filtered
to display only the hospitals that are within the distance defined by
the selector to the user.

For guidelines on creating prompts for mobile devices, see
Allowing users to filter data: prompts, page 173.

Mobile Analysis Guide
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2. If users want to be able to edit, add, or delete data from your database
with a mobile device, create documents that use Transaction Services.

▫ If you are designing for iPhones or iPads, consider using a
Transactions table to organize the Transactions data. For
example, you are creating a calendar of events and want
users to be able to add or edit events on the calendar. You
can use a Transactions table to easily create a form that asks
the user for event details and saves them to the database.
For steps, see Organizing transactions with tables on iOS
devices, page 191.

3. If you want to create a survey, where users are presented with a set of
questions they answer by selecting options from a list or by typing in
their answers, consider using a Survey widget. For steps, see
Gathering data from users: Survey widget, page 267.

4. To create a document that runs other applications on the mobile device
to perform a specific task, such as opening your mail app to send an
email, accesses specific features within MicroStrategy Mobile, such as
repeating a prompt on a document, or opens other documents or
reports, add a link. For more information on what you can do with links
and steps to create them, see Linking to reports and documents from a
mobile document.

5. To include videos and images in a document, use the Video Player and
Image Viewer widgets. For steps, see Downloading and playing videos:
Video Player widget, page 280 and Displaying images: Image Viewer
widget, page 219.

6. Based on the information users want to access and how they want to
use that data, decide how you will display data in your document.

• You can display important information in a docked header or
footer. Docked headers and footers are always visible at the top

Mobile Analysis Guide
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and bottom, respectively, of the screen as the user scrolls up or
down in the document. For steps, see Allowing users easy
access to document content: docked headers and footers, page
164.

• You can inform users of important information, such as new
content or updates, by displaying and update a badge displayed
next to the MicroStrategy Mobile application icon on a user's
iPhone or iPad. For steps, see Notifying users: Displaying a
badge next to the MicroStrategy Mobile application icon, page
167.

• You can create a simple graph to display your data. Many graph
types are available, such as overlapping bar graphs and pie
graphs.

For interactive graphs, such as a data cloud, graph matrix, or
map, consider using a widget. For a description of each widget
you can use and steps to create them, see Adding widgets and
visualizations to documents for mobile devices, page 206.

7. Design your document based on how you want the user to interact with
your document and the mobile device they are using. For best results,
follow the guidelines listed in Best practices while planning reports and
documents, page 121.

For iPads and Android tablets, it is recommended that the document be
the same size as the screen of the device. If you cannot fit all the
objects you need in one document, consider splitt ing the document into
multiple documents and linking them together, or use one of the
following techniques:

l Group small sets of related data together into panel stacks. For
information on creating panel stacks for mobile devices, see Allowing
users to access information easily: mobile-friendly panel stacks, page

Mobile Analysis Guide
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146.

l Place detailed data in an Information Window that displays when the
user taps on another object. For example, you are creating a
document with a scatter graph. You can create an Information
Window that displays when the user taps on a bubble in the scatter
graph, with detailed information on the bubble. For steps, see
Providing additional information to users: Information Windows, page
149.

8. Create the datasets that support your document. You can import data
from your database or use an already existing report or Intelligent
Cube.

9. Create the document based on your design. For best results, follow the
guidelines listed in Best practices while creating reports and
documents, page 125. For device-specific guidelines, see Creating
documents for mobile devices, page 127.

10. If the document is going to be viewed on devices with different screen
sizes, format the document so it displays properly on all devices. For
steps, see Formatting documents for mobile devices, page 130.

11. Distribute the document. If the document is part of an app, deploy the
app within your organization or on the App Store. For steps, see
Deploying and configuring the MicroStrategy Mobile application.
Otherwise, place the document in the Shared Reports folder of your
MicroStrategy project. All users with permission to view the folder are
able to view the document from their mobile device.

12. If you have MicroStrategy Enterprise Manager, you can fine-tune the
design of your app based on user statistics. Enterprise Manager is a set
of pre-built documents that display data on how people are using your
app, such as what device they're using, which documents they view the
most, and app performance. You can also create your own documents
with the statistics that Enterprise Manager collects.

Mobile Analysis Guide

MobileDesignAndAnalysis/Deploying_and_configuring_the_MicroStrategy_Mobile.htm#admin_1334452462_1105770


Copyright © 2024 All Rights Reserved 12

Overview: Creating apps with MicroStrategy Mobile

You can use MicroStrategy Mobile as a platform to create mobile business
intelligence (BI) apps for your organization. By linking dashboard-style
documents and dashboards together, you create the experience of a mobile
app. Using visualizations and widgets, users can analyze data and make
decisions based off that data as they receive it.

The app you create uses a dashborard-style document that serves as a
home screen and links to other documents of interest. The home screen
displays when users open your Mobile application instead of MicroStrategy's
default interface. For example, the CFO Dashboard demo app has a home
screen that links to documents for financial performance, what-if analysis,
and so on, as shown in the following figure:

Mobile Analysis Guide
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To create a mobile app

1. Evaluate what the users need and the workflow that they require. It is
useful to know the following:

l The users' current problems, their goals, and their expectations

l The mobile device(s) the users are using for the app.

2. Define the purpose of the app and the key issues the app solves. Based
on this, determine the data required for the app and whether your
database contains that data.

3. Create a diagram of the documents you are designing and how users
will navigate between them. Design the documents to accomplish your
users' tasks and the navigation system to support your users' workflow.
Best practices while designing documents are described in Best
practices while planning reports and documents, page 121.

You can have users navigate the app with:

l A menu bar with buttons that link to the main documents in your app.
The menu bar displays at the bottom of all documents that it is linked
to.

l Swiping left or right to view each new screen. This is useful for apps
that have a linear workflow or for apps whose main purpose is to
showcase information. Do this by creating a panel stack that fi l ls the
screen of the device and adding a docked panel selector to the stack.
Each panel in the stack is a separate screen.

l A link embedded in a document. You can create links to documents
from a text field, image, button, or attribute element. Depending on
the device you are designing for, you can create links that fi lter the
data of the document they link to based on the object the user
selects.

Mobile Analysis Guide
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4. Create the documents that make up your app and link them together
based on your diagram.

To create the feel of a standalone app, designate one of the documents
you create as the home screen for your app, which you configure to
display when the application opens. Consider adding a button to your
home screen with a link to MicroStrategy's device-specific help, which
provides instructions for your users on how to interact with widgets and
reports, and so on. To create a link to the help, see Using links to
access features within the MicroStrategy Mobile application, page 312.

For high-level steps to create a document, see Overview: Creating
documents for mobile, page 7.

5. If you are creating a custom home screen for the app, create a mobile
configuration that configures users' devices to load the custom home
screen when the application loads. For steps to create a mobile
configuration, including steps to define a custom home screen, see
Administering MicroStrategy Mobile.

6. By default, users log in to your mobile app using their MicroStrategy
user name and password. You can customize the way users log in to
your app, by requiring a custom token when they log in or allowing them
to use their Facebook credentials to log in. You can also have users log
in separately for each project they want to access, or re-direct users to
a different page when they cannot log in. For detailed information on
how you can customize the way users log in to Mobile, see the
MicroStrategy Developer Library.

7. Distribute your app to a preliminary set of users to gather feedback on
whether your app addresses your users' needs. You can also test how
easily users navigate and use your app. Redesign components of your
app as necessary based on user feedback.

Mobile Analysis Guide
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8. Distribute the app to users within your organization, on Google Play, or
on the Apple App Store. For steps to deploy and configure your app for
all mobile devices, see Administering MicroStrategy Mobile.

You can create customized versions of the MicroStrategy applications
that use your organization's branding. For the requirements and steps
to build customized applications, see the SDK page of MicroStrategy
Community.

To access the MSDZ, you must create an account in the MicroStrategy
Knowledge base, at the following URL:
https://resource.microstrategy.com.

9. Update and maintain the app as necessary. Most apps require periodic
refreshing so the data they contain is relevant and up-to-date. To
automatically refresh the data, you can create subscriptions for users
to send them updated data on a schedule.

Viewing demo apps and dashboards: Restoring
default settings

On the iPhone or iPad, you can restore your custom Mobile app to the
MicroStrategy default project settings to view the latest demo apps that
MicroStrategy provides and see examples of the latest features.

To restore your Mobile app to the MicroStrategy default app sett ings

1. From the iPhone or iPad home screen, tap Settings.

2. From the list of apps on the left, tap one of the following:MicroStrategy

l If you want to reset the Mobile app, tap .

l If you want to reset the Good Dynamics app, tap MicroStrategyGD.

3. Tap Reset Application.

Mobile Analysis Guide
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You can return to your custom Mobile app by re-installing it, either by
downloading it from your company's internal website or clicking a
configuration URL in an email from your administrator.

Mobile Analysis Guide
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Getting Started with MicroStrategy Mobile for iPhone

Introduction
This section provides an overview of basic tasks that analysts can perform
with MicroStrategy Mobile for iPhone.

The steps and images in this section are based on the default settings of the
application. Your interaction with the application depends on the
configurations made by your administrator. For information on customizing
MicroStrategy Mobile, see the MicroStrategy Mobile Administration Help.

If you are designing reports and documents for the iPhone, see the
MicroStrategy Mobile Administration Help.

For information on installing and configuring MicroStrategy Mobile for
iPhone, see the MicroStrategy Mobile Administration Help.

Prerequisites

• You must have the following privileges:

l Use MicroStrategy Mobile for all projects containing reports or documents
that you want to view.

l Mobile View Document

For information on privileges, contact your administrator.

Getting started with MicroStrategy Mobile for iPhone
It is recommended that you install the MicroStrategy Mobile application sent
to you by your administrator.

Mobile Analysis Guide
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To run the MicroStrategy application on your iPhone, tap the MicroStrategy
Mobile icon. You may be prompted for your MicroStrategy user name and
password.

When the application opens, the MicroStrategy Home screen is displayed,
as shown below.

The Home screen lists the projects your device is connected to. You can use
the Home screen to browse these projects and run reports and documents.

The format of the Home screen may vary according to how your
administrator has configured it. Buttons may open a report, launch a micro
application, open a folder for browsing, and so on. For information on
customizing the Home screen, see the MicroStrategy Mobile Administration
Help.

To access different areas of your application, swipe to the right to display
the navigation menu. You can access the navigation menu from any screen
outside the reports and documents in your app. The options in the navigation
menu are described below:

Mobile Analysis Guide
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l Home: Displays the list of projects your device is connected to.

l Recently viewed: Displays reports and documents that you have recently
accessed.

l Subscriptions: Displays reports and documents that you are subscribed
to.

l Offline Transactions: Some documents may include forms that you can
fil l out and send back to your company's database. The Offline
Transactions screen displays a list of documents that will send information
to your company's database once you are connected to the Internet.

l Report Queue: While a report or document is opening, you can tap View
Later to download the report or document in the background and continue
using your app. The Report Queue displays the reports and documents
that were downloaded.

l Settings: Allows you to configure the MicroStrategy Mobile servers and
projects that you are connected to, and general administrative and display
options.

It is recommended that you configure the application using the
configuration URL that you receive from your administrator.

l Learn more: Displays MicroStrategy's Mobile website.

l Help: Displays the Help for the application.

To close the navigation menu, tap the navigation menu icon .

Receiving alerts when data meets certain conditions: Push
notifications

You can configure MicroStrategy to send an alert to your iPhone when a
metric on a report meets a specific condition. For example, you can choose
to receive an alert if the Profit data in a report drops below $50,000. These
alerts are called push notifications, and can be received even if the

Mobile Analysis Guide
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MicroStrategy iPhone application is not running. For information on setting
up push notifications, see the MicroStrategy Mobile Administration Help.

Enabling and disabling alerts

You enable or disable alerts using your iPhone's Settings screen.

The procedure below refers to software produced by third-party vendors and
thus is subject to change. MicroStrategy makes no guarantee on the
availability or accuracy of third-party documentation.

To enable or disable push notificat ions

1. On your iPhone's Home screen, tap Settings.

2. Tap Notification Center. The Notification Center page opens, with a
list of applications that can send you alerts (push notifications).

3. Tap MicroStrategy.

4. Turn the Show in Notification Center switch on or off.

5. If you have enabled notifications, configure the push notifications, as
described in the following steps:

a. Choose an Alert Style from the list:

l None: No alerts are displayed for push notifications.

l Banners: Display at the top of the iPhone screen. Tap a banner
to open MicroStrategy Mobile. If you ignore the banner, it will
close automatically.

l Alerts: Display as a pop-up window on the iPhone. Tap a button
to open MicroStrategy Mobile or close the alert.

a. Turn the Sounds switch on or off.

Mobile Analysis Guide
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b. Turn the View in Lock Screen switch on or off.

6. Push the Home button to return to the iPhone's Home screen.

Sorting the list of reports, documents, and folders

Some screens, such as the Home screen and the Subscriptions screen,
contain a list of fi les, such as reports, documents, and folders, that you can
sort. Sorting can make it easier to find the report or document you want or
identify which files were updated so you can see new data. By default, fi les
are sorted by name.

To sort by the name of the file, the date the file was last modified, or the type
of file, tap the Sort icon at the top. Select Name, Last Modified, or Type,

depending on how you want to sort the folder.

You can also sort by the date the files were last downloaded to your iPhone.
From the navigation menu, select Settings. Turn on Show Timestamp
Options. Return to the screen with the files you want to sort, tap the Sort
icon , and select Last Updated.

Running and viewing reports and documents
Once you have started MicroStrategy Mobile, you can view reports and
documents on your device.

Some reports and documents may prompt you with questions when the
report or document is run. The answer you provide to a prompt determines
the data that is displayed on a report or document. For steps to answer
prompts, see Answering prompts in MicroStrategy Mobile for iPhone, page
16.

This section contains information about the following:

Running reports and documents

You can locate and run reports and documents in the following ways:

Mobile Analysis Guide
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l Running them from a list of subscribed-to reports and documents. For
steps, see Running subscribed-to reports and documents, page 6.

l Browsing to their location within a project. For steps, see Locating and
running reports and documents, page 7.

l To update the list of reports and documents, drag the screen down.

Running subscribed-to reports and documents

You can quickly access reports and documents that you have subscribed to
using the Subscriptions button in the navigation menu on the left.

Subscribing to a report or document causes your iPhone to automatically
download the report or document on a defined schedule, which allows you to
open the report or document quickly and access it at any time. For steps to
subscribe to a report or document, see the MicroStrategy Web Help.

To run subscribed-to reports and documents

1. Within MicroStrategy Mobile, swipe to the right to display the navigation
toolbar.

2. Tap Subscriptions. A list of subscribed-to reports and documents is
displayed.

3. Tap a report or document on the list to run it. The report or document is
displayed.

For information on viewing and navigating reports, see Viewing and
navigating data in a grid or graph report, page 8.

For information about viewing and navigating documents, see Viewing
and navigating data in a document, page 12.

Mobile Analysis Guide
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Locating and running reports and documents

You can run reports and documents by navigating to where they are located
within a project that your iPhone is connected to.

To locate a report or document, you must have the proper permissions in
MicroStrategy to access the folders containing the report or document. For
information about the permissions that are assigned to you, contact your
administrator.

To run reports and documents from a folder within a project

1. From the default Home screen, tap the name of the project you want to
browse. The folders within the selected project are displayed.

2. Browse to the folder that contains the report or document that you want
to run. A list of reports and documents is displayed.

3. The icon next to the report or document name indicates whether it is a
grid report, graph report, document, or dashboard.

l Grid reports:

l Graph reports:

l Documents:

l
Dashboards:

4. To make it easier to find the report or document you want, you can sort
the contents of the folder by name, the date the file was last modified,
or the type of file. Tap the Sort icon at the top. Select Name, Last

Modified, or Type, depending on how you want to sort the folder.

You can also sort by the date the files were last downloaded to your
iPhone. From the navigation menu, select Settings. Turn on Show

Mobile Analysis Guide
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Timestamp Options. Return to the screen with the files you want to
sort, tap the Sort icon , then select Last Updated.

5. To view the report or document details, tap the i info button next to

the report or document's name. A description of the report or document
displays, along with the dates it was last modified and refreshed.

To return to the list of reports and documents, tap the back arrow icon
at the top of the screen.

6. Tap a report or document on the list to run it. The report or document is
displayed.

For information about viewing and navigating reports, see Viewing and
navigating data in a grid or graph report, page 8.

For information about viewing and navigating documents, see Viewing
and navigating data in a document, page 12.

As you navigate the projects you are connected to, the name of the folder
you are currently in displays at the top of the screen. To return to a folder
you were in before, swipe the current folder's name to the right, then tap the
name of the folder you want to return to.

Viewing and navigating data in a grid or graph report

There are two types of MicroStrategy reports: grid reports and graph reports.

l Grid reports display business data organized in rows and columns.

l Graph reports present data visually in styles such as a bar, line, or pie
graph.

The following actions can be applied to most grid and graph reports after
they have been displayed:

Mobile Analysis Guide
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l To switch between full screen mode and non-full screen mode, tap the
report.

Full screen mode displays as much data on the screen as possible.

Non-full screen mode displays a navigation bar at the top of the grid. The
navigation bar shows the back button and the report name.

l If the report is in full screen mode, you can display the report's tit le, switch
the page-by group, or exit the report by tapping the action button .

l To change the orientation between portrait and landscape, rotate the
device.

l To scroll across a report, swipe the screen horizontally. To scroll up and
down a report, swipe the middle of the screen vertically.

l To change the group of data that is displayed, tap the currently displayed
group of data at the top of the report and choose another group. You can
also perform a horizontal swipe at the edge of the screen to move between
groups of data.

The currently displayed group of data appears in the page-by bar at the
top of the report.

The following sections show examples of grid and graph reports displayed
on an iPhone:

l For examples of grid reports on an iPhone, see Viewing and navigating
data in grid reports, page 9.

l For examples of graph reports on an iPhone, see Viewing graph reports,
page 10.

Viewing and navigat ing data in grid reports

Grid reports are the most commonly used type of report. A grid report
organizes business data into rows and columns. The image below shows a
grid report displayed on an iPhone.

Mobile Analysis Guide
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Some reports are designed to have data automatically appear with special
formatting depending upon certain conditions (such as sales over $1 million,
or inventory below 50). This is called conditional formatting.

The data that meets the condition is considered to be data that has passed
the threshold of the condition; once data passes the threshold, the
formatting is applied. Thresholds are cells of data that are formatted
differently from the rest of the data on a report.

In the example report above, the report uses thresholds in the Cost column.

Viewing graph reports

Graph reports present data visually in a style such as a bar, line, or pie
graph. The images below provide examples of graph reports displayed in
MicroStrategy Mobile for the iPhone.
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l To view tooltips to explain parts of a graph, such as a single bar in a bar
graph, tap and hold on the screen.

l To zoom, perform a pinch on the center of the screen or double-tap the
center of the screen to switch between a zoomed-in view and a zoomed-
out view.
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Viewing and navigating data in a document

Documents are used to present data from multiple reports in a presentation-
quality format. They can contain a variety of graphics and text, depending
upon their design.

The following actions can be used to view and navigate data in a document.
Some of these actions may be disabled by the designer. For more
information about designing documents for use on the iPhone, see the
MicroStrategy Mobile Administration Help.

l Switch between portrait and landscape orientations by rotating the device.

l Zoom in or out on a document by performing a pinch on the center of the
screen or double-tapping the center of the screen.

The following example shows a basic document displayed on an iPhone.

Switching between panels in a document: panel stacks

A document may contain panels that you can switch between, similar to
slides in a slideshow.
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You may be able to switch between panels by tapping a button or link, or by
swiping left or right.

Some panels contain a gray bar at the bottom with a row of circles, as shown
below. Each circle represents a panel and the currently displayed panel is
marked with a dark circle.

To switch between panels, swipe left or right.

Viewing and navigat ing tabs in a document

A document may contain multiple tabs across the bottom of the document,
called layouts. To view a layout, tap the tab with the layout's name.

Each layout functions as a separate document and can have its own
grouping of data, formatting, and so on. The following examples show two
different layouts from the same document.

The following examples show two different layouts from the same multi-
layout document.
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Sharing reports and documents via email

You can share a screenshot of a MicroStrategy report or document with your
contacts using email. Your recipients do not need to have MicroStrategy
installed to view the screenshot. The steps to share a screenshot are as
follows.
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Prerequisites

• You must have configured an email account on your iPhone.

To share reports via email

1. In MicroStrategy Mobile, open a report or document that you want to
share with your contacts.

2. In the top-right corner, tap the Menu button . The context menu

opens.

3. Tap the Email icon . A new email message is composed, with a

screenshot of the report attached.

4. Type the email addresses of your contacts in the To and Cc/Bcc f ields,
as applicable.

5. Once you have composed the email, tap Send. The email is sent.

Printing reports and documents

If you have an AirPrint-capable printer available on your network, you can
print a copy of your report or document, as described in the steps below. For
a complete list of printers that support AirPrint, as well as information about
configuring an AirPrint printer, see your Apple documentation.

Prerequisite

l You must have an AirPrint supported printer on your network to be able to
print from your iPhone.

To print reports and documents

1. In MicroStrategy Mobile, open a report or document that you want to
print.
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2. In the top-right corner, tap the Menu button .

3. Tap the Print icon . The Printer Options dialog box opens.

4. To choose a printer, tap Printer. A list of available printers is
displayed.

5. Tap the name of the printer you want to print from. The printer is
selected, and you are returned to the Printer Options dialog box.

6. To change the number of copies to print, use the plus + and minus -
buttons.

7. If your printer supports double-sided printing, turn the Double-sided
switch on.

8. When you are satisfied with the settings, tap Print.

Answering prompts in MicroStrategy Mobile for iPhone
Some reports and documents may ask you to choose what data is displayed
by asking you questions, called prompts. Prompts allow you to display only
the data that you want to view.

The following table lists the types of prompt you may have to answer and
steps to answer them.

Type of
Prompt

Answering the prompt

Calendar

To select a date, tap it.

To select a range of dates, tap and hold the start date, and drag until the
end date.

Date/time
wheel

Scroll through the columns to select a date and time.

Text prompt Tap inside the text box to begin typing an answer.

Numerical Drag the slider to choose a value.

Mobile Analysis Guide



Copyright © 2024 All Rights Reserved 17

Type of
Prompt

Answering the prompt

slider

Numeric
stepper

Tap the plus or minus button to select a value.

Numeric
wheel

Scroll to the value you want to use.

On/Off
switch

Slide the switch to turn it on or off.

Location

Tap the button to use your current location.

You are prompted for permission to use your location.

Barcode

Use your device's camera to scan a barcode or QR code.

To manually enter a barcode, tap the keypad button and enter the

number that corresponds with the barcode.

Selections
from a list

For a list of possible selections, tap the name of the list. Tap an item in the
list to select it. The item you select is displayed in the report or document.

If an arrow icon displays next to an item, then the item itself may contain
one or more lists. Tap the arrow icon to display the lists, then tap the lists to
view the items you can select from the list.

To change the list so that the items you select are excluded from the report
or document, tap in list next to the list's name.

To de-select an item, tap the item again. To de-select all items in a list, tap
the X next to the list's name.

Using the Prompts screen

The Prompts screen displays the prompts associated with a report or
document and your response to them. The Prompts screen displays if one or
more of the following conditions are met:
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l The report or document contains at least one prompt

l You have not opened this report or document before

l You have not saved your previous answers to the prompts in this report or
document

l An answer you provided does not meet the prompt's requirements

The Prompts screen displays each prompt's name, description, and the
answers you have provided. Tap the name of a prompt to answer it.

If the answer you have provided does not meet the prompt's requirements,
the requirements are displayed in red text.

To change your prompt answers before running the report, tap the name of
the prompt that you want to revise.

When the prompt's answer requirements are met, tap Apply to run the
report. If you want to change your prompt answers after you run the report,
tap the Menu button , then tap the Prompts icon to display and edit

your prompt answers.

Achieving the best response from MicroStrategy Mobile
The speed at which your list of reports is retrieved and reports are refreshed
in MicroStrategy Mobile depends on several factors:

l Your mobile service provider.

l The time at which you are accessing the reports and documents.

The speed at which a report or document opens in MicroStrategy Mobile
depends on several factors:

l The amount of usable memory on the mobile device.

l The processor speed of the mobile device.

l The version of the mobile device.
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l The size and contents of the reports and documents.

For best practices to create reports and documents for use with
MicroStrategy Mobile, see the MicroStrategy Mobile Administration Help.

Consider creating subscriptions to your most commonly used reports and
documents. This will give you access to them in the Reports folder on your
Home screen, and will pre-load their contents on your device so that they
will open more quickly. For steps to subscribe to a report or document, see
the MicroStrategy Web Help.

Mobile Analysis Guide

https://www2.microstrategy.com/producthelp/2021/MobileAdmin/WebHelp/Lang_1033/Content/home.htm


Copyright © 2024 All Rights Reserved 20

Analyzing Reports and Documents on an iPhone

Introduction
This chapter describes some of the tasks that an analyst can perform to
analyze data in a MicroStrategy report or document using MicroStrategy
Mobile on an iPhone. The following topics are covered:

l Analyzing reports and documents on an iPhone, page 20

l Interacting with data, page 27

After you run a report or document in MicroStrategy Mobile, you can view
data at different levels, view a subset of data, and analyze data using
interactive graphs. You can also follow links to display different reports or
documents, or to access iPhone functionality such as sending email or
placing phone calls.

Prerequisite

This chapter assumes you are familiar with the information provided in
Chapter , Getting Started with MicroStrategy Mobile for iPhone.

Analyzing reports and documents on an iPhone
You can interact with MicroStrategy reports and documents that are
displayed on an iPhone to analyze the data. This section provides details to
perform the following:

l Sorting data in a grid report, page 21

l Viewing data at different levels: dril l ing, page 22
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l Viewing reports and documents: links, page 22

l Using documents to send or update data in your data warehouse:
Transaction Services, page 25

l Viewing a subset of data: changing your prompt answers, page 24

l Copying text from documents, page 24

You can also view details about a specific point on a graph report. For more
information, see Viewing more information about a point on a graph: tooltips,
page 25.

Sorting data in a grid report

Sorting allows you to reorganize the way data is displayed so that you can
analyze it more effectively. For example, you could sort the data in a report
in descending order of profit to get a quick idea of your most profitable
products.

To sort data in a grid report

1. Tap and hold the column header you want to sort your data by. The
context menu opens.

2. Tap Sort. The Sort menu opens, for sorting in ascending or descending
order, as shown below.

3. Tap Sort Ascending, or Sort Descending, as applicable.
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Viewing data at different levels: dril l ing

Some MicroStrategy reports and documents allow you to view information at
lower, more detailed levels or higher, summarized levels. For example, a
report can display time at the year level by default, but can also display data
grouped by quarter or month.

You may be able to change the level at which you are viewing data by
tapping an object. In the example above, tapping ACS Innovations displays
data for each category of products sold by ACS Innovations.

To go back to the level you were at previously, tap the back arrow in the top
left.

If dril l ing was enabled for a report or document, you can dril l from page-bys,
attributes, or metrics. Dril l ing is enabled by the designer. For an introduction
to dril l ing, see the Basic Reporting Guide.

Viewing reports and documents: links

Some documents may contain links that you can use to open a report or
another document, navigate to another location in your app, or open another
application on your iPhone.

To open a link in a document, tap the link. The link may be an image or a text
field. The function and appearance of a link depends on the way it was
designed.
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Tapping on a link may change the following properties of the report or
document that the link executes:

l The group of data displayed in the report or document

l The prompt answers that are used in the report or document

l The view of the report: as a grid, as a graph, or as a grid and graph

l If the document contains multiple tabs, called layouts, the tab that displays
when the document opens

For steps to create links in documents, see the MicroStrategy Mobile
Administration Help.

Opening iPhone applications in documents using links

Some documents may contain links that you can use to interact with
applications that are stored on your iPhone. Tap the link to open the
application. The link may be an image or a text field. The function and
appearance of a link depends on the way it was designed.

A link in a MicroStrategy document may open one of the following
applications on your iPhone:

l Email

l Phone

l SMS (text)

l Maps

l Videos

For example, a MicroStrategy document displays sales information for a
particular product, including how the product is selling and which stores
carry it. The document contains links to applications on your iPhone, which
you can tap to:
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l Open a video demonstrating the product

l View a map of the nearest stores that carry the product

l Call the store to see if they have the product in stock

The document designer determines how these applications are accessed on
the document, and what actions the applications perform. For more
information on creating links that open other iPhone applications, see the
MicroStrategy Mobile Administration Help.

Viewing a subset of data: changing your prompt answers

MicroStrategy reports and documents that present you with a question use
your prompt answers to display a subset of data. Some reports and
documents may allow you to change your prompt answer to display different
subsets of data without having to re-execute the report.

To change your prompt answers, tap the Menu button ( ) at the top of the

report or document, then tap the Filter button ( ). The Filter screen is

displayed, and you can change your prompt answers.

Copying text from documents

You can copy text from a document. First, select the text to copy by tapping
and holding the text. If zoom is disabled, you can also select the text by
double-tapping it.

If you do not know whether or not zoom is enabled, double-tap the text. If
zoom is enabled, double-tapping zooms in or out.

From the pop-up menu that displays, choose to copy the selected text or
select all the text in the text field.

If the text is displayed in the Detail section of a document, you must tap the
text.
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Viewing more information about a point on a graph: tooltips

A tooltip displays detailed information about a specific data point on a graph
report. Tooltips provide information such as the value of a specific data
point, the name of a group, or the label of a graph's X-axis. An example of a
tooltip in a boxplot graph is shown below:

To display a tooltip on a graph report, tap and hold on a data point on the
graph.

Using documents to send or update data in your data warehouse:
Transaction Services

Some documents may include forms that you can use to edit or add
information to your data warehouse through Transaction Services. Some
examples are documents that approve requests, track business activity, and
execute business decisions, directly from your mobile device. Any new data
or changes are saved in your data warehouse.

Prerequisites

To use a Transaction Services-enabled document, you must meet the
following criteria:
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l You must have Transaction Services.

l You must have the Execute Transaction privilege.

l The Transaction Services-enabled document must already be created.

Using Transact ion Services-enabled documents

Depending on the way the document is designed, you may be able to
manipulate data in the following ways:

l Edit text or numerical values in a text box.

l Use a slider to select from a range of values.

l Select values from a drop-down list.

l Use an On/Off switch for Yes or No conditions.

l Use a date/time wheel to select a date.

l Use your device's camera to scan a barcode. To manually enter a barcode
or QR code, tap the keypad button and enter the number that

corresponds with the barcode.

Once you have completed your manipulations, you may be able to perform
one or more of the following:

The designer may use different names for the buttons or links described
below.

l To preview the results of your changes in the Grid/Graph without updating
your data warehouse, tap Recalculate.

l To update your data warehouse with the values you provided, tap Submit.

If you are not connected to the internet, the document as added to the list
of offl ine transactions that are pending changes. Your changes are sent to
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your data warehouse when a connection is available. For steps to edit
your pending changes, see To edit pending transactions, page 27 below.

l To undo the changes you have made, tap Discard Changes. The
document reverts to the values from the last time you submitted data.

To ed i t pend ing t r ansact ions

1. In the document's header, tap the Offline Transactions button: . A

list of the transactions that are pending changes are displayed.

2. To change the values you want to submit, tap a transaction in the queue
to select it, and then tap Edit.

3. To delete a transaction, tap the transaction in the queue to select it,
and then tap Delete.

4. To view transactions for all documents that are pending changes, tap
the list icon , then tap the document whose transactions you want to

edit or delete.

Interacting with data
Documents displayed on an iPhone can contain interactive objects you can
use to analyze data, upload or download files, and so on.

For examples of interactive objects you can use to analyze data, and
instructions to analyze the data that they contain, see the following sections:

l Analyzing data in a tabular layout: Interactive Grids, page 28

l Analyzing data on a Map: Maps, page 31

l Analyzing data at a glance: Microcharts, page 35

l Analyzing data on a time-based graph: Time Series, page 37

For instructions to use interactive objects that allow you to view videos,
upload images, and download files, see the following sections:
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l Downloading multimedia files: Multimedia, page 38

l Uploading images to your data warehouse from your camera or photo
album, page 39

l Browsing a gallery of images: Image Viewer, page 40

l Playing videos: Video Player, page 40

Analyzing data in a tabular layout: Interactive Grids

Some documents may display data in an interactive grid, as shown in the
example below.

In this interactive grid, attributes and metric values are displayed in the
columns and rows, and grouping appears at the top of the screen.

The actions that you can perform depend on how the table was designed.
You may be able to do the following:

l If a column has an orange triangle above its tit le, the column contains
more than one metric. You can tap the column's title to switch between
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metrics.

l To sort the grid by a column, tap and hold the title of the column. Click
Sort, then choose Ascending or Descending to sort the grid by the
column.

l To undo a sort, tap and hold the title of the column you used to sort the
grid. Click Clear Sort.

l To display different groups of data, tap different page-bys.

l Tap on objects to dril l. For more information about dril l ing, see Viewing
data at different levels: dril l ing, page 22.

l Tap on objects to follow links. For more information about linking, see
Viewing reports and documents: links, page 22, and Opening iPhone
applications in documents using links, page 23.

l To toggle between full screen and non-full screen mode, tap the center of
the screen once.

l To switch the page displayed, swipe across the screen.

Analyzing Hierarchy Reports

Unbalanced hierarchies are hierarchies with branches that descend to
inconsistent levels. For example, in an Employee hierarchy, different parts
of the organizational structure will have more management levels than
others.

Many organizations have aspects of their business that are organized in
unbalanced hierarchies. Besides the Employee hierarchy, other typical
examples include a chart of accounts, complex product portfolios, and
multinational geographic groupings.

Hierarchy Reports are a class of reports in which the data is naturally
organized and presented in a hierarchical structure. Hierarchy Reporting
features treat hierarchies as a first-class citizen, and make interacting with
entire hierarchies intuitive and efficient. Both balanced and unbalanced
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hierarchies may be represented in a hierarchy report, although unbalanced
hierarchies benefit the most from Hierarchy Reporting features.

Hierarchical Attr ibutes

To facilitate the building of hierarchy reports, there is a new type of
attribute: the hierarchical attribute. The hierarchical attribute represents an
entire hierarchy and all its levels. For example, you may have a Time
hierarchical attribute that represents the Time hierarchy, including its levels
Year, Quarter, Month, and Day. In contrast, a normal attribute usually
represents a single level of a hierarchy (for example, Year). The hierarchical
attribute appears on a grid, fi ltered, and sorted, much like a normal attribute.

Navigat ing Hierarchy Reports

Navigate through the hierarchy by expanding and collapsing the hierarchical
attributes using the plus (+) and minus (-) icons. You can also tap the cell
directly above the top level of the hierarchy and choose Expand/Collapse
>Expand All or Collapse All.

Sort ing Hierarchy Reports

When a report with a hierarchical attribute is sorted, the structure of the
hierarchy remains intact, so every element retains its parent in the hierarchy
tree. Each level of the hierarchy is sorted separately from the other levels.

To sort on a hierarchy or a metric, tap the cell directly above the top level of
the hierarchy and choose Sort Ascending or Sort Descending.

Filter ing Hierarchy Reports

To filter a Hierarchy report, tap the Filter icon to open the Filter panel. Then,
tap the filter you want to use. The Filter panel displays the elements of the
hierarchy in a tree. Expand or collapse the filters using the plus (+) and
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minus icons. You can also expand or collapse all of the filters by tapping
Expand/Collapse >Expand All or Collapse All.

Analyzing data on a Map: Maps

Some documents may display data based on locations on a map, as shown
below.

The map uses pins to represent nearby stores. Stores with pins that overlap
each other are grouped together, with the number of pins in the group
marked in the circle.

Some maps may show image markers or the color concentrations of a
density map, instead of pins. For an example of a density map, see
Analyzing data on a Map: Map, page 71.

The document containing a map may prompt you for your current location, so
that the map can show locations that are within a given distance from your
current location. For instructions to answer prompts on an iPhone, see
Answering prompts in MicroStrategy Mobile for iPhone, page 16.
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Depending upon how the map was designed, you may be able to:

l Swipe to a different area on the map.

l Zoom in or out by pinching the map. For some maps, markers are
displayed instead of colors as you zoom in.

l Rotate the map by placing two fingers on the map and spinning them.

l View more information about a specific marker, by tapping the marker on
the map.

l Switch between Map, Satellite, and Hybrid views. Tap the Settings icon

, tap Style, and then tap the appropriate button.

l Select a different metric to display with the markers. Tap the Settings icon
, tap Map Based on, and select the metric you want to display.

l You can ungroup markers. Tap the Settings icon , tap Marker Type,

and turn off Advanced Clustering.

l You can display or hide text with a marker's metric value instead of the
marker. Tap the Settings icon , tap Marker Type, and select either

Marker or Text. The map shown below has metric text displayed.
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If Advanced Clustering is turned on, the metric text is for the group of
markers.

l You can select a set of locations to analyze by creating a region. To do
this, tap the Select icon , and do one of the following:

l To select locations within a certain radius of a central location, tap the
Circle icon. Tap the central location, then drag your finger outward until
the radius is as large as you want. As you draw, the radius of the circle,
in miles, is displayed.

l To select locations within a rectangular area, tap the Rectangle icon,
and then draw a rectangle on the map. As you draw, the length and width
of the rectangle, in miles, is displayed.

l To select locations by drawing a freeform shape around them, tap the
Freeform icon, and then draw a shape on the map around the locations.
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l To select individual markers, tap the Marker icon, and then select
markers on the map. Tap Done to create the region.

A tab for the newly defined region is displayed at the top of the screen,
listing how many markers or locations are included in the region. For
example, in the map displayed below, two regions have been created. First,
a rectangle was drawn on the map, which created Region 1, with 20 markers.
Next, a circle was drawn on the map, which created Region 2, with 30
markers. If more than one region is defined, as in this case, another tab,
labeled All, is also displayed. The All tab selects all the regions.

If more than two regions are created, you can scroll through the regions in
the tab by swiping the tab. To close the tab, tap the slider (shown below) in
the tab.
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l After you create a region, you can analyze data by:

l Browsing through the markers in a region. Tap the region in the region
tab to display a list of the markers in the region. Tap a marker to view
more information about the marker. You can browse through the details
for each marker by tapping the arrows to navigate through the markers.

l Drill ing in a region. Tap the region on the map, then tap Drill. Dril l ing
allows you to view information at lower, more detailed levels or higher,
summarized levels.

l Zooming in on the region. Tap the region in the region tap, then tap
Zoom.

l Deleting all defined regions from the map. Tap the Select icon , and

then tap the x icon.

Analyzing data at a glance: Microcharts

Some documents may contain a grid with miniature charts, called
microcharts, that you can use to view trends in a metric's value at a quick
glance. An example is shown below:
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To analyze data with Microcharts

1. To view information about a data point in a graph, tap and hold your
finger over it. A tooltip with more information appears, as shown below.

2. Drag your finger along the graph to view tooltips for each data point.
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3. If some metric columns do not fit on the screen, swipe horizontally to
view the other metric columns.

4. Depending on how the microchart was designed, you can sort the
microchart based on one of its columns. Tap the title of the column to
sort the rows in ascending order, based on the values in the column.
Tap the title of the column again to sort in descending order. Tapping
the title of the column a third time undoes the sort.

Analyzing data on a time-based graph: Time Series

Reports and documents can include a line graph that displays data over a
period of time. The graph may contain multiple data series. For example, the
values for the various profit and revenue metrics for the Books and
Electronics categories for a two-year period are displayed in the image
below:

Use the slider at the bottom to select a time period to view. The highlighted
section is the time period you are currently viewing.

The actions that you can perform with the graph depend upon how the graph
was designed. You may be able to do any of the following:
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l Change the orientation of the graph between portrait and landscape by
rotating the device.

l To view data for a specific amount of time, tap one of the time periods at
the top of the graph. In the example above, you can select either a six-
month or twelve-month time period.

l To display tooltips, tap and hold on the graph. For example, if you tapped
and held on the Books Revenue graph line for September, the tooltip
would display $93,728.

l To scroll through the time axis, drag the slider below the graph.

l To view a longer or shorter period of time, drag the left or right edge of the
slider to adjust its size.

l To view a legend of all the metrics, tap the bar on the right edge of the
graph. The example already displays the metric legend. You can select a
metric to highlight it in the graph.

Downloading multimedia files: Multimedia

Some documents may include files that you can download. These files can
be of various formats, such as videos, PDFs, ePub files, and so on.

Any new files that were not in a document previously are labeled as New the
next time you view or refresh the document, indicating that new content is
available.

Depending on how the document was designed, you may be able to do the
following:

l To start downloading the file, tap the Download button. A progress bar
indicates the status of the download.

l To cancel a download, tap the Cancel button.

l To open a file, tap its icon.
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Uploading images to your data warehouse from your camera or
photo album

Some documents may allow you to upload images by selecting an image
from your photo album or by taking a picture using your device's camera, if
applicable.

To upload images

1. Tap Add Photo.

If your device has a camera, a menu is displayed, with the option to
either take a new photo, or use an existing photo.

If your device does not have a camera, your photo albums are
displayed.

2. To take a new photo, do the following:

a. Tap Take New Photo. The camera opens.

b. If your device has a front and a back camera, you can switch
between the two cameras by tapping the Switch Camera icon .

c. Use the camera to take a photo. A preview of the photo is
displayed, with a white frame.

3. To use a photo from your album, do the following:

a. Tap Choose Existing Photo. A list of the photo albums on your
device is displayed.

b. Navigate to the photo you want to upload, and tap its thumbnail.
The photo is displayed, with a white frame.

4. Drag the photo in the white frame to crop the photo and select which
area to use. To zoom into the photo, use a pinch gesture.
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5. When you have selected which area to use, tap Use Photo. To discard
this photo and take a new one, tap Retake.

6. A preview of the cropped photo displays, with the option to add a
caption.

7. To discard this photo and take a new one, tap Retake.

8. To use this photo, tap Done. The photo appears on the screen. To add
more photos, tap the Add Photo again, and repeat the above steps.
Once you have selected a photo, the counter on the top-right of the
frame indicates the number of photos you have chosen.

The number of photos you can upload may be limited by the designer.

9. To upload all the photos, tap Submit. The photos are uploaded, and
depending on the document's configuration, a confirmation may appear.

Browsing a gallery of images: Image Viewer

Some documents may include a gallery of images, which you can browse to
view different images.

Depending on how the gallery is designed, you may be able to do the
following:

l Swipe left or right to navigate between images.

l Tap an image to make it fi l l the screen.

Playing videos: Video Player

Some documents may include an embedded video that you can view. Tap
Play to begin the video.

If a local copy of the video was cached on your device, you can view the
video whether or not the device is connected to the internet. While your
mobile device is online, the video can be downloaded or streamed.
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In order to view streaming videos when the mobile device is offl ine, ensure
that the video is fully downloaded while the mobile device is online. By
default, the video file is discarded when you close the MicroStrategy Mobile
application. Your administrator can ensure that streaming videos are
downloaded and stored on the mobile device for offl ine use. Steps to do so
are provided in the MicroStrategy Mobile Administration Help.
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Getting Started with MicroStrategy Mobile for iPad

Introduction

This chapter provides an overview of basic tasks that analysts can perform
with MicroStrategy Mobile for iPad.

The steps and images below are based on the default settings of the
application. Your interaction with the application depends on the
configurations that your administrator has made. For information on
customizing MicroStrategy Mobile, see the MicroStrategy Mobile
Administration Help.

If you are designing reports and documents for the iPad, see the
MicroStrategy Mobile Administration Help.

If you are an administrator planning to deploy and configure MicroStrategy
Mobile for mobile device users, see the MicroStrategy Mobile Administration
Help.

Prerequisites

l You must have an iPad device with iOS 4.3.x or higher.

l You must have the following privileges:

l Use MicroStrategy Mobile, for all projects containing reports or
documents that you want to view.

l Mobile View Document.

For information on privileges, contact your administrator.
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Getting Started with MicroStrategy Mobile for iPad
It is recommended that you install the MicroStrategy Mobile application sent
to you by your administrator.

To start MicroStrategy Mobile for iPad, tap the application's icon. You may
need to type your MicroStrategy user name and password.

When you log in to MicroStrategy, the Home screen displays. You can
access the projects you are connected to, any reports you have subscribed
to, and reports that you have recently accessed.

The icons on your Home screen may vary, depending on the configuration
set by your administrator. For example, you may see additional shortcuts to
reports and documents. For information on customizing the Home screen,
see the MicroStrategy Mobile Administration Help.

From the toolbar on the left, you can select from the following options:

Mobile Analysis Guide

https://www2.microstrategy.com/producthelp/2021/MobileAdmin/WebHelp/Lang_1033/Content/home.htm


Copyright © 2024 All Rights Reserved 44

l Home : Displays the list of projects your device is connected to.

l Recently viewed : Displays reports and documents that you have

recently accessed.

l Subscriptions : Displays reports and documents that you are

subscribed to.

l
Offline Transactions : Some documents may include forms that you

can fil l out and send back to your company's database. The Offline
Transactions screen displays a list of documents that will send information
to your company's database once you are connected to the Internet.

l
Report Queue : While a report or document is opening, you can tap

View Later to download the report or document in the background and
continue using your app. The Report Queue displays the reports and
documents that were downloaded.

l Settings : Allows you to configure the MicroStrategy Mobile servers

and projects that you are connected to, and general administrative and
display options.

It is recommended that you configure the application using the
configuration URL that you receive from your administrator.

l Learn more : Displays MicroStrategy's Mobile website, where you can

learn more about MicroStrategy Mobile.

l Help : Displays the help for the application.

l If you have tagged any reports and documents, the tags you created. Tap
the name of a tag to view reports and documents with the tag.

To close the navigation menu, tap the navigation menu icon .
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Receiving alerts when data meets certain conditions: Push
notifications

You can configure MicroStrategy to send you an alert on your iPad when a
metric on a report meets a specific condition. For example, you can choose
to receive an alert if the Profit data in a report drops below $50,000. These
alerts are called push notifications, and can be received even if the
MicroStrategy iPad application isn't running. For information on setting up
push notifications, see the MicroStrategy Mobile Administration Help.

Turning alerts on or off

You can turn alerts on or off using the application's Settings screen.

The documentation listed below refers to software produced by third-party
vendors and thus is subject to change. MicroStrategy makes no guarantee
on the availability or accuracy of third-party documentation.

To turn alerts on or off

1. On the iPad's Home screen, tap Settings. The Settings screen opens.

2. Tap Notification Center. The Notification Center page opens, with a
list of applications that can send you alerts.

3. Tap MicroStrategy.

4. Turn the Show in Notification Center switch on or off.

Select ing the display of the alert

You can specify whether you want to receive notifications as pop-up alerts,
with sounds, or both, through your iPad's Settings screen.

The documentation listed below refers to software produced by third-party
vendors and thus is subject to change. MicroStrategy makes no guarantee
on the availability or accuracy of third party documentation.
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To change the type of notificat ion using the iPad's Sett ings screen

1. Open your iPad's Settings screen. On the iPad's Home screen, tap
Settings.

2. Tap Notification Center. The Notification Center page opens, with a
list of applications that can send you alerts (push notifications).

3. Tap MicroStrategy.

4. Choose an Alert Style from the list:

a. None: No alerts are displayed for push notifications.

b. Banners: Display at the top of the iPad screen. Tap a banner to
open MicroStrategy Mobile. If you ignore the banner, it will close
automatically.

c. Alerts: Display as a pop-up window on the iPad. Tap a button to
open MicroStrategy Mobile or close the alert.

5. Turn the Sounds switch on or off.

6. Turn the View in Lock Screen switch on or off.

Sorting the list of reports, documents, and folders

Some screens, such as the Home screen and the Subscriptions screen,
contain a list of fi les, such as reports, documents, and folders, that you can
sort. Sorting can help make it easier to find the report or document you want
or identify which files were updated so you can see any new data. By
default, fi les are sorted by name.

To sort by the name of the file, the date the file was last modified, or the type
of file, tap the Sort icon . Select Name, Last Modified, or Type,

depending on how you want to sort the folder.

You can also sort by the date the files were last downloaded to your iPad.
From the navigation menu, select Settings. Turn on Show Timestamp
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Options. Return to the screen with the files you want to sort, tap the Sort
icon , then select Last Updated.

Running and viewing reports and documents
Once you have started MicroStrategy Mobile, you can navigate through your
project and run reports and documents on the iPad.

Some reports and documents require you to answer questions, called
prompts, before the report is executed. For information on answering
prompted reports, see Answering prompts in MicroStrategy Mobile for iPad,
page 55.

For information on interacting with the data in reports and documents, see
Chapter , Analyzing Reports and Documents on an iPad.

Running reports and documents you have subscribed to

You can automatically download reports and documents on a specified
schedule by subscribing to the report or document. All the reports and
documents that you are subscribed are listed in the Subscriptions page.

For steps to subscribe to a report or document, see the MicroStrategy Web
Help.

To run reports and documents you have subscribed to

1. From the navigation menu on the left, tap the Subscriptions icon . A

list of the reports and documents you are subscribed to displays,
grouped by project.

2. To view the description for a report or document and where the report
or document is located, tap the i info button to the right of the report or
document's name. The info pane displays.

Tap the x button to close the info pane.
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3. Tap the name of the report or document you want to run.

For information on viewing and navigating reports, see Viewing grid and
graph reports, page 50.

For information on viewing and navigating documents, see Viewing
Report Services documents, page 51.

Running reports and documents by browsing to their location

In addition to running reports and documents that you are subscribed to, you
can browse folders in projects to locate reports or documents and run them.

To run reports and documents by browsing to their locat ion

1. In the default Home screen, tap the name of the project you want to
browse. The folders within the project are displayed.

2. Browse to the folder that contains the report or document that you want
to run.

The icon next to the report or document name indicates whether it is a
grid report, graph report, document, or dashboard.

l Grid reports:

l
Graph reports:

l
Documents:

l
Dashboards:

3. To make it easier to find the report or document you want, you can sort
the contents of the project by name, last modified date, type, and any
tags you have added to the reports or documents. Tap the Sort icon
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at the top. Select Name, Last Modified, Type, or Tag, depending on
how you want to sort the folder.

You can also sort by the date the files were last downloaded to your
iPad. From the navigation menu, select Settings. Turn on Show
Timestamp Options. Return to the screen with the files you want to
sort, tap the Sort icon , then select Last Updated.

4. To view a specific report or document's details, tap the i info button

next to the report or document's name. A description of the report or
document displays, along with the dates it was last modified and
refreshed.

To close the details pane, tap the X icon at the top of the pane.

5. To view descriptions for all items in the folder, tap the Table View icon
at the top of the screen.

To return to viewing a list of the items in the folder, tap the List View
icon at the top of the screen.

6. Tap a report or document in the list to run it. The report or document is
displayed.

If you are presented with a prompt to answer, see Answering prompts in
MicroStrategy Mobile for iPad, page 55 for details to answer each type
of prompt.

For information about viewing and navigating reports, see Viewing grid
and graph reports, page 50.

For information about viewing and navigating documents, see Viewing
Report Services documents, page 51.

As you navigate the projects you are connected to, the name of the
folder you are currently in displays at the top of the screen. To return to
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a folder you were in before, swipe the current folder's name to the right,
then tap the name of the folder you want to return to.

Viewing grid and graph reports

There are two types of MicroStrategy reports: grid reports and graph reports.
Grid reports display business data organized in rows and columns. Graph
reports present data visually in styles such as a bar, line, or pie graph.

The following is applicable to most grid and graph reports:

l You can view reports in portrait or landscape mode by rotating the iPad.

l To scroll across a report, swipe horizontally. To scroll up and down a
report, swipe vertically.

l In grid reports, tap and hold your finger over a cell to see a magnified view
of the data in that cell.

l To switch between viewing the report as a grid or a graph, tap the graph
icon at the top-right of the screen.

l The data in a report may be specific to a certain group, displayed in the
page-by at the top of the report. To change the group of data, tap the
name of the current group and choose another. You may also be able to
switch to another group using gestures, as described in Using gestures for
page-by, page 50.

Using gestures for page-by

You can use gestures to navigate through pages in up to two page-by
groups, displayed at the top of the report.

If the designer has enabled book-style page-by navigation, the report is
displayed as a book, as shown below.
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To navigate through the pages, tap the left or right edge of the report.

If book-style page-by navigation is not enabled, switch between page-by
groups by tapping the name of the current page-by group at the top of the
page. Select the group you want to view.

Viewing Report Services documents

Report Services documents contain several representations of key
performance indicators (KPIs), giving you various perspectives of your
business data.

Switching between panels in a document: panel stacks

A document may contain panels that you can switch between, similar to
slides in a slideshow.

You may be able to switch between panels by tapping a button or link, or by
swiping left or right.

Some panels contain a gray bar at the bottom with a row of circles, as shown
below. Each circle represents a panel and the currently displayed panel is
marked with a dark circle.
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To switch between panels, swipe left or right.

Viewing and navigat ing tabs in a document

A document may contain multiple tabs across the bottom of the document,
called layouts. To view a layout, tap the tab with the layout's name.

Each layout functions as a separate document and can have its own
grouping of data, formatting, and so on. The following image provides an
example of a document with multiple layouts.

Tap the name of a layout to switch to it.
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Sharing reports and documents via email

You can share a screenshot of a MicroStrategy report or document with your
contacts using email. Your recipients do not need to have MicroStrategy
installed to view the screenshot. The steps to share a screenshot are as
follows.

Prerequisites

l You must have configured an email account on your iPad.

To share reports via email

1. In MicroStrategy Mobile, open a report or document that you want to
share with your contacts.

2. In the top-right corner, tap the Menu button . The context menu

opens.

3. Tap Email Screen. A new email message displays, with a screenshot of
the report included in the body.

4. Type the email addresses of your contacts in the To and Cc/Bcc f ields,
as applicable.

5. Once you have composed the email, tap Send. The email is sent.

Annotating reports and documents on an iPad

You can add annotations, such as comments and freehand drawings, to a
screenshot of your dashboard, and share the annotated screenshot with
your contacts. The steps to annotate and share a screenshot follow.
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To annot at e and shar e r epor t s and docum en t s on an iPad

1. In MicroStrategy Mobile, open a report or document you want to
annotate and share.

2. In the top-right corner, tap the Menu button . The context menu

opens.

3. Tap Annotate and Share. A screenshot of the dashboard opens.

4. You can annotate the screenshot in the following ways:

l To draw shapes freehand, use your finger.

l To add a comment to your drawing, tap the drawing, then tap Add
Comment. A comment box is displayed, which allows you to enter
text.

l To add a comment anywhere in the screenshot, in the top right of the
screen, tap the Add Comment icon . A comment box is displayed.

l To move the comment box, tap, hold, and drag the box around the
screen.

l To resize the comment box, tap, hold, and drag the corners of the
box.

5. To email, save, or print the annotated screenshot, tap the Action button
, then select the appropriate action.

Printing reports and documents

If you have a printer available on your network, you can print a copy of your
report or document, as described in the steps below.
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To print reports and documents

1. In MicroStrategy Mobile, open a report or document that you want to
print.

2. In the top-right corner, tap the Menu button .

3. Tap Print. The Printer Options dialog box opens.

4. To choose a printer, tap Printer. A list of available printers is
displayed.

5. Tap the name of the printer you want to print from. The printer is
selected, and you are returned to the Printer Options dialog box.

6. To change the number of copies to print, use the plus + and minus -
buttons.

7. If your printer supports double-sided printing, turn the Double-sided
switch on.

8. When you are satisfied with the settings, tap Print.

Answering prompts in MicroStrategy Mobile for iPad
Some reports and documents may ask you to choose what data is displayed
by asking you questions, called prompts. Prompts allow you to display only
the data that you want to view.

The following table lists the types of prompt you may have to answer and
steps to answer them.

Type of
Prompt

Answering the prompt

Calendar

To select a date, tap it.

To select a range of dates, tap and hold the start date, and drag until the
end date.
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Type of
Prompt

Answering the prompt

Date/time
wheel

Scroll through the columns to select a date and time.

Text prompt Tap inside the text box to begin typing an answer.

Numerical
slider

Drag the slider to choose a value.

Numeric
stepper

Tap the plus or minus button to select a value.

Numeric
wheel

Scroll to the value you want to use.

On/Off
switch

Slide the switch to turn it on or off.

Location

Tap the button to use your current location.

You are prompted for permission to use your location.

Barcode

Use your device's camera to scan a barcode or QR code. To manually enter
a barcode, tap the keypad button and enter the number that corresponds

with the barcode.

Selections
from a list

For a list of possible selections, tap the name of the list. Tap an item in the
list to select it. The item you select is displayed in the report or document.

If an arrow icon displays next to an item, then the item itself may contain
one or more lists. Tap the arrow icon to display the lists, then tap the lists to
view the items you can select from the list.

To change the list so that the items you select are excluded from the report
or document, tap in list next to the list's name.

Using the Prompts screen

The Prompts screen displays the prompts associated with a report or
document and your response to them. The Prompts screen displays if one or
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more of the following conditions are met:

l The report or document contains at least one prompt

l You have not opened this report or document before

l You have not saved your previous answers to the prompts in this report or
document

l An answer you provided does not meet the prompt's requirements

The Prompts screen displays each prompt's name, description, and the
answers you have provided. Tap the name of a prompt to answer it.

If the answer you have provided does not meet the prompt's requirements,
the requirements are displayed in red text.

To change your prompt answers before running the report, tap the name of
the prompt that you want to revise.

When the prompt's answer requirements are met, tap Apply to run the
report. If you want to change your prompt answers after you run the report,
tap the Menu button , then tap the Prompts icon to display and edit

your prompt answers.

Achieving the best response from MicroStrategy Mobile
The speed at which your list of reports is retrieved and reports are refreshed
in MicroStrategy Mobile depends on several factors:

l Your mobile service provider or internet service provider.

l The time at which you are accessing the reports and documents.

The speed at which a report or document opens in MicroStrategy Mobile
depends on several factors:

l Amount of usable memory on the mobile device.

l The version of the mobile device.

l The size and contents of the reports and documents.
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For best practices for creating reports and documents for use with
MicroStrategy Mobile, see the MicroStrategy Mobile Administration Help.

Consider creating subscriptions to your most commonly used reports and
documents. This gives you access to them in the Reports tab on your Home
screen, and can pre-load their contents on your device so that they open
more quickly. For steps to create subscriptions, see the MicroStrategy Web
Help.
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Analyzing Reports and Documents on an iPad

Introduction
This chapter describes the tasks you can perform to interact with and
analyze data in MicroStrategy Mobile for iPad. The following sections are
covered:

l Analyzing reports and documents on an iPad, page 59

l Interacting with data, page 67

l Using interactive dashboards on an iPad, page 84

Prerequisites

l This chapter assumes you are familiar with the information provided in
Chapter , Getting Started with MicroStrategy Mobile for iPad.

Analyzing reports and documents on an iPad
This section describes the following ways in which you can interact with data
in MicroStrategy Mobile for iPad:

l Sorting data in a grid report, page 60

l Viewing more information about a data point on a graph: tooltips, page 60

l Viewing data at different levels: dril l ing, page 61

l Viewing reports and documents: links and buttons, page 63

l Viewing subsets of data: changing your prompt answers, page 64
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l Opening other iPad applications from documents using links, page 64

l Using documents to send or update data in your data warehouse:
Transaction Services, page 65

l Copying text from documents, page 67

Sorting data in a grid report

Sorting allows you to reorganize the way data is displayed so that you can
analyze it more effectively. For example, you could sort the data in a report
in descending order of profit to get a quick idea of your most profitable
products.

To sort data in a grid report

1. Tap and hold the column header you want to sort your data by. The
context menu opens.

2. Tap Sort. The Sort menu opens, for sorting in ascending or descending
order, as shown below.

3. Tap Sort Ascending, or Sort Descending, as applicable.

Viewing more information about a data point on a graph: tooltips

A tooltip displays detailed information about a specific data point on a graph
report. Tooltips provide information such as the value of a specific data
point, the name of a group, or the label of a graph's X-axis. An example of a
tooltip in a pie chart is shown below:
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To display a tooltip on a graph report, tap and hold a data point on the
graph.

Viewing data at different levels: dril l ing

Drill ing lets you view your data at levels other than those displayed in the
report or document. For example, a report displays data at the year level by
default. You can dril l down to view the same data at the quarter level.
Alternatively, you can dril l to another dimension, such as Geography, to view
data at the city level.

If dril l ing is enabled, Drill Anywhere appears when you tap and hold an
attribute header or attribute element, as shown below:
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To drill on a grid or graph

1. Tap and hold an attribute header or attribute element, and then release.
The context menu appears.

2. Tap Drill Anywhere (on a grid) or Drill (on a graph). The graphical dril l
path selector appears, as shown below. A list of dimensions to which
you can dril l is displayed.

To cancel dril l ing at any time, tap the close button at the top-right

of the dril l path selector.

3. In the dril l path interface, scroll through the displayed dimensions until
the one you want to dril l to is highlighted in the center.

4. Tap the dimension's name. The dimension gets added to the dril l path
on the left, and a list of attributes representing that dimension appears.

5. Repeat the procedure, adding an attribute to the dril l path. The Update
icon appears, as shown below.
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If you want to change your selections, tap the name of the first
dimension you selected, shown in blue at the far left of the screen. The
dril l path is reset.

6. Once you have made your selection, tap Update to refresh the report
with data for your chosen attribute.

7. To return to the original report, tap the Back button on the top-left.

Viewing reports and documents: links and buttons

A link is a connection between the currently displayed MicroStrategy
document and another document or report. When selected, a link executes a
document or report from the currently displayed document.

Links in MicroStrategy documents can be displayed as images, text, or
buttons. The function and appearance of a link depends upon the way it is
designed.

A button can also open a different screen, such as the Home screen or the
Report List.

To follow a link that is displayed on a document, tap the button, or the linked
image or text. To return to the original document, tap the Back arrow at the
top-left of the screen.

When a link executes a report or document, it can change the following
properties of the report or document that it executes:
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l The grouping of a report or document

l The layout of a document

l The view of a report: as a grid, as a graph, or as a grid and graph

l The prompt answers that are used in a report or document

l The selector values that are used in a document

A link can also display the Group-by page. For more information about the
Group-by page, see Chapter , Getting Started with MicroStrategy Mobile for
iPad.

For steps to create links in documents, see the MicroStrategy Mobile
Administration Help.

Viewing subsets of data: changing your prompt answers

MicroStrategy reports and documents that contain prompts use your prompt
answers to display a subset of data. Some reports and documents may allow
you to change your prompt answer to display different subsets of data
without having to navigate to the report and re-execute it.

Reports or documents that allow you to change your prompt answers may
display a Filter icon at the top of the screen.

To change your prompt answers after the report has run, tap the Filter

icon. The prompt screen is displayed, and you can change your prompt
answers.

Opening other iPad applications from documents using links

A MicroStrategy document can use links to open other iPad applications,
such as Safari, Mail, and Google Maps. For example, a document may report
sales per employee. When you view the document, you can tap a link to send
an email to an employee using Mail.
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The document designer determines how applications are accessed on the
document, and what actions the applications perform. For information about
designing documents, see the MicroStrategy Mobile Administration Help.

Using documents to send or update data in your data warehouse:
Transaction Services

Some documents may include forms that you can use to edit or add
information to your data warehouse through Transaction Services. Some
examples are documents that approve requests, track business activity, and
execute business decisions, directly from your mobile device. Any new data
or changes are saved in your data warehouse.

Prerequisites

To use a Transaction Services-enabled document, you must meet the
following criteria:

l You must have Transaction Services.

l You must have the Execute Transaction privilege.

l The Transaction Services-enabled document must already be created.

Using Transact ion Services-enabled documents

Depending on the way the document is designed, you may be able to
manipulate data in the following ways:

l Edit text or numerical values in a text box.

l Use a slider to select from a range of values.

l Select values from a drop-down list.

l Use an On/Off switch for Yes or No conditions.

l Use a date/time wheel to select a date.
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l Use your device's camera to scan a barcode or QR code. To manually
enter a barcode, tap the keypad button and enter the number that
corresponds with the barcode.

Once you have completed your manipulations, you may be able to perform
one or more of the following:

The designer may not use all the buttons described below, or may use
different names for them.

l To preview the results of your changes in the Grid/Graph without updating
your data warehouse, tap Recalculate.

l To update your data warehouse with the values you provided, tap Submit.

If you are not connected to the internet, the document is added to the list
of offl ine transactions that are pending changes. Your changes are sent to
your data warehouse when a connection is available. For steps to edit
your pending changes, see To edit pending transactions, page 66 below.

l To undo the changes you have made, tap Discard Changes. The
document reverts to the values from the last time you submitted data.

To ed i t pend ing t r ansact ions

1. In the document's header, tap the Offline Transactions button: . A

list of the transactions that are pending changes are displayed.

2. To change the values you want to submit, tap a transaction in the queue
to select it, and then tap Edit.

3. To delete a transaction, tap the transaction in the queue to select it,
and then tap Delete.

4. To view transactions for all documents that are pending changes, tap
the list icon , then tap the document whose transactions you want to

edit or delete.
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Copying text from documents

You can copy text from a document. First, select the text to copy by tapping
and holding the text. If zoom is disabled, you can also select the text by
double-tapping it.

If you do not know whether or not zoom is enabled, double-tap the text. If
zoom is enabled, double-tapping zooms in or out.

From the pop-up menu that displays, choose to copy the selected text or
select all the text in the text field.

If the text is displayed in the Detail section of a document, you must tap the
text.

Interacting with data
Documents on the iPad can contain interactive objects you can use to
interact with rich, graphical displays of data, view videos, download files,
and so on.

For examples of interactive objects you can use to analyze data, and
instructions to analyze the data that they contain, see the following sections:

l Analyzing trends at a glance: Microcharts, page 68

l Analyzing data on a Map: Map, page 71

l Analyzing data on a time-based graph: Time Series, page 74

l Analyzing data in a Graph Matrix, page 75

l Analyzing relationships between items in a Network visualization, page 76

l Analyzing data on a heat map: Heat Map, page 77

l Analyzing data on a calendar: Date Selection, page 78

l Analyzing events on a timeline, page 79
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For instructions to use interactive objects that allow you to view videos,
upload images, and download files, see the following sections:

l Downloading multimedia files: Multimedia, page 81

l Uploading images to your data warehouse from your camera or photo
album, page 82

l Browsing a gallery of images: Image Viewer, page 83

l Playing videos: Video Player, page 84

Analyzing trends at a glance: Microcharts

Some documents may contain a grid with miniature charts, called
microcharts, that you can use to view trends in a metric's value at a quick
glance. An example is shown below:

To analyze data with Microcharts in MicroStrategy Mobile

1. To view information about a data point in a graph, tap and hold your
finger over it. A tooltip with more information appears, as shown below.
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2. Drag your finger along the graph to view tooltips for each data point.

3. Depending on how the microcharts grid was designed, you can sort the
grid based on one of its columns. Tap the title of the column to sort the
rows in ascending order, based on the values in the column. Tap the
title of the column again to sort in descending order. Tapping the title of
the column a third time undoes the sort.

4. If some metric columns are not displayed, swipe horizontally to view the
metric columns that could not fit on the screen.

Analyzing Hierarchy Reports

Unbalanced hierarchies are hierarchies with branches that descend to
inconsistent levels. For example, in an Employee hierarchy, different parts
of the organizational structure will have more management levels than
others.

Many organizations have aspects of their business that are organized in
unbalanced hierarchies. Besides the Employee hierarchy, other typical
examples include a chart of accounts, complex product portfolios, and
multinational geographic groupings.

Hierarchy Reports are a class of reports in which the data is naturally
organized and presented in a hierarchical structure. Hierarchy Reporting
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features treat hierarchies as a first-class citizen, and make interacting with
entire hierarchies intuitive and efficient. Both balanced and unbalanced
hierarchies may be represented in a hierarchy report, although unbalanced
hierarchies benefit the most from Hierarchy Reporting features.

Hierarchical Attr ibutes

To facilitate the building of hierarchy reports, there is a new type of
attribute: the hierarchical attribute. The hierarchical attribute represents an
entire hierarchy and all its levels. For example, you may have a Time
hierarchical attribute that represents the Time hierarchy, including its levels
Year, Quarter, Month, and Day. In contrast, a normal attribute usually
represents a single level of a hierarchy (for example, Year). The hierarchical
attribute appears on a grid, fi ltered, and sorted, much like a normal attribute.

Navigat ing Hierarchy Reports

Navigate through the hierarchy by expanding and collapsing the hierarchical
attributes using the plus (+) and minus (-) icons. You can also tap the cell
directly above the top level of the hierarchy and choose Expand/Collapse
>Expand All or Collapse All.

Sort ing Hierarchy Reports

When a report with a hierarchical attribute is sorted, the structure of the
hierarchy remains intact, so every element retains its parent in the hierarchy
tree. Each level of the hierarchy is sorted separately from the other levels.

To sort on a hierarchy or a metric, tap the cell directly above the top level of
the hierarchy and choose Sort Ascending or Sort Descending.
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Filter ing Hierarchy Reports

To filter a Hierarchy report, tap the Filter icon to open the Filter panel. Then,
tap the filter you want to use. The Filter panel displays the elements of the
hierarchy in a tree. Expand or collapse the filters using the plus (+) and
minus icons. You can also expand or collapse all of the filters by tapping
Expand/Collapse >Expand All or Collapse All.

Analyzing data on a Map: Map

Documents can display data based on locations on a map. Points of interest
may be marked on the map, and may be different sizes based on the value of
a metric.

The map below shows the population of large cities in Europe using colors.
Darker colors indicate a higher population density.
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A map may show image markers or bubble markers instead.

The document containing a map may prompt you for your current location so
the map can show locations that are within a given distance from you. For
information about answering prompts on an iPad, see Chapter , Getting
Started with MicroStrategy Mobile for iPad.

Depending on how the map was designed, you may be able to:

l Swipe to a different area on the map.

l Zoom in or out by pinching the map. For some maps, markers are
displayed instead of colors as you zoom in.

l Rotate the map by placing two fingers on the map and spinning them.

l View more information about a specific marker, by tapping the marker on
the map.

l Switch between Map, Satellite, and Hybrid views. Tap the name of the
current view, then tap the appropriate button.

l Select a different metric to display with the markers. Tap the name of the
current metric, then tap the metric you want to display.

l You can select a set of locations to analyze, by creating a region. To do
this, tap the Select icon , and do one of the following:

o To select locations within a certain radius of a central location, tap the
Circle icon. Tap the central location, then drag your finger outward until
the radius is as large as you want. As you draw, the radius of the circle,
in miles, is displayed.

o To select locations within a rectangular area, tap the Rectangle icon,
and then draw a rectangle on the map. As you draw, the length and width
of the rectangle, in miles, is displayed.
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o To select locations by drawing a freeform shape around them, tap the
Freeform icon, and then draw a shape on the map around the locations.

o To select individual markers, tap the Marker icon, and then select
markers on the map. Tap Done to create the region.

A tab for the newly defined region is displayed at the right of the screen,
listing how many markers or locations are included in the region. For
example, in the map displayed above, three regions have been created.
First, a circle was drawn on the map, which created Region 1, with four
markers. Next, a freeform shape was drawn on the map, which created
Region 2, with seven markers. Finally, a rectangle was drawn on the map,
which created Region 3, with four markers. Tapping All selects all the
regions.

If more than two regions are created, you can scroll through the region tabs
by swiping the tabs. To close the region tabs, tap the Close icon (shown
below) in the region tabs.

l After you create a region, you can analyze data by:

o Viewing more information about a specific marker, by tapping the marker
on the map.

o Browsing through different marker information for a region, tapping the
region in the region tab. Tap a marker to view more information about
the marker.

o Drill ing in a region. Tap the region on the map, and then tap Drill.
Dril l ing allows you to view information at multiple levels.

o Zooming in on a region. Tap the region in the region tab, and then tap
Zoom.
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o Deleting all defined regions from the map. Tap the Select icon , and

then tap the x icon.

Analyzing data on a time-based graph: Time Series

Some documents may include a line graph that displays data over a period
of time, called a Time Series. A Time Series may contain multiple data
series. For example, the Time Series shown below displays values for the
Profit metric for the Business and Drama subcategories:

Use the slider at the bottom to select a time period to view. The highlighted
section is the time period you are currently viewing.

The actions that you can perform depend on how the Time Series was
designed. Depending upon the Time Series that you are analyzing, do any of
the following:

l To display tooltips, tap and hold part of the graph.

l To scroll through the time axis, swipe horizontally, or drag the highlighted
portion of the slider at the bottom.

l To view a longer or shorter period of time, drag the left or right edge of the
slider to adjust its size.
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l To view a legend of all the metrics, tap the bar on the right edge of the
Time Series.

Analyzing data in a Graph Matrix

Some documents may contain a chart with multiple graphs, called a Graph
Matrix visualization. The data may be displayed in different graph styles,
such as line, bar, or scatter. An example of a Graph Matrix that uses line
graphs is shown below.

You may be able to perform the following actions in a Graph Matrix
visualization:

l Use a pinch gesture to zoom into the graphs. To return to the original
zoom level, double-tap the visualization.

l Tap and hold points on the graphs to view additional information about
them.
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l To sort the grid by a column, tap and hold the title of the column. Click
Sort, then choose Ascending or Descending to sort the grid by the
column.

Analyzing relationships between items in a Network visualization

You can use a Network visualization to quickly view data about relationships
between individual items. Each node represents a business attribute, while
the lines between them represent the relationships between them. An
example of a Network visualization that displays the relationships between
product categories and subcategories is shown below.

You can perform the following actions on a Network visualization:

l To view information about a node and its relationships to other nodes, tap
the node.

l To zoom into the visualization, use the pinch gesture.
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l To switch between arranging nodes in a force-directed layout, circular
layout, and linear layout, tap F, C, or L, respectively.

l To manually arrange nodes, tap Select, and tap and drag nodes to
rearrange them.

Analyzing data on a heat map: Heat Map

Some documents may include heat maps, which are visualizations that let
you quickly grasp the state and impact of a large number of variables at one
time.

The characteristics of heat maps are described below:

l The size of each rectangle represents its relative weight.

l The color of each rectangle represents its relative value.
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l Large areas (displayed with thicker borders) represent different groups of
data.

l Small rectangles represent individual elements.

Depending on how the heat map is designed, you may be able to perform the
following actions:

l To zoom in or out, perform a pinch gesture.

l To view more information about an element, tap and hold your finger over
it.

l You can temporarily delete elements from your view. Tap the Edit button,
then turn on the Enable Delete switch. Tap Close.

l To delete an element from the Heat Map, tap and hold your finger over it,
then tap X.

l To restore deleted elements, tap the Edit button. Under Restore elements,
tap the elements you want to restore. To restore all elements, tap All.
When you are done, tap Restore.

Analyzing data on a calendar: Date Selection

Some documents may include an interactive calendar that lets you view
events for every day of the month in either a Month, Week, or Day view. An
example of a calendar in Month view is below:
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In the example above, the week starts on Sunday. If your device has a
different day specified in the app setting Start Week On, that day will
display in your calendar.

Depending on how the calendar is configured, you may be able to perform
the following actions:

l Tap an event to view additional information about it.

l Tap Day, Week, or Month for different views of your data.

l
Events may be color-coded. To view a legend, tap the Legend button .

Analyzing events on a timeline

The Timeline lets you track events or milestones over time. For example,
while viewing data for products, you can view milestones for every mill ion
units sold, and the state of your business at that point.
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The example below shows a Timeline that displays timelines for a set of
assets, with markers for events such as the beginning or end of a lease or a
new purchase.

Depending on how the Timeline is configured, you may be able to do the
following:

l Tap an event to view additional information about it.

l Tap a cell in the left column to view additional information about it.

l Tap the metric headers on the right or bottom to cycle through the
available metrics.

Analyzing data overlaid on images: Image Layout

Some documents may include data overlaid on an images as a colored area.
For example, a document may contain an image of a store's layout, where
each section of the store is a separate colored area.
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You can view data for separate colored sections on the image. Tap and hold
your finger over a bubble or colored area. A tooltip is displayed, with the
metrics for that area.

Downloading multimedia files: Multimedia

Some documents may include files that you can download. These files can
be of various formats, such as videos, PDFs, ePub files, and so on.

Any new files that were not in a document previously are labeled as New the
next time you view or refresh the document, indicating that new content is
available.

Depending on how the document was designed, you may be able to do the
following:
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l To start downloading the file, tap the Download icon . A progress bar

shows the status of the download.

l To cancel a download, tap x.

l To open a file, tap its icon.

Uploading images to your data warehouse from your camera or
photo album

Some documents may allow you to upload images by selecting a photo from
your photo album or by taking a picture using your device's camera, if
applicable.

To upload images

1. Tap Add Photo.

l If your device has a camera, a menu is displayed, with the option to
either take a new photo or use an existing photo.

l If your device does not have a camera, your photo albums are
displayed.

2. To take a new photo, do the following:

a. Tap Take New Photo. The camera opens.

b. Use the camera to take a photo. A preview of the photo is
displayed, with the option to add a caption.

3. To use a photo from your album, do the following:

a. If your albums are not already displayed, tap Choose Existing
Photo. A list of the photo albums on your device is displayed.
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b. Navigate to the photo you want to upload, and tap its thumbnail.
The Choose Photo screen is displayed.

c. If you want to select a specific area of the photo to use, pinch to
zoom into the photo, and drag on the photo until the area you want
is in the center of the frame.

4. When you have selected which area to use, tap Use. A preview of the
photo is displayed, with the option to add a caption.

5. To use this photo, tap Use (if you took a new photo) or Upload (if you
are using an existing photo), as applicable. To discard this photo and
use another, tap Retake. The photo appears in the screen.

6. To add more photos, tap the Add Photo again, and repeat the above
steps. As you select photos, the counter on the top-right of the frame
indicates the number of photos you have chosen.

The number of photos you can upload may be limited by the designer.

7. To upload all the photos, tap Submit. The photos are uploaded, and
depending on the document's configuration, a confirmation may appear.

Browsing a gallery of images: Image Viewer

Some documents may include a gallery of images, which you can browse to
view different images.

Depending on how the gallery is designed, you may be able to do the
following:

l Swipe left or right to navigate between images.

l Tap an image to make it fi l l the screen.
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Playing videos: Video Player

Some documents may include an embedded video that you can view. Tap
Play to begin the video.

If a local copy of the video was cached on your device, you can view the
video whether or not the device is connected. While your mobile device is
online, the video can be downloaded or streamed.

In order to view streaming videos when the mobile device is offl ine, ensure
that the video is fully downloaded while the mobile device is online. By
default, the video file is discarded when you close the MicroStrategy Mobile
application. Your administrator can ensure that streaming videos are
downloaded and stored on the mobile device for offl ine use. Steps to do so
are provided in the MicroStrategy Mobile Administration Help.

Using interactive dashboards on an iPad
Some dashboards may be interactive so you can actively explore business
data on an iPad. You can add or remove attribute elements from a
visualization to change your the data you are viewing. An example of a
dashboard is shown below.
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When you run a dashboard, it is displayed as a grid, graph, or a collection of
one or more visualizations. Depending on how the dashboard is designed,
you may be able to do the following:

l If more than one visualization is available, swipe to the left or right to
navigate between visualizations.

l Use the drop-down lists in the Filters pane to include or exclude attribute
elements from the dashboard.

l Use the page-by bar at the top to view different groupings, or pages, of
data.

l If more than one visualization is available, tap an attribute element in one
visualization to filter the display of other visualizations.

l If more than one visualization is available, tap an attribute element in one
visualization to highlight matching attribute elements and metrics in other
visualizations.

You can also display your dashboard on an external display using AirPlay
Mirroring, which allows you to show your iPad's screen on an external
display. The requirements are:

l An iPad, connected to a Wi-Fi network.

l An Apple TV®, connected to the same Wi-Fi network.

l An external display, connected to the Apple TV.

For steps to enable AirPlay Mirroring, refer to the following Apple Support
article: http://support.apple.com/kb/HT5209.
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u

Getting Started with MicroStrategy Mobile for
Android

Introduction
This chapter provides an overview of basic tasks that analysts can perform
on an Android phone or table using MicroStrategy Mobile.

The steps and images below are based on the default settings for the
MicroStrategy Mobile for Android application. Your interaction with the
application depends on the configurations that your administrator has made.
For information on customizing MicroStrategy Mobile, see the MicroStrategy
Mobile Administration Help.

If you are designing reports and documents for use with MicroStrategy
Mobile for Android, see the MicroStrategy Mobile Administration Help.

If you are an administrator planning to deploy and configure MicroStrategy
Mobile for mobile device users, see the MicroStrategy Mobile Administration
Help.

Prerequisites

l You must have an Android device that meets the MicroStrategy Mobile
system requirements. For an up-to-date list of these requirements, see the
MicroStrategy Mobile Readme.

l You must have the following privileges:
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l Use MicroStrategy Mobile, for all projects containing reports or
documents that you want to view

l Mobile View Document

For information on privileges, contact your administrator.

Getting started with MicroStrategy Mobile for Android
It is recommended that you install the MicroStrategy Mobile application sent
to you by your administrator.

To start using MicroStrategy Mobile on your device, tap the MicroStrategy
Mobile icon. You may be prompted for your MicroStrategy user name and
password.

When the application opens, the MicroStrategy Home screen is displayed.
The default Home screen is shown below.

Your Home screen buttons may vary according to how your administrator
has configured the Home screen. For information on customizing the Home
screen, see the MicroStrategy Mobile Administration Help.

The default Home screen buttons are described below:
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l Subscriptions: Displays the reports and documents that you have
subscribed to.

l Shared Library: Displays the MicroStrategy projects that your device can
connect to. Tap a project to display the folders within it. Tap a report or
document to run it.

l Settings: Allows you to configure the MicroStrategy Mobile servers and
projects that you are connected to, and general administrative and display
options.

It is recommended that you configure the application using the
configuration URL that you receive from your administrator.

l Help: Displays the help for the application.

You can return to the Home screen at any time by tapping the MicroStrategy
logo at the top left corner of the screen.

Running and viewing reports and documents
Once you have started MicroStrategy Mobile, you can run and view reports
and documents on your device.

This section contains information about the following:

l Running reports and documents, page 89

l Navigating data in a grid or graph report, page 92

l Navigating data in a document, page 96

l Filtering displayed data: Answering prompts, page 100

l Achieving the best response from MicroStrategy Mobile, page 103

For information about interacting with the data displayed on a report or
document, see Chapter , Analyzing Reports and Documents on an Android
device.

Mobile Analysis Guide



Copyright © 2024 All Rights Reserved 89

Running reports and documents

You can locate and run a report or Report Services document by browsing to
its location within a project. Steps to browse to reports and documents are
below.

Once a report is run, you can view the data it displays and manipulate the
data to see trends and results for your organization or department.

Locating and running reports and documents

Use the Shared Library button on the default Home screen to browse the
folders in a project. You can run reports and documents from the list
displayed within the folders by tapping the report or document name. Details
are as described below:

l To run reports and documents on an Android phone, page 89

l To run reports and documents on an Android tablet, page 90

You must have the proper privileges in MicroStrategy to access folders in a
project. For information about the privileges that are assigned to you,
contact your administrator.

To run reports and documents on an Android phone

1. From the default Home screen, tap the Shared Library button, shown
below.

A list of projects that your mobile device is connected to is
displayed.

2. From the list of projects, select the project that you want to browse. The
folders within the selected project are displayed.
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3. Browse to the folder that contains the report or document that you want
to run. A list of reports and documents is displayed. The icon next to the
report or document name indicates whether it is a grid report, graph
report, or document.

l
Grid reports appear with this icon:

l
Graph reports appear with this icon:

l
Documents appear with this icon:

4. To view the report or document details, tap and hold it. A preview is
displayed.

To run the report or document from the preview, tap View.

5. Tap a report or document on the list to run it. The report or document is
displayed.

If you are presented with a prompt to answer, see Filtering displayed
data: Answering prompts, page 100 for details to answer each type
of prompt.

For information about navigating reports, see Navigating data in a
grid or graph report, page 92.

For information about navigating documents, see Navigating data in
a document, page 96.

To run reports and documents on an Android tablet

1. From the default Home screen, tap a project's icon. The folders within
the project are displayed.

2. Browse to the folder that contains the report or document that you want
to run.
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For reports and documents that you have run before, a thumbnail
preview is displayed. For reports and documents that you have not
run yet, a generic icon appears.

l
Grid reports appear with this icon:

l
Graph reports appear with this icon:

l
Documents appear with this icon:

3. Tap the report or document. The description, the date that it was last
accessed, and additional information about the report or document is
displayed in the right pane.

4. Tap View to run the report or document. The report or document is
displayed.

If you are presented with a prompt to answer, see Filtering displayed
data: Answering prompts, page 100 for details to answer each type
of prompt.

For information about viewing and navigating reports, see
Navigating data in a grid or graph report, page 92.

For information about viewing and navigating documents, see
Navigating data in a document, page 96.

Running reports and documents you have subscribed to

All the reports and documents that you are subscribed to appear under the
Reports tab on the Home screen.
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To run reports and documents you have subscribed to

1. From the Android Tablet Home screen, tap Subscriptions or tap Home
on an Android Phone.

2. Tap a report's name to run it.

Running recently opened reports or documents

If you are currently viewing a report or document, you can quickly access
one of the other reports or documents that you recently opened.

To run reports and documents that you recently opened

1. From an open report or document, tap the report or document tit le. The
Recently Opened menu opens.

2. Tap the name of the recently opened report or document that you want
to open.

Navigating data in a grid or graph report

The following actions can be applied to most grid and graph reports after
they have been displayed:
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l To change the orientation between portrait and landscape, rotate the
device.

l To scroll across large reports, swipe the middle of the screen horizontally.
To scroll up and down large reports, swipe the middle of the screen
vertically.

l
To change the group of data that is displayed, tap the Menu button

and then tap Page-by. Select the group of data that you want to display.

The following sections show examples of grid and graph reports displayed
on an Android device, and steps taken to analyze their data.

Navigat ing data in grid reports

A grid report organizes business data into rows and columns. The image
below shows a grid report displayed on an Android device.
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Some reports display special formatting depending upon certain conditions,
for example, sales over $1 million, or inventory count below 50.

In the example below, the report shows specially formatted data that has
met specific conditions, or thresholds, in the Sales column:

To magnify the contents of a cell in the grid, tap and hold the desired cell.
The Info Viewer appears and displays the cell value, column headings, row
headings, and Drill and Link buttons, as in the following example.

If the grid was designed with a dril l map for the selected attribute, tap Drill
to view the dril l options. If the grid was designed with a link for the selected
attribute, tap Link to open the link.
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Viewing graph reports

Graph reports present data visually in a style such as a bar, line, or pie
graph. The images below provide examples of graph reports displayed on an
Android device.

Tooltips provide information such as the value of a specific data point, the
name of a group, or the label of a graph's X-axis. To view tooltips to explain
parts of a graph, such as a single bar in a bar graph, tap and hold on the
screen. An example of a tooltip in a stacked bar graph is shown below:
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Navigating data in a document

Report Services documents generally provide data from multiple reports.
They can contain a variety of grids, graphs, interactive visualizations, and
text, depending upon their design.

The following example shows a simple document displayed on an Android
device.

The following actions can be applied to most documents after they have
been displayed:
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l To change the orientation between portrait and landscape, rotate the
device.

l To scroll across large documents, swipe the middle of the screen
horizontally. To scroll up and down large documents, swipe the middle of
the screen vertically.

l There are several ways to view different groups of data, depending on how
the document was designed. You may be able to do one or more of the
following:

l
Change the group of data that is displayed by tapping the Menu

button, and then tapping Grouping. Select the group of data that you
want to display.

l Swipe horizontally to view different pages (or panels) of data.

l If a dark bar appears at the bottom of the document (as shown in the
image below), tap one of the circles in it to see another group of data.

l If a button or link is displayed, tap it to view a different group of data or
to access other functionality such as email or a video.

l If tabs are displayed across the bottom of the document (as shown in the
image below), tap the tab for the set of data that you want to see.
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l
From the Menu button, choose Layouts. Select the layout, or group

of data, that you want to see.

For more information about designing documents for use on mobile devices
and which make use of these features, see the MicroStrategy Mobile
Administration Help.

Filtering data: Changing the page-by attribute
If your report was designed with a page-by attribute, you can change the
page-by to display data at different levels. For example, if Year is a page-by
attribute, you can choose to display metric values for a desired year.

To select the page-by attr ibute for a report

1. Tap the Page-by button. The Page By screen opens.

2. Tap the desired page-by attribute.
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3. Select the desired attribute element.

4. Tap back to go back to the Page By screen.

5. Tap OK.

Sharing data: sending a screenshot of a report or document
You can share data from MicroStrategy Mobile by sending a screenshot of a
report or document by email, text message, and so on.

To share a screenshot of a report or document

1. Tap the Share button. The Share via... screen opens.

2. Tap the name of the application to use to share the screenshot. The
application opens.

3. Select recipients and deliver your content using the selected
application.

Annotating reports and documents on an Android Tablet
You can add annotations, such as comments and freehand drawings, to a
screenshot of your dashboard, and share the annotated screenshot with
your contacts. The steps to annotate and share a screenshot follow.

To annotate and share reports and documents on an Android Tablet

1. In MicroStrategy Mobile, open a report or document you want to
annotate and share.

2. In the top-right corner, tap the Annotate button. The Annotate

menu and a screenshot of the dashboard open.

3. You can annotate the screenshot in the following ways:
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l
To draw shapes freehand, click Freehand Drawing and use your

finger to draw.

l
To change the color of your drawing, tap the drawing, tap Color ,

and select the desired color.

l
To delete a drawing, tap the drawing and then tap Delete .

l To add a comment anywhere in the screenshot, tap Add Comment
. Type your comment in the box.

l To move the comment box, tap, hold, and drag the box around the
screen.

l To resize the comment box, tap, hold, and drag the corners of the
box.

l
To edit the text in a comment box, tap the box and then tap Edit .

l
To delete a comment box, tap it and then tap Delete .

To share the annotated screenshot, tap the Share button and select the

desired sharing medium.

Filtering displayed data: Answering prompts
Some reports and documents request your input to define what data is
displayed. A report or document requests this information by displaying one
or more prompts. When you provide an answer to a prompt, you define the
data you want to see.

Answering different types of prompts

How you answer a prompt differs depending upon the type of prompt you are
answering. The following table lists the types of prompts and how to answer
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each one.

Type of
Prompt

Answering the Prompt

Calendar

To select a date, tap it.

To select a range of dates, tap and hold the start date, and drag until the
end date.

Text prompt Tap inside the text box to begin typing an answer.

Numerical
slider

Drag the slider to choose a value.

Numeric
stepper

Tap the plus or minus button to select a value.

On/Off
switch

Tap the box to select it and turn it on.

Tap the box again to clear the check mark and turn it off.

Location

Tap the button to use your current location.

You are prompted for permission to use your location.

Barcode

To scan a barcode or QR code, tap the barcode icon, and use your device's
camera to scan a barcode.

To manually enter a barcode, tap the prompt name, and then type the
number that corresponds with the barcode or select from a list of barcodes.

Selections
from a list

To add an item to the list, select the item's check box.

To remove an item from the list, clear the item's check box.

If the list of items is long, you can scroll through the list.

GPS Prompt
To insert your current location in the GPS Search field, tap the GPS icon.

To select from a list of locations, tap the prompt name.
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Using the Prompt Summary screen

The Prompt Summary screen displays a variety of information about the
prompts associated with a report or document. This screen is displayed if
one or more of the following conditions are met:

l • The report or document contains more than one prompt

l • The answer that you provided does not meet the prompt's requirements

l • A prompt requires you to turn a switch on or off, select a number, or
type in a text box

The Prompt Summary screen displays each prompt's name, description, and
the answers that you have provided.

You can change your prompt answers before running the report or
document. To do so, on the Prompt Summary screen, tap the prompt's name
that you want to revise. This opens the prompt screen for that prompt.

To clear a date/time answer on the prompt summary screen, swipe the
prompt answer from left to right.

If the prompt's answer requirements have been met, tap Run Report or Run
Document to run the report or document.

Filter ing data: Changing your prompt answers

Some reports and documents may allow you to change your prompt answer
to display different subsets of data without having to re-execute the report.

To change prompt answers on a report or document

1. Tap the Filter button. The Prompt Summary screen opens. On

Android tablets, the Prompt Summary pane opens to the left of the
report or document.
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2. Change the prompt answers as necessary. For steps to answer each
type of prompt, see Filtering displayed data: Answering prompts, page
100.

3. Tap Run Report or Run Document. The report or document is re-
executed, using the new prompt answers that you provided.

Achieving the best response from MicroStrategy Mobile
The speed at which your list of reports and documents is retrieved and
reports and documents are refreshed depends on several factors:

l Your mobile service provider

l The time at which you are accessing the reports and documents

The speed at which a report or document opens in MicroStrategy Mobile
depends on several factors:

l The amount of usable memory on the mobile device

l The processor speed of the mobile device

l The version of the mobile device

l The size and contents of the report or document

Well-designed reports and documents perform best. For best practices to
create reports and documents for use with MicroStrategy Mobile, see the
MicroStrategy Mobile Administration Help.

Receiving alerts when data meets certain conditions: Push
notifications for Android
You can configure MicroStrategy to send you an alert on your Android
devicewhen a metric on a report meets a specific condition. For example,
you can choose to receive an alert if the Profit data in a report drops below
$50,000. These alerts are called push notifications, and can be received
even if the MicroStrategy application is not running. For information on
setting up push notifications, see Configuring MicroStrategy Mobile for
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Android to Receive Push Notifications in the MicroStrategy Mobile
Administration Help.

Enabling and disabling alerts

You enable or disable alerts using your Android's Settings screen.

The documentation listed below refers to software produced by third-party
vendors and thus is subject to change. MicroStrategy makes no guarantee
on the availability or accuracy of third-party documentation.

To enable or disable push notificat ions

1. Open your Android's Settings screen.

2. Open your Android's Notification Center. The Notification Center page
opens, with a list of applications that can send you alerts (push
notifications).

3. Tap MicroStrategy.

4. Turn the Show in Notification Center switch on or off.

5. If you have enabled notifications, configure the push notifications, as
described in the following steps:

a. Choose an Alert Style from the list:

l None: No alerts are displayed for push notifications.

l Banners: Display at the top of the screen. Tap a banner to open
MicroStrategy Mobile. If you ignore the banner, it will close
automatically.

l Alerts: Display as a pop-up window . Tap a button to open
MicroStrategy Mobile or close the alert.
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6. Push the Home button to return to the Home screen of your Android
device.
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Analyzing Reports and Documents on an Android
device

Introduction
This chapter describes ways to analyze data in a MicroStrategy report or
document using MicroStrategy Mobile on an Android phone or tablet.

After you run a report or document in MicroStrategy Mobile, you can view
data at different levels, view a subset of data, and interact with some of the
displayed data and certain features of the document. You can also follow
links to display different reports or documents, or send email or place phone
calls.

This chapter assumes you are familiar with the information provided in
Chapter , Getting Started with MicroStrategy Mobile for Android.

This chapter provides details to perform the following:

l Viewing data at different levels using dril l ing, page 107

l Analyzing data using links, page 109

l Using documents to send or update data in your data warehouse:
Transaction Services, page 115.

l Analyzing data with widgets:

l Analyzing data in a table: Interactive Grid widgets, page 110

l Analyzing data on a map: Map widgets, page 112

l Analyzing trends at a glance: Microcharts widget, page 113
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l Analyzing data on a time-based graph: Time Series widgets, page 114

l Uploading images, page 116

l Viewing images, page 118

Viewing data at different levels using drilling
Some MicroStrategy reports and documents allow you to view information at
multiple levels. For example, a report displays data at the year level by
default, but can also display data by quarter or month. If a report or
document lets you dril l to other levels, the Drill option appears in bold in the
Info Viewer, as shown in the following image.

In the example above, tapping and holding Nov 2009 displays the Info
Viewer for that month. To view the dril l options for Nov 2009, tap Drill in the
Info Viewer.

When you dril l, and then navigate back to the initial report or document, the
group-by, page-by, and layout settings that were selected in the initial
report or document are preserved.
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To perform the default dril l ing action for an object in the grid, tap it. For an
introduction to dril l ing concepts, see the Basic Reporting Help.

Analyzing Hierarchy Reports
Unbalanced hierarchies are hierarchies with branches that descend to
inconsistent levels. For example, in an Employee hierarchy, different parts
of the organizational structure will have more management levels than
others.

Many organizations have aspects of their business that are organized in
unbalanced hierarchies. Besides the Employee hierarchy, other typical
examples include a chart of accounts, complex product portfolios, and
multinational geographic groupings.

Hierarchy Reports are a class of reports in which the data is naturally
organized and presented in a hierarchical structure. Hierarchy Reporting
features treat hierarchies as a first-class citizen, and make interacting with
entire hierarchies intuitive and efficient. Both balanced and unbalanced
hierarchies may be represented in a hierarchy report, although unbalanced
hierarchies benefit the most from Hierarchy Reporting features.

Hierarchical Attributes

To facilitate the building of hierarchy reports, there is a new type of
attribute: the hierarchical attribute. The hierarchical attribute represents an
entire hierarchy and all its levels. For example, you may have a Time
hierarchical attribute that represents the Time hierarchy, including its levels
Year, Quarter, Month, and Day. In contrast, a normal attribute usually
represents a single level of a hierarchy (for example, Year). The hierarchical
attribute appears on a grid, fi ltered, and sorted, much like a normal attribute.
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Navigating Hierarchy Reports

Navigate through the hierarchy by expanding and collapsing the hierarchical
attributes using the plus (+) and minus (-) icons. You can also tap the cell
directly above the top level of the hierarchy and choose Expand/Collapse
>Expand All or Collapse All.

Sorting Hierarchy Reports

When a report with a hierarchical attribute is sorted, the structure of the
hierarchy remains intact, so every element retains its parent in the hierarchy
tree. Each level of the hierarchy is sorted separately from the other levels.

To sort on a hierarchy or a metric, tap the cell directly above the top level of
the hierarchy and choose Sort Ascending or Sort Descending.

Filtering Hierarchy Reports

To filter a Hierarchy report, tap the Filter icon to open the Filter panel. Then,
tap the filter you want to use. The Filter panel displays the elements of the
hierarchy in a tree. Expand or collapse the filters using the plus (+) and
minus icons. You can also expand or collapse all of the filters by tapping
Expand/Collapse >Expand All or Collapse All.

Analyzing data using links
A link is a connection between the currently displayed MicroStrategy
document and another document, a different screen, or another app. When
selected, a link can do one of the following:

l Execute another document or report from the currently displayed
document.

l Return you to the Prompt Summary screen or the Group-by page for the
current report or document.
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l Open another application on your device. Documents can interact with the
following apps via links:

l Email

l Phone

l SMS (text messaging)

l Maps

l Videos

Links in MicroStrategy documents can be displayed as images or text. To
follow a link that is displayed in a report or document, tap the linked image
or text.

An object that contains a link can also be able to be dril led on. In this case,
when you tap the object, a menu is displayed. Select whether to follow the
link or to dril l on the object.

Analyzing data in a table: Interactive Grid widgets
Data can be displayed in an interactive table as part of an Interactive Grid
widget.

An example of an Interactive Grid widget is shown below:
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In this widget, attributes and metric values are displayed in the columns and
rows, and grouping appears at the top of the screen. The widget above is
grouped by Region.

Other ways to analyze data in a table may be enabled for your document,
and include:

l Tapping the metric to switch between metrics, if a report or document
contains more than one metric.

l
Displaying different groups of data by tapping the Menu button at the

top right corner of the screen, then tapping Page-By (for a report) or
Grouping (for a document) and selecting the group of data that you want
to display.

l If dril l ing is enabled for an object, the object is underlined. Dril l ing allows
you to view data at different layers. Dril l on an object by tapping it. For an
example, see Viewing data at different levels using dril l ing, page 107.
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l Switch between displaying the widget in full screen and non-full screen
mode by tapping the Enter full screen or Exit full screen button.

Analyzing data on a map: Map widgets
Reports and documents can display information based on locations on a
map, as shown below:

Map widgets can use Geo Location prompts to narrow the map area that is
displayed. For example, when you answer the prompt with your current
location, a Map widget can show locations that are within a given distance
from your current location. For instructions to answer prompts on an Android
device, see Filtering displayed data: Answering prompts, page 100.

Points of interest can be marked on the map. In the example above, the
markers indicate stores in the area. A tooltip is displayed for a specific
marker, to provide details about the selected store. To display a tooltip, tap
on a marker.

Other ways to analyze data on a page may be enabled for your document,
and include:
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l Selecting a different metric by tapping the header in the top right.

l If using Android 3.x or higher, zoom by performing a pinch.

l Switching between Map, Satellite, Terrain, and Hybrid views by tapping
the Menu button at the top right corner of the screen, and then

selecting the appropriate option.

Analyzing trends at a glance: Microcharts widget
The Microcharts widget lets you visualize trends in a metric's value at quick
glance. An example of the Microcharts widget on an Android tablet is shown
below:

To analyze data with the Microcharts widget

1. To view information about a data point in a graph, tap and hold your
finger over it. A tooltip with information is displayed.

2. Drag your finger along the graph to view tooltips for each data point.

3. To expand all of the elements in tree mode, pinch open over the
collapsed categories.
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4. To collapse all of the elements in tree mode, pinch close over the
expanded categories.

Analyzing data on a time-based graph: Time Series widgets
Reports and documents can include a line graph that displays data over a
period of time, by using a Time Series widget.

A Time Series widget can contain multiple data series on the same graph.
For example, the values for the Cost metric for the Books and Electronics
subcategories are displayed in the image above.

Other ways to analyze data on a time-based graph may be enabled for your
document, and include:

l Displaying tooltips by tapping and holding on the graph.

l Changing the metric or attribute being displayed by tapping the object. (If
you can change the object, a small triangle appears in the top left.)

l Scrolling through the time axis by swiping horizontally, or if you are using
a tablet, dragging the highlighted portion of the slider at the bottom.

l Selecting a fixed time period by tapping its header.
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l If you are using a tablet, determine the range of values to view by dragging
the left or right edge of the slider to adjust its size.

Using documents to send or update data in your data
warehouse: Transaction Services
Some documents may include forms that you can use to edit or add
information to your data warehouse through Transaction Services. Some
examples are documents that approve requests, track business activity, and
execute business decisions, directly from your mobile device. Any new data
or changes are saved in your data warehouse.

Prerequisites

l You must have the Execute Transaction privilege.

l The document must be a Transaction Services-enabled document.

Depending on how the document is designed, you may be able to manipulate
data in the following ways:

l Edit text or numerical values in a text box.

l Use a slider to select from a range of values.

l Select values from a drop-down list.

l Use an On/Off switch to answer Yes or No questions.

l Use a date/time wheel to select a date.

l Once you have made the changes that you want to make, select one of the
following options:

The designer may use different names for the buttons or links described
below.

l To preview the results of your changes without updating your data
warehouse, tap Recalculate.
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l To update the data warehouse with the values that you provided, tap
Submit.

If you are not connected to the internet, the Transactions Queue button
is displayed. Your changes are sent to your data warehouse when a

connection is available.

l To undo the changes you have made, tap Discard Changes. The
document reverts to the values from the last time you submitted data.

To edit pending transact ions

1. In the Shared Library, tap the Menu button.

2. Tap the Transactions Queue button . The Transactions Queue

opens, with a list of pending transactions.

3. To change the values you want to submit, tap a transaction in the queue
to select it, and then tap Edit.

4. To delete a transaction, tap the transaction in the queue to select it,
and then tap Delete.

Uploading images
If enabled in the document you are viewing, you can upload images to the
document by either selecting an image from your photo album, or by taking a
picture using your device's camera. You can display only a specific area of a
photo, and you can provide captions for photos that you upload to a
document.
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To upload images using the Photo Uploader widget

1. In a document with the Photo Uploader widget, tap Add Photo.

l If your device has a camera, a menu is displayed, with the option to
either take a new photo or use an existing photo. Follow the steps
below to take a new photo or use an existing photo from your album.

l If your device does not have a camera, your photo albums are
displayed. Follow the steps below to use an existing photo from your
album.

2. To take a new photo, do the following:

a. Tap Take New Photo. The camera opens.

b. Use the device's camera to take a photo. A preview of the photo is
displayed, with the option to add a caption.

c. To use this photo in the document, tap Use. To discard this photo
and take a new one, tap Retake.

3. To use a photo from your album, do the following:

a. Tap Choose Existing Photo. A list of the photo albums on your
device is displayed.

b. Navigate to the photo to upload, and tap its thumbnail. The Choose
Photo screen is displayed.

c. Use the pinch gesture to zoom into the photo, and drag on the
photo to select which area to use.

d. When you have selected which area to use, tap Use. A preview of
the photo is displayed, with the option to add a caption.

e. To use this photo in the document, tap Upload. To discard this
photo and use another, tap Retake.
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Once you have selected a photo, the counter at the top right of the
widget indicates the number of photos you have chosen.

4. To add more photos, tap Add Photo again, and repeat the steps above
to either take a new photo or use a photo from an album.

5. After you have added all the photos, upload them by tapping Submit.
Depending on the document's configuration, a confirmation may
appear.

Viewing images
Some documents may include a browsable series of images. In these
documents, you can swipe left or right to navigate between images, and tap
an image to make it fi l l the screen.
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Design ing Repor t s and
Docum en t s fo r M ob i le Devices

This chapter contains steps to design reports and dashboard-style
documents in MicroStrategy Web, for display and use on mobile devices
such as iPhones, iPads, and Android-based phones and tablets. These can
be standalone documents or documents that are part of a mobile app. This
chapter also contains best practices for designing reports and documents
that perform well and are easy to use. The following topics are covered:

l Best practices for designing reports and documents for mobile devices,
page 120. Designing a MicroStrategy report or dashboard-style document
that is viewed on iOS and Android devices requires the use of device-
specific document features. This section discusses best practices for
using these features.

l Creating documents for mobile devices, page 127. This section describes
the ways in which you can design dashboard-style documents for iOS- and
Android-based devices, and to use features specifically designed for these
devices.

l Allowing users to filter data: prompts, page 173. A prompt is a question
that the system presents to a user when a report is executed. The user's
answer determines the data that is returned by the report. Specific
prompts can be added to a report for use on a mobile device that has the
MicroStrategy Mobile application.

l Allowing users to filter data using filter panels, page 190. You can create a
panel of selectors in a dashboard-style document that acts as a filter
panel, where users decide what data in the document is displayed by
making selections in the panel.
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l Organizing transactions with tables on iOS devices, page 191. A user can
interact with data and send those interactions back to the data source. For
example, a user can add a new customer contact name and details while
on-site with the customer, and send the new data back to be recorded in
the data source immediately. Transactions allow users to make decisions
and write back to the data source. If you have multiple input object
controls on a document displayed on an iOS device, you can create a
transaction table to group and organize the controls.

Prerequisites

l This chapter assumes that you know the nature and structure of your
company's data, which users will analyze in business intelligence reports
and documents.

l This chapter assumes that you are familiar with designing MicroStrategy
reports and documents and have the necessary privileges to do so.

For information on designing MicroStrategy reports, see the Basic
Reporting Help. For information on designing dashboard-style
documents, see the Document Creation Help.

Best practices for designing reports and documents
for mobile devices

Designing a report or dashboard-style document that is viewed on iOS and
Android devices requires the use of device-specific document features. This
section discusses best practices for using these features.

Best practices for enhancing performance on a mobile device
l Keep the report or document as focused as possible, by providing only the
objects necessary for an effective analysis.
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l Consider using Intelligent Cubes to provide historical or trend data in your
documents. For background information on Intelligent Cubes, and
instructions to create reports based on Intelligent Cubes, see the In-
memory Analytics Help.

l To let users display subsets of data, group data in a document using
features such as page-by. Accessing a cached report or document that has
multiple pages is faster than re-prompting the report or document, which
resubmits the job to the Intelligence Server.

Best practices while planning reports and documents
l Sketch the documents you will use in your app and outline how users will
navigate between them. If you are creating an app for both tablets and
mobile phones, you may want to create multiple diagrams for your app,
one for each screen size. Diagramming the documents and links that need
to be created allows you to identify:

l If you are creating an app that uses an existing dashboard-style
document, whether the content in that document needs to be
reorganized to suit a smaller screen.

l If you are creating an app with documents that contain a large amount of
data, consider splitt ing each document into multiple, smaller documents
to reduce loading time. You can then use links to allow users to switch
between the documents.

l The navigation tools you must include. For example, you can include a
tab bar on the bottom of every document that links users to other
documents or you can allow users to navigate through documents by
swiping right or left. For descriptions of the navigation tools you can use,
see Chapter , Using links in documents.

l If users must tap on or swipe across an object, the size of those objects.
In general, objects that users are meant to tap on should be at least 30
pixels wide and 30 pixels tall. For best results, make the objects larger,
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around 45 pixels wide and 45 pixels tall.

l If you are creating an app or a document that links to other documents,
the order in which these documents must be built. Links must be created
after the document they target has already been created. For
instructions on creating links in mobile documents, see Chapter , Using
links in documents.

l Where duplicate functionality exists. If two documents display different
data with the same formatting, you may be able to create one document,
duplicate it, and change the datasets to save development time.

l The datasets that are needed. One dataset can frequently supply data to
multiple documents, which can speed up development and reduce cache
sizes on the Intelligence Server.

l Any user interactivity you may want to include, such as widgets for data
visualization or changing the appearance of the app when the mobile
device is oriented in landscape mode instead of portrait.

l Consider the mobile device you are designing for:

l Create your documents using fonts that are available on the device.

l Ensure that the document displays correctly on the mobile device by
defining the display properties, available in the Properties dialog box.
These properties include optimizing the layout for display on a device,
and whether the page-by bar and re-prompt icon are displayed. For
descriptions of these properties, see Creating documents for mobile
devices, page 127.

l Consider the size of the device's screen when building your reports.
Although users can scroll through data, reports with fewer metrics
improve performance and are usually easier to read. In addition, take
advantage of the larger screen size available on tablet devices.
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l Design documents for tablets such that users can view all the data in a
single screen without panning. If more data must be displayed than will
f it on one screen, consider using panel stacks to arrange the data such
that the user can navigate by swiping or using selectors.

l To take advantage of the high-resolution screens on newer iOS devices,
consider using large images in your documents.

If the documents are for both older and newer mobile devices, add the
suffix @2x to the image's file name. This ensures that the image is
appropriately resized for older devices. For example, use
http://example.com/image@2x.png. For devices with high-
resolution screens, such as the iPhone 6 Plus and newer, use the suffix
@3x.

l In documents for tablets, use Information Windows to show users
additional information about an attribute element they select. For
information on creating Information Windows, see Providing additional
information to users: Information Windows, page 149.

l In documents for tablets, use the Interactive Grid widget adjacent to a
panel stack, and use the Interactive Grid as a selector that targets the
panel stack. This allows users to view additional information without
linking to a new document.

l In general, use at least 13-point size font. Font sizes that are greater than
or equal to 13-point font are easier for readers to view.

l Images are easier to manage if they are hosted on a web server, and
referenced using HTTP or HTTPS URLs. That way, if you need to migrate
images across environments, you do not need to change the URLs for the
images.

An example of an HTTP URL to an image is
http://example.com/folder/image.png.
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l You can configure the mobile apps to pre-cache reports, documents, or
dashboards, so that they are available to users if they are offline. If the
reports and documents contain images, to ensure that the images are pre-
cached, store the images on both your Mobile Server and Intelligence
Server machine. By default, the folders that you can store your images in
are:

l Mobile Server: C:\Program Files\MicroStrategy\Mobile

Server ASPx\Images

l Intelligence Server: C:\Program
Files\MicroStrategy\Intelligence Server\Images

When you add the images to your documents or dashboards, use relative
paths for the image's location, for example, .\images\mobile_
example.png.

l If the data in your document is frequently updated, you can have the
document periodically refresh itself as it is being displayed on a mobile
device. For steps, see Enabling automatic refresh for documents, page
143.

l In a Transaction Services document, you can submit a unique ID for a
specific mobile device, using the Mobile ID prompt. This allows you to
keep track of which mobile devices are creating which records. You can
filter the transaction date by Mobile ID.

The Mobile ID prompt is a system prompt, which is a special type of
prompt that does not require an answer from the user. Instead, it is
answered automatically by Intelligence Server. System prompts are
located in the Public Objects/Prompts/System Prompts folder in
Developer. For background information on system prompts in general, see
the System Administration Help.

l Use the docked panel selector to display visualizations grouped on panel
stacks. For information on creating docked panel selectors, see Allowing
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users to easily switch between panels: docked panel selectors, page 146.

l For reports with data grouped by an attribute in the page-by pane, you can
choose to display the report on an iPad as a book with a separate page for
each attribute element. This option, called Enable book-style page-by
navigation, is selected by default. For steps to group data in a report, see
the Basic Reporting Help.

Best practices while creating reports and documents
l Consider using one of MicroStrategy's pre-designed templates when
creating documents for a mobile device. The pre-designed templates take
into account the size of the device's screen. For a list of pre-designed
templates, see Creating documents for mobile devices using a template,
page 128.

l Enable dril l ing to give users the ability to view information at different
levels within a single report. Dril l ing allows users to get more information
from one report without having to browse to, and run, other reports.

l When designing graph reports to be used on a mobile device, consider the
following:

o To display tooltips on mobile devices, enable tooltips for the graph
series while creating the graph. For steps, see the Basic Reporting Help.

o To maximize the graph size, move the legend below the graph.

o The following graph types are supported on Android devices:

n Bubble

n Funnel

n Gauges

n Horizontal Area

n Horizontal Bar
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n Horizontal Line

n Pareto

n Pie

n Scatter

n Vertical Area

n Vertical Bar

n Vertical Line

o If you must display more information than can fit on one screen, use
page-bys to break the graph in logical places across multiple screens.

l When designing grid reports, add padding around the cells to make the
data more legible on mobile devices.

l Because Android devices come in varying screen sizes, a document
designed for iOS may appear different when viewed on an Android device.
To adapt a document's display to an Android device, while leaving the
display on an iOS device unaffected, use the following properties to
modify the document:

o Use the Fit Page or Fit Width options to ensure that the document fits
to the size of the screen. Before selecting one of these Zoom options on
the Home toolbar, optimize the layout for micro applications. For steps,
see Formatting document tabs: layouts, page 137.

o By default, when the document is displayed on an Android device, any
area not used to display the document is rendered in the same color as
the background color defined for the document. You can use the
Document Fill Color or Layout Watermark to provide a background for
any part of the screen that is not used by the rest of the document.

o Manually size the column widths of any grids on a document, rather than
using the automatic resizing options.
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l Consider using Mobile Views to support different screen sizes, and
different orientations of the device. For instructions on using Mobile
Views, see Formatting documents for various screen sizes and different
orientations: Mobile Views, page 131.

l Consider creating documents that include widgets, rather than converting
reports to widgets. Certain features, such as Information Windows and
network lines for the Map widget, can only be used in documents.

For steps to create widgets in documents, see Chapter , Displaying data
as interactive visualizations: Widgets.

l If you are creating an Interactive Grid widget, it is recommended that you
assign an action to only one attribute form in the widget. For example, if
you want one attribute to act as a selector, ensure that dril l ing is disabled
for the Grid/Graph, and that attributes on the Grid/Graph do not link to
other reports or documents.

For steps to create an Interactive Grid widget, see Displaying data in rows
and columns: Interactive Grid widget, page 222.

l Consider using links to add interactivity to your document. For example,
you can create links that allow users to send an email, make a phone call,
or execute related reports and documents. For information and the steps
to create links, see Opening a device's installed applications from
documents, page 287 and Linking to reports and documents from a mobile
document, page 294.

l If you have prompts in a linked-to report, make sure that there are default
answers saved for the prompts.

Creating documents for mobile devices

This section describes the ways in which you can design dashboard-style
documents for iOS- and Android-based devices, and to use features
specifically designed for some devices.
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If you are creating an app, you can use dashboard-style documents as the
pages and panels of your app and create links on buttons and tab bars in
your documents to allow users to navigate to other pages or panels in the
app. For steps, see Chapter , Using links in documents.

This section assumes that you have created a document with the datasets
that you want to analyze. For steps to create a document, refer to the Report
Services Document Creation Guide.

Creating documents for mobile devices using a template
A document template allows you to start with a predefined structure when
you create a new document. You can use several predesigned templates for
your mobile documents to help you create documents that are correctly
sized for the device's screen, as described below.

The following templates are optimized for display on iPhone and Android
smart phones:

l iPhone Portrait: This template is designed to be viewed on an iPhone or
Android smart phone held in a vertical position. Only the Detail Header
section of the document is displayed.

o Width: 6.6 inches

o Height: 9.6 inches, which includes room for the smart phone's status bar

o Supported orientation: Portrait only

o Graph tooltips displayed: Yes

l iPhone Portrait Micro-Application: This template is the same as the
iPhone Portrait template, except that the Optimize layout for micro
application option is selected, preventing users from performing actions
such as zooming in or out of the document. This allows you to better
control the user's experience and interaction with the document.

l iPhone Landscape: This template is designed to be viewed on an iPhone
or Android smart phone held in a horizontal position. Only the Detail
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Header section of the document is displayed.

o Width: 10 inches. The smart phone's status bar is not displayed in
landscape view.

o Height: 6.6 inches

o Supported orientation: Landscape only

o Graph tooltips displayed: Yes

l iPhone Landscape Micro-Application: This template is the same as the
iPhone Landscape template, except that the Optimize layout for micro
application option is selected, preventing users from performing actions
such as zooming in or out of the document. This allows you to better
control the user's experience and interaction with the document.

l iPhone Map Information Window: You can define an Information Window
for a Map widget to be displayed on an iPhone or Android smartphone, to
display additional information when a user taps a map marker in the
widget. Use this template to create a document layout for use as an
Information Window. For detailed steps, see Using a layout as an
Information Window in a Map widget, page 238.

o Width: 3 inches

o Height: 2 inches

The following templates are optimized for display on iPad and Android
tablets:

l iPad Portrait: This template is designed to be viewed on an iPad or
Android tablet held in a vertical position. Only one section of the document
is displayed.

o Width: 8 inches
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o Height: 10 inches, which includes room for the tablet's status bar

o Supported orientation: Portrait only

l iPad Landscape: This template is designed to be viewed on an iPad or
Android tablet held in a horizontal position. Only one section of the
document is displayed.

o Width: 10.67 inches

o Height: 7.33 inches

o Supported orientation: Landscape only

For documents displayed on an iOS device, you can create a navigation
document, which contains only a tab bar. A tab bar displays a series of
buttons, which users can tap to navigate through the documents in your app.
Use the following templates to create a navigation document. For steps and
examples, see Linking from documents with buttons and tab bars, page 316.

l Navigation for iPad: This template is designed to create a navigation
document for iPads.

l Navigation for iPhone: This template is designed to create a navigation
document for iPhones.

Formatting documents for mobile devices
You can ensure that the document displays correctly on mobile devices by
defining the display properties, such as whether the document layout is
optimized for mobile phones, and whether the page-by bar and re-prompt
icon are displayed.

You can format the display properties at the following levels:

l For each Mobile View. You can create Mobile Views to define how your
document appears on different devices, and for different orientations of
the device. For example, you can size a graph so that it takes up less
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vertical space when displayed in landscape orientation on a device. For
instructions to define Mobile Views, see Formatting documents for various
screen sizes and different orientations: Mobile Views, page 131.

l In multi-layout documents, for each document layout. For descriptions of
the layout display properties, see Formatting document tabs: layouts,
page 137 and Disabling swiping between layouts in iOS documents, page
140.

You must use MicroStrategy Web to define these properties. For
instructions, see the steps below.

Formatting documents for various screen sizes and different
orientations: Mobile Views

You can specify how to display documents on iPhone, iPad, and Android
devices by using Mobile Views. Mobile Views allow you to quickly and easily
determine how the elements of a document are displayed in the following
scenarios:

l When users rotate their devices. For example, you can resize a graph to
take advantage of the extra horizontal space when the device is held in
landscape orientation, or rearrange the controls on the document to
accommodate the extra vertical space when the mobile device is held in
portrait orientation.

l When users access the same document from different devices, which may
have different screen sizes. For example, you can size text to take up less
room on a mobile phone in one Mobile View, or enlarge an image to fit a
tablet in another Mobile View. The document is automatically displayed
using the Mobile View that most closely matches the height and width
(resolution) of the device's screen.

l When users access the same document on different iPhone versions,
which have different screen sizes. You can create a view for each device,
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with the corresponding layout height. The objects on each layout can have
different sizes and positions.

When you use a Mobile View, controls in the document keep the same basic
settings when displayed in different Mobile Views. For example, a selector
containing a list of regions targets a graph displaying revenue data. If the
user selects the Southeast region from the selector, revenue information for
Southeast is displayed in the graph. When the user rotates the mobile
device and the document is displayed using a different Mobile View,
Southeast remains selected and the data displayed in the graph is
unchanged.

Parameters you can change in Mobile Views

Once you have added a Mobile View to a document, you can do the
following:

l Display a preview of the Mobile View in Design Mode or Editable Mode in
Web.

l Edit controls in the Mobile View. You can edit the following options for a
control independently in each Mobile View:

Editing any option that is not included in the list below also edits this
property for all other Mobile Views in the document. For example, if you
change the background color of a document section to green in one
Mobile View, the section is displayed as green in all other Mobile Views.

l The position of the control in the document

l The height and width of the control

l The height of the control's tit le bar (for Grid/Graphs, panel stacks, and
selectors)
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l Whether the control is hidden. You can determine whether a control will
be visible when the Mobile View is displayed on a mobile device. All
controls in the document must be included in each Mobile View you
define. However, you can hide a control in an individual Mobile View to
prevent it from being displayed when the document is viewed on a
mobile device. For steps to determine whether a control is visible, see
the Document Creation Help.

For example, you want to create two Mobile Views, but only want to
display a specific grid in the Mobile View for a single mobile device. You
must hide the grid in the Mobile View in which you do not want the grid to
be displayed.

l Whether the height and width of the control are automatically determined
or are fixed at a specific size

l The height of a document section

l Whether a document section can grow or shrink to fit its contents

l Whether to hide a document section if it has no content

l Show or hide all controls in the document in Design Mode, regardless of
whether they are shown when the document is displayed on a mobile
device.

By default, the mobile device tries to display a document using the Mobile
View that matches the exact height and width of the device's screen. If there
is more than one Mobile View with the same height and width as the mobile
device's screen, the first of these Mobile Views, as listed in the Manage
Views Editor, is used. Otherwise, the mobile device displays the Mobile View
whose width most closely matches the width of the mobile device's screen.

Using Mobile Views with mult i-layout documents

Documents can contain multiple layouts. When you create a Mobile View, it
is automatically available to every layout in the document.
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For example, a multi-layout document contains three layouts. If you create a
Mobile View to determine how the document is shown on an iPhone, you
must edit the controls in each layout to define how the layouts will be
displayed. You can use the Orientation option for Mobile Views in
conjunction with the Supported Orientation option for document layouts to
determine how a mobile device chooses the best Mobile View to use to
display a document layout, as follows:

l If the Supported Orientation of the document layout is set to Both Portrait
and Landscape, the document layout is displayed using the Mobile View
that most closely matches the height and width of the mobile device, as
well as the orientation in which the mobile device is held.

For example, if the mobile device is held vertically, the mobile device
attempts to display the document layout using the Mobile View that has
Orientation set to Portrait or Portrait and Landscape, and most closely
matches the height and width of the device. If only Mobile Views
designed to be displayed in landscape orientation have been defined for
the layout, the mobile device chooses the best Mobile View from among
those defined and rotates the Mobile View to be displayed vertically, to
match the orientation of the mobile device.

l If the Supported Orientation of the document layout is set to either Portrait
Only or Landscape Only, the document layout is displayed using the
Mobile View that most closely matches the height and width of the mobile
device, as well as the Supported Orientation of the layout.

For example, if the Supported Orientation is Portrait Only, the mobile
device attempts to display the document layout using the Mobile View
that has Orientation set to Portrait or Portrait and Landscape, and most
closely matches the height and width of the mobile device. If only Mobile
Views designed to be displayed in landscape orientation have been
defined for the layout, the mobile device chooses the best Mobile View
from among those defined and displays the Mobile View vertically, to
match the Supported Orientation of the document layout. The Mobile
View is locked to the same orientation as the Supported Orientation
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option, meaning that if the Supported Orientation is set to Portrait Only
and a Mobile View is displayed vertically on the mobile device, the
orientation of the layout as displayed on the mobile device remains the
same and does not rotate regardless of whether the user rotates the
mobile device.

When a document is viewed on the iPhone, the Supported Orientation
option determines which layout is displayed on the mobile device. The
mobile device then determines the best Mobile View to use to display the
layout. For more information on the Supported Orientation setting, see the
MicroStrategy Web Help.

To define a Mobile View in a document

1. In MicroStrategy Web, open the document in Design Mode or Editable
Mode.

2. From the Tools menu, select Manage Views. The Manage Views Editor
opens.

A default Mobile View is automatically displayed in the list of Mobile
Views, and cannot be deleted.

3. Click the Duplicate icon next to an existing Mobile View. A new Mobile
View is automatically created.

4. In the Name f ield, type a name for the new Mobile View.

5. Under the Resolution column, specify the height and width of the
mobile device screen on which to display the Mobile View, as follows:

a. In the first field, type the width, in pixels, of the device screen.

b. In the second field, type the height, in pixels, of the device screen.
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6. You can specify whether the Mobile View is designed to be displayed
on a mobile device when the device is held vertically or horizontally.
From the Orientation drop-down list, select one of the following:

l To display the Mobile View when the device is held vertically, select
Portrait Only.

l To display the Mobile View when the device is held horizontally,
select Landscape Only.

l To display the Mobile View when the device is held vertically or
horizontally, select Portrait and Landscape.

7. Repeat the appropriate steps above to define each Mobile View.

8. You can determine which Mobile View to display in Design Mode when
the document layout is displayed in Web. Under the Current column,
select the Mobile View to display.

9. To delete an existing Mobile View, click the Delete icon next to the
Mobile View to delete.

10. You can choose to show all controls in Design Mode in Web, regardless
of whether they are marked as hidden. For example, you design a
Mobile View to be displayed on the iPhone. The Mobile View contains
several controls that will be displayed on the iPhone, as well as a grid
that is marked as hidden and will not be displayed. You can choose to
display all the controls in Design Mode, including the grid. Do one of
the following:

l To display all controls in the layout in Design Mode, regardless of
whether they are hidden, select the Show hidden objects in Design
Mode check box.

l To display only the controls that are specified as not hidden, clear the
Show hidden objects in Design Mode check box.

11. Click OK to save your changes.
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12. Add controls to the document, such as text fields, images, graphs, and
so on. For steps to add controls to a document, see the Document
Creation Help. When you add a new control to the document, a
message is displayed asking if you would like to make the control
visible in all Mobile Views. Do one of the following:

l To make the control visible in all views, select Yes.

l To make the control visible in only the current Mobile View, select No.

l To remove a control from a Mobile View, select the control, and press
Delete. A message is displayed asking you if you want to delete the
control from the document. To hide the control from the current
Mobile View, while keeping it visible in all other Mobile Views, select
No.

To determine which Mobile View to display in Web

13. From the Tools menu, select Manage Views. The Manage Views editor
opens.

14. Under the Current column, select the Mobile View you want to display.

15. Click OK to save your changes.

To delete a Mobile View from a document

16. From the Tools menu, select Manage Views. The Manage Views editor
opens.

17. Click the Delete icon next to the Mobile View you want to delete.

18. Click OK to save your changes.

Formatting document tabs: layouts

Each layout in a document can be defined to display on an iPhone, iPad, or
Android device independently of other layouts within the same document.
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Steps are provided below to format a document layout for mobile devices.

For an introduction to multi-layout documents, see the Document Creation
Help.

To define how tabs in a document display on mobile devices

1. In MicroStrategy Web, open the document in Design Mode.

2. From the Tools menu, select Layout. The Properties dialog box opens.

3. From the left, under Layout Properties, click Mobile. You can define the
following display options:

l From the Supported Orientations drop-down list, select which
orientations you want the layout to support:

l Portrait Only (height is greater than width)

l Landscape Only (width is greater than height)

l Portrait and Landscape

4. You can also define the following display options for documents:

l To allow users to filter the display of the document by tapping a page-
by element from the page-by bar, select the Display page-by
interface check box.

l To allow users to change their prompt answers, select the Display
filter interface check box. The Filter button displays on the layout.

l To use a layout as an Information Window in a Map widget, select the
Use as Information Window for the Map widget check box.

An Information Window is a small pop-up window that provides
additional details about a location. It is displayed when a user
selects a map marker in a Map widget. For more information,
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see Using a layout as an Information Window in a Map widget,
page 238.

If the document is to be displayed on multiple devices, it is
recommended that you use a panel stack as the Information Window.
For information, see Providing additional information to users:
Information Windows, page 149.

l To prevent Android users from performing actions such as scrolling in
the document, choose Optimize layout for micro application.
Optimizing the layout for a micro-application prevents allows you to
better control the user's experience and interaction with the
document.

Selecting this option allows you to size the layout for Android devices
to fit the page or the width of the device's screen. When a user views
the document on an Android device, a fit-to-page layout is zoomed
and displayed within the screen, so that he does not need to scroll
vertically or horizontally to view any data. A fit-to-width layout is
zoomed to the width of the screen, so that a user does not need to
scroll horizontally to view any data. To do this, complete the following
steps:

a. Select Optimize layout for micro application.

b. Click Apply.

c. On the Home toolbar, select either Fit Page or Fit Width from
the Zoom drop-down list.

5. You can choose to always open a document in full screen mode. From
the left, under Document Properties, click Document, and select the
Always open this document in full screen mode check box.

Documents displayed on an iPhone in landscape orientation are
automatically displayed in full screen mode.
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When documents are displayed in full screen mode, the navigation
bars and action menu are hidden. You can control whether users
can access the hidden navigation bars and action menu.

l To display the navigation bars and action menu when users tap on the
full screen button at the top of the app, select the Allow users to
access navigation bars and action menu check box (default).

l To prevent users from accessing the navigation bars and access
menu, clear the Allow users to access navigation bars and action
menu check box.

l On the iPad, users are also unable to access the layout bar, which
displays the different tabs in the document.

l On the iPhone in landscape orientation, users are unable to access
the layout bar, which displays the different tabs in the document,
and the page-by bar. In Portrait orientation, users can access both.

Consider doing this when you want to control how users exit and
interact with the document, such as when the document is part of
a custom mobile app with its own navigation system.

To allow users to perform actions that would normally be done in
the action menu, you can create a link in the document that
performs the same action. For example, to allow users to exit the
document, you can create a link in the document that opens
another document or sends them to a different screen in the app,
such as the Home page. For steps, see Using links to access
features within the MicroStrategy Mobile application, page 312.

6. Click OK. The Properties dialog box closes.

Disabling swiping between layouts in iOS documents

By default, users can navigate between layouts in a document by swiping to
the left or right. On an iPad or iPhone, you can disable this default so that
users must use the layout bar to navigate between layouts.
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To disable swiping between layouts in documents on iOS devices

1. In MicroStrategy Web, open the document in Design Mode.

2. From the Tools menu, select Document Properties. The Properties
dialog box opens.

3. From the left, under the Document Properties section, click Mobile.

4. Do one of the following:

l To allow users to swipe between pages or select an option in the
layout bar to display a report or document, select the Enable swiping
to switch layout check box (default).

l To disable swiping between layouts and have users switch layout by
tapping the layout's name in the layout bar, clear the Enable swiping
to switch layout check box.

5. To enable graph tooltips on the device, select the Enable graph
tooltips check box.

6. Click Apply. The Properties dialog box closes.

Displaying documents on iOS devices with a dark or light theme

On the iPad and iPhone, you can choose whether documents use a dark or
light theme. In the image shown below, the document on the left is using the
dark theme, while the document on the right is using the light theme.
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A document's theme controls the colors of its tit le bar, menu, and may also
control the colors of the widgets in the document.

You may want to choose the dark theme if the document's background is
also dark, so that the title bar and menu match the document. Similarly, if
the document's background is light, you may want to choose the light theme.

You can also display documents with the same theme the app is using. By
default, Mobile apps use the dark theme.

To choose which theme a document displayed on the iPad or iPhone

uses

1. In MicroStrategy Web, open the document in Design Mode.

2. From the Tools menu, select Document Properties. The Properties
dialog box opens.

3. From the left, under the Document Properties area, select Mobile.

4. From the Document theme color drop-down list, select one of the
following:
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l If you want the document and its widgets to use the same theme as
the rest of the Mobile app, select Application theme color (default).

l If you want the document to always use the dark theme, select Dark.

l If you want the document to always use the light theme, select Light.

Enabling automatic refresh for documents

For iPhone, iPad, and Android devices, you can define whether the
document refreshes itself as it is being displayed on a mobile device.
Automatic refresh is helpful if the data is frequently updated.

Automatic refresh also applies to documents viewed in Express Mode in
MicroStrategy Web.

To enable automatic refresh in an iOS or Android document

1. In MicroStrategy Web, open the document in Design Mode.

2. From the Tools menu, select Document Properties. The Properties
dialog box opens.

3. From the left, under the Document Properties section, click Advanced.

4. Select the Automatically Refresh check box.

5. In the field, type the amount of time, in seconds, to wait before each
refresh.

6. Click OK. The Properties dialog box closes.

Enabling zoom for iOS documents

For the iPhone and iPad, you can define whether you can zoom in and out of
the document by pinching and double-tapping.
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To enable zooming in an iOS document

1. In MicroStrategy Web, open the document in Design Mode.

2. From the Tools menu, select Document Properties.. The Properties
dialog box opens.

3. From the left, under the Document Properties section, click Mobile.

4. Select the Enable zoom (pinch and double-tap) check box.

5. Click OK. The Properties dialog box closes.

Creating an image watermark for an Android document

An image watermark is a faint design appearing in the background of a
document. A watermark typically identifies or decorates pages. For example,
a business logo can appear in the background of an Android document.

To create an image watermark for an Android document

1. In MicroStrategy Web, open the document in Design or Editable Mode.

2. From the Tools menu, select Document Properties. The Properties
dialog box opens.

3. To make the background of the document transparent:

a. From the left, select Color and Borders.

b. From the Color drop-down list, select No Fill.

4. From the left, select Watermark.

5. To create an image watermark:
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a. From the Watermark drop-down list, select Image watermark.

The image file must be available to both the Intelligence Server
and to the designers of the document.

b. Type the path and file name of the image in the Source f ield.

c. By default, the image is automatically resized to fit within the
document margins while retaining its aspect ratio. To scale the
image manually, select a percentage from the Scale drop-down
list.

6. Click OK to return to the document.

Setting Info Window to partial screen per panel stack

An Info Window can be set to appear set to a specific initial slide in size and
screen position.

1. Right click anywhere on the panel stack to be used.

2. Select Properties and Formatting from the list.

3. In the General > Panel Stack section select the check box for Use as
Information Window.

4. In the Mobile Only section, set Window Mode to Slide from the drop
down menu.

5. Set Position as desired.

6. Select the check box next to Display in partial screen per panel
stack size on mobile phone

7. Set Initial sliding in width i f you selected Position Left or Right, or
Initial sliding in height i f you selected Position Above or Below.

8. Click Apply then OK to close the window.
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Allowing users to access information easily: mobile-friendly
panel stacks
In addition to the standard features supported by panels in documents, you
can use the following features to make viewing data in your app easy for
users:

l Allow users to easily switch between panels by tapping on circles
displayed in a docked panel selector that appears at the bottom of a panel
stack. See Allowing users to easily switch between panels: docked panel
selectors, page 146.

l Allow users to switch between panels by swiping. See Allowing users to
switch panels by swiping, page 148.

l Save screen space by using an Information Window, which is a pop-up
window that can display additional details when users tap a selector in a
document or a marker in a map widget. See Providing additional
information to users: Information Windows, page 149.

l In documents for iPad, determine whether a panel stack resets to the first
panel when an attribute selector that targets the panel stack is changed.
See Resetting panel stacks when selectors are changed, page 163.

Allowing users to easily switch between panels: docked panel
selectors

A docked panel selector allows users to switch between panels by tapping
on circles displayed on a selector bar that appears at the bottom of a panel
stack. An example of a panel with a docked selector on the iPad is shown
below:
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A row of circles, each representing a panel, is displayed in the center of the
selector. The current panel is marked with a dark circle.

You can use a docked panel selector in an app to display multiple graphs or
widgets in one space. You can also use the docked panel selector with a
panel stack to create an interactive slide show, where the information in one
panel progresses naturally to the information displayed in the next.

The steps to create a docked panel selector are described below.

To create a docked panel selector

1. In MicroStrategy Web, create a new document, or open an existing
document in Design Mode.

2. From the Insert menu, choose Panel Stack. When you move the mouse
cursor to the Layout area, the pointer changes to crosshair.

3. Click and drag in the Layout area to create the panel stack.

To cr eat e and con f igu r e a select o r f o r t he panel st ack

1. Right-click the panel stack, and choose Create Panel Selector. A
drop-down selector appears above the panel stack.
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2. Right-click the panel selector and choose Properties and Formatting.
The Properties and Formatting dialog box appears.

3. From the left, choose the Selector category.

4. Under Mobile, ensure that the Display selector docked to its panel
stack check box is enabled.

5. Click OK to save the changes.

To add panels and con t en t t o t he panel st ack

1. Hover the mouse cursor over the panel stack. A toolbar appears above
the panel stack.

2. Click Add Panel to add panels to the stack.

3. For each panel, click Add Content, and add grids or graphs to the
panel.

Allowing users to switch panels by swiping

You can allow users to change panels in a panel stack by swiping the
device's screen to move to the next or previous panel.

Pr er equ isi t es

This procedure assumes that you have created a document with the
following:

l A panel stack.

l A selector that targets the panel stack.
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To allow users to switch panels by swiping

1. Open the document in Design or Editable Mode.

2. Right-click the panel stack with the docked panel selector and select
Properties and Formatting. The Properties and Formatting dialog box
opens.

3. From the left, select General.

4. Select the Allow current panel to be changed without selector
check box.

5. Click OK to return to the document.

Providing additional information to users: Information Windows

Information Windows let users view additional information about a specific
object by tapping it. A pop-up window displays the additional information. A
user can display an Information Window by tapping:

l An attribute element in a grid or graph.

l A button.

l An image.

l An item in a selector.

l An object in a widget. For example, a user can tap a store's location in a
Map widget to display the store's address, phone number, and ratings.

l A text field.

An Information Window is a panel stack that is configured to appear as a
pop-up window over the selected object, displaying an additional
visualization or additional information based on the selected object. An
example of an Information Window in an iPad document is shown below:

Mobile Analysis Guide



Copyright © 2024 All Rights Reserved 150

You can customize the data that displays in an Information Window
depending on the content of the selected object by using the object as a
selector. In the above example, the Subcategory column in the grid is used
as a selector. When a user taps an element in the column, the Information
Window is displayed with data specific to that attribute element.

You can also use an Information Window as a navigational menu that
displays when a user clicks on a button in the page. For example, in the
MicroStrategy Mobile demo app below, an Information Window is used to
display a list of useful links within the app. The Information Window is
configured to slide in from the left side of the screen when the user clicks a
menu button in the app.
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To use an Information Window in a document, you must do one of the
following:

l Define a panel stack to be used as the Information Window, and a
Grid/Graph or selector that uses the panel stack as an Information
Window, as described in To define an Information Window for a
Grid/Graph or a selector in a mobile document, page 152.

l Define a panel stack to be used as the Information Window, and a text
field, image, or button that uses the panel stack as an Information Window,
as described in To define an Information Window for a text field, an image,
or a button in a mobile document, page 155.

You can specify how the Information Window is displayed, by specifying how
it opens (for example, it can slide in from the right), how it closes (using a
Close button or tapping outside the window), its location, and its opacity. For
examples of the different options and steps to specify them, see Specifying
the display of an Information Window on an iPad or iPhone, page 157.
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To define an Information Window for a Grid/Graph or a selector in a
mobile document

1. In MicroStrategy Web, navigate to the document to add an Information
Window to. The document must contain a Grid/Graph or a selector,
which must contain data related to the data to be placed on the panel
stack. This procedure includes steps to add a selector.

For example, the document shown below contains a basic grid:

2. Open the document in Design Mode.

To def ine t he panel st ack fo r t he In fo r m at ion Window

1. From the Insert menu, choose Panel Stack. When you move the cursor
into the Layout area, the pointer becomes a crosshair.

2. Click and drag anywhere in the Layout area to create the panel stack.
The panel stack is added to the document.

3. Right-click the panel stack, and select Properties and Formatting.
The Properties and Formatting dialog box opens.
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4. From the left, click General, then type an appropriate name for the
panel stack in the Name f ield. This name appears as the title of the
Information Window on the mobile device.

5. Select the Use as Information Window check box.

6. Click OK to save the changes.

7. Add data related to the Grid/Graph to the Grid/Graph or selector.

For example, in the document above, a pie chart representation of
Revenue for each Year is added to the panel stack, as shown below:

8. Do one of the following:

l If you are using a Grid/Graph, define the Grid/Graph as a selector.
Follow the steps below:

a. In the report grid, right-click the attribute you want to use as the
selector, and choose Use as Selector. MicroStrategy Web
automatically attempts to find targets for the selector.

In the above example, the Region attribute is used as a selector
for the Information Window.

b. To verify that the selector targets the Information Window, right-
click the attribute again, and choose Edit Selector. The
Configure Selector dialog box appears, as shown below.
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c. In the Selected Targets list, ensure that the Information Window
panel appears in the list.

d. Click OK.

l If you are using a selector, create the selector to target the panel
used as an Information Window. Follow the steps below:

a. Click the arrow next to the Selector Control icon on the

Controls toolbar, and then choose how to display the selector
from the drop-down list. When you move the mouse to the layout
area, the pointer becomes crosshairs.

b. Click the section of the Layout area in which to place the
selector. If you click and drag in the section, you can size the
selector.

c. Right-click the selector and select Properties and Formatting.
The Properties and Formatting dialog box opens.

d. From the left, choose Selector.
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e. Select an attribute, custom group, or consolidation in the Source
f ield. The elements of the source are displayed as items in the
selector.

f. In the Selected l ist, ensure that the Information Window panel
appears in the list.

g. Click OK.

9. Save the document.

For the example above, when the document is executed on an iPad, the
Information Window appears when the user taps an element in the
Region column, as shown below:

To define an Information Window for a text field, an image, or a button in
a mobile document

To cr eat e t he panel st ack fo r t he In fo r m at ion Window

1. In MicroStrategy Web, navigate to the document to add an Information
Window to.

2. Open the document in Design Mode.
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3. From the Insert menu, choose Panel Stack. When you move the cursor
into the Layout area, the pointer becomes a crosshair.

4. Click and drag anywhere in the Layout area to create the panel stack.
The panel stack is added to the document.

5. Right-click the panel stack, and select Properties and Formatting.
The Properties and Formatting dialog box opens.

6. From the left, click General, then type an appropriate name for the
panel stack in the Name f ield. This name appears as the title of the
Information Window on the mobile device.

7. Click OK to save the changes.

8. Add controls to the panel stack, such as Grid/Graphs or text fields.

To def ine t he t ext f ield , im age, o r bu t t on t hat uses t he In fo r m at ion
Window

1. In MicroStrategy Web, navigate to the document to add an Information
Window to.

2. Open the document in Design Mode.

3. Add a text field, image, or button to the panel stack.

4. Right-click the text field or image, and select Properties and
Formatting. The Properties and Formatting dialog box opens.

5. From the left, click General.

6. From the Panel Stack drop-down list, select the panel stack to use as
the Information Window.

7. Click OK to save your changes.

8. Save the document.
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Specifying the display of an Information Window on an iPad or iPhone

You can specify how an Information Window opens on an iPad or iPhone: by
popping up over the document, fl ipping up (like turning over a card),
increasing in size, or sliding in from an edge of the screen.

You can display a Close button on the Information Window or have it close
when the user taps outside the Information Window.

An Information Window can display in the best position automatically, at the
position of the panel stack, above or below the selected object, or to the
right or left of the selected object.

You can specify the transparency of the Information Window.

You specify these options by defining:

l The window Mode, which is how the Information Window opens (pop up,
flip up, scale, or slide)

l Whether the Close button is displayed

For pop-up Information Windows, you can specify the placement, or position,
of the Information Window.

l A flip-up or scaling Information Window displays in the center of the
screen.

l A sliding Information Window displays at the edge that it slid from.

In the document below, a user can tap the buttons on the left to display
Information Windows.
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Each Information Window is formatted differently. If a user taps the KPI
button, an Information Window without a Close button pops up. The user can
tap anywhere outside of the Information Window to close it.
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If the user taps the Task Logger button, the Task Logger Information
Window pops up. Notice that a Close button is displayed.
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When the user taps the Profit Forecast button, the Profit Forecast
Information Window slides in from the right.

To specify how an Information Window displays on iPads and iPhones

1. In Web, open the document in Design Mode.

2. Right-click the panel stack that is used as an Information Window, and
select Properties and Formatting.

3. From the left, choose the General category.

4. To specify how to open the Information Window, select one of the
following Window mode options:

l To open the Information Window by popping it up, select Appear.
(This is the default.)
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l To open the Information Window by flipping it up, like turning over a
card, select Flip Up.

l To open the Information Window by gradually increasing its size,
select Scale Up.

l To open the Information Window by sliding it from an edge of the
screen, select Slide.

5. If you selected Appear as the Window Mode, you can specify the
location of the Information Window. Select one of the following options
from the Placement drop-down list:

l To display the Information Window in the best position, select
Automatic. (This is the default.)

l To display the Information Window at the position of the panel stack,
select Fixed.

l To display the Information Window above the selected object (for
example, the item in the selector or the attribute in the grid), select
Above.

l To display the Information Window below the selected object, select
Below.

l To display the Information Window to the left of the selected object,
select Left.

l To display the Information Window to the right of the selected object,
select Right.

6. If you selected Slide as the Window Mode, you can specify which edge
to slide the Information Window from. Select one of the following
options from the Position drop-down list:

l Right (the default)

l Left
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l Above

l Below

7. By default, Information Windows on an iPhone fil l the screen when they
display. To scale the Information Window so it is the same size on the
iPhone as in Web, select the Display in partial screen per panel
stack size on mobile phone check box.

Information Windows on an iPad automatically scale so they are the
same size as in Web.

l If you selected Slide as the Window Mode, you can specify how much
of the Information Window initially displays. Users can then drag the
Information Window out to view the rest of the Information Window.
Do one of the following:

o If you selected Right or Left as the Information Window's position,
specify how much of the Information Window's left or right side
displays, respectively. Type the value, in inches, in the Initial
sliding in width f ield.

To display the full Information Window, type 0 (default).

o If you selected Above or Below as the Information Window's
position, specify how much of the Information Window's bottom or
top side displays, respectively. Type the value, in inches, in the
Initial sliding in height f ield.

To display the full Information Window, type 0 (default).

8. By default, the Information Window is closed when a user taps outside
of the Information Window. To close the Information Window by tapping
a button instead, select the Dismiss only when 'Close' button is
tapped check box.
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9. If the Information Window is set to open by flipping, increasing in size,
or sliding into the screen, you can define how transparent the
Information Window displays. Do the following:

a. From the left, select Effects.

b. In the Transparency f ield, type a percentage. A higher value
displays the Information Window as more transparent, while a
lower value displays the Information Window as more solid. The
default value is 0.

c. To blur the sections of the document that show through the
transparent Information Window, select Enable blur effect.

10. Click OK to save your changes and return to the document.

Resetting panel stacks when selectors are changed

In documents for iPad, you can determine whether a panel stack resets to
the first panel when an attribute selector that targets the panel stack is
changed. By default, the current panel (the panel that is displayed) does not
change when an attribute selector is changed. The steps to enable this
option follow.

To determine whether a panel stack resets when a selector is

changed

1. In MicroStrategy Web, open the document in Design Mode.

2. Right-click the panel stack, and select Properties and Formatting.

3. In the General category, select the Reset to first panel when
targeted (Mobile only) check box.

4. Click OK to save your changes.
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Allowing users easy access to document content: docked
headers and footers
You can ensure that users always have access to a section of content in a
mobile document by adding the content to a docked page header or page
footer. The content of a docked page header is always displayed at the top
of the screen, while a docked page footer is always displayed at the bottom,
regardless of screen size. Docked headers and footers remain in the same
place on the screen as the user scrolls up or down in the document, allowing
the user easy access to the footer's content.

Some examples of how you can use docked headers and footers are:

l To display important information, such as the name of your company,
project, or app, copyright information, or contact information.

l To create a navigation bar of useful links. Do this if you want to create a
custom navigation bar instead of the tab bar MicroStrategy provides. For
steps to create a tab bar, see Creating a tab bar to hold buttons, page 319.

Steps are below to define a docked page header or page footer.

To dock a header or footer to the top or bottom of a document

1. Right-click the page header or page footer section that you want to
define as docked, then select Properties and Formatting. The
Properties and Formatting dialog box opens.

2. From the left, click General in the Properties section. Do one of the
following:

l To display the page header or page footer as an ordinary header or
footer that is not docked to the top or bottom of the document, clear
the Dock to top of screen (Mobile only) check box or the Dock to
bottom of screen (Mobile only) check box
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l To display the page header or page footer as docked, select the Dock
to top of screen (Mobile only) check box or the Dock to bottom of
screen (Mobile only) check box.

Allowing users to copy text from documents on iOS devices
On an iPad or iPhone, a user can copy text from a document, by tapping and
holding the text to copy. If zoom is disabled, a user can also double-tap the
text.

If the document uses a document template other than an iPad or iPhone
template, the document may use a Detail section. The Detail section of a
document displays one row for each row of data in the document's dataset.
(For descriptions and examples of the different document sections, see the
Designing and Creating Documents chapter of the Report Services
Document Creation Guide.) If the text is displayed in the Detail section, a
user taps the text to copy.

For example, a document contains the heading "List of Regions" in the
Detail Header section, and the actual regions in the Detail, as shown below:

Zoom is disabled in the document, so double-tapping the word Region
displays a pop-up menu. The user can copy the selected text (Region), or
select all the text in the text field (List of Regions).

When a user taps Northeast, which is in the Detail section, the word
Northeast is selected. The pop-up menu allows the user to copy the selected
text (Northeast).
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For a document, you can enable copying for the whole document, and also
enable or disable copying for a specific text field, as described in the steps
below. This means that you can enable copying for all text fields on a
document, but specify that a particular text field cannot be copied.

To allow users to copy text from a text field in a document

1. In MicroStrategy Web, open the document in Design Mode.

2. To enable copying for the whole document, follow the steps below:

a. From the Tools menu, select Document Properties. The
Properties and Formatting dialog box opens.

b. From the list of categories on the left, under Document Properties,
select Mobile.

c. To enable copying from all text fields on the document, select the
Enable copy for text check box.

Text sub-selection is only supported outside of the Detail section. This
means that if the user selects text in the Detail section of the
document, all the text in the Detail section is selected. A user cannot
select a single word, as he can in other document sections. The
example in Allowing users to copy text from documents on iOS devices
demonstrates this.

3. By default, all text fields use the document-level setting to determine
whether copying is enabled. You can enable or disable copying on a
specific text field by following the steps below:

a. Right-click the text field, and select Properties and Formatting.
The Properties and Formatting dialog box opens.

b. From the list of categories on the left, select General.

c. Select one of the following:
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l To enable copying on this text field, select Enable copy for this
text.

l To disable copying on this text field, select Disable copy for
this text.

d. Click OK to save your changes and return to the document.

Notifying users: Displaying a badge next to the MicroStrategy
Mobile application icon
You can choose to display and update a badge displayed next to the
MicroStrategy Mobile application icon on a user's iPhone or iPad. The badge
is an alert you can use to inform users of important information, such as new
content or updates. A badge displays as a red circle with white text.

You can:

l Update the badge each time that the user runs a document. For steps, see
Updating the MicroStrategy Mobile application badge each time that a
document is run, page 167.

l Update the badge when the data in a report meets specific threshold
conditions. For steps, see Updating the MicroStrategy Mobile application
badge when the data in a report meets specific threshold conditions, page
168.

Updating the MicroStrategy Mobile application badge each time
that a document is run

You can update the badge displayed next to the MicroStrategy Mobile
application icon on a user's iPhone or iPad each time that the user runs a
document. To do so, you must add a text field to the document which
contains the value to display in the badge, as described in the steps below.
When the user runs the document, the value displayed in the text field is
automatically used to update the badge.
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To update the MicroStrategy Mobile applicat ion badge each time that a
document is run

1. In MicroStrategy Web, open the document in Design or Editable Mode.

2. You can have MicroStrategy update the badge with the value of a
metric, rather than a static value. Do one of the following:

l To update the badge with a metric value, from the Dataset Objects panel
on the left, click and drag the metric onto the layout area. A text field is
automatically created and displayed, containing shortcut text that will be
automatically replaced with the metric's value when the document is run.

l To update the badge with a static value, from the Insert menu, select
Text, then click the location in the layout area to add the text field to. A
blank text field is automatically created and added to the document. In the
field, type the value to display, then click outside the text field to apply
your changes.

3. Right-click the text field and select Properties and Formatting. The
Properties and Formatting dialog box opens.

4. Under Mobile, select the Set application badge to value of this field
check box.

5. Click OK to apply your changes.

Updating the MicroStrategy Mobile application badge when the
data in a report meets specific threshold conditions

You can update the badge displayed next to the MicroStrategy Mobile
application icon on a user's iPhone or iPad when a metric on a report meets
specific threshold conditions. This alerts users who see the badge to data
that is likely to be important for making business decisions. To do this, you
must create an alert-based subscription based on the metric, as described in
the steps below.
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Prerequisites

l You must have MicroStrategy Distribution Services installed.

l MicroStrategy Web must be configured to use Distribution Services.

l Mobile device users must have the Use MicroStrategy Mobile and Mobile
View Document privileges.

To update the MicroStrategy Mobile applicat ion badge when the data in a
report meets specific threshold condit ions

1. In MicroStrategy Web, run the report to use to update the application
badge.

2. Right-click the name of a metric in the report, then point to Alerts.
Select Mobile Notifications. The Alerts Editor opens.

3. From the Filter On drop-down list, select the attribute or metric to use
to create a condition.

4. If you are creating a condition based on a metric, do the following:

a. Select a comparison operator, such as Greater Than or Less Than.

b. Enter a value in the field on the right or click Select Metric to
choose another metric to compare the original metric to.

5. If you are creating a condition based on an attribute, do one of the
following:

l To define your condition by typing specific attribute form values:

a. Select the Qualify option.

b. From the drop-down list on the left, select the attribute form on
which to base the condition. For example, you can qualify on the
attribute element's ID form, one of its description forms, or the
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DATE if the attribute is time-based.

c. From the next drop-down list, select a comparison operator such
as Greater Than or Less Than. The operators available for a
selection depend on the attribute form you chose above.

d. Do one of the following:

o To compare the attribute form to a specified value, type the
value in the field.

o To compare the first attribute form to a second attribute form,
click Select Attribute, then select the second attribute form
from the drop-down list.

l To define your condition by selecting attribute elements from a list:

a. Choose the Select option.

b. From the drop-down list on the left, select In List or Not In List.
If you select Not in List, then the attribute elements in the
Selected list will not be included in the threshold condition.

c. Move attribute elements from the Available list to the Selected
list. Elements in the Selected list are included in the threshold
condition.

l To search for a specific element, use the Search for f ield. Select the
Match case check box to return only items that match the upper and
lower cases you typed in the Search for field.

6. Click the Apply icon to define the condition.

7. To add another threshold condition, select Add Condition, then repeat
the appropriate steps above to define the condition.

8. Expand Delivery Settings, then enter a name for the subscription in
the Name f ield.
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9. From the Schedule drop-down list, select a schedule or event. The
schedule choices available are created in the Developer Schedule
Manager. For steps, see the Scheduling Jobs and Administrative Tasks
chapter in the System Administration Guide.

10. If you want alerts delivered to a mobile device:

a. Click To to choose an address. The Recipients Browser dialog box
opens.

b. You can search for contacts or a contact list in the Find f ield. The
contacts will appear in the Available list below.

c. Click the left arrow and right arrow to add or remove contacts from
the To, Cc, and Bcc fields.

d. Click OK to save the list of addresses.

11. From the Device type drop-down list, select the type of device to
deliver the notifications to.

12. From the Target Application drop-down list, select the type of
application you want to send the report to.

13. Select the Update application badge with the value of this metric
check box. From the drop-down list next to the check box, select the
metric whose value you want to display next to the application icon.
Once a row of data in the report meets the threshold condition you
defined in the steps above, the value of this metric, as displayed in the
row, is shown next to the application icon. The first row of data that
meets the threshold condition is used to update the application icon.

For example, in the report displayed below, you can define a threshold
condition as "Profit greater than or equal to 200,000". If you select
Sales Team from the drop-down list, 8 is displayed next to the
application icon.
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14. If you want to specify an expiration date for the subscription, expand
Advanced Options and select the Do not deliver after check box,
then specify an expiration date by choosing a date from the calendar.

15. Click OK to create the subscription.

Creating documents that use Transaction Services to update
your data warehouse
You can create documents for iOS and Android devices that allow users to
change values in grids and then write those changes to your data
warehouse. Use Transaction Services in your apps and documents to update
data, write new information to your warehouse, or delete existing records.
This feature is available when you install Transaction Services.

For an introduction to Transaction Services, see the Advanced Reporting
Guide.

Some examples of how you can use Transaction Services are:

l To create a Corporate Request Center that allows users to approve or
deny time off, expenses, and purchase order requests.

l To create inspection forms. Inspectors can input data with sliders and
selectors. They can also take pictures of any issues they find. The results
of their inspections are instantly written to the database.

l To create and update budgets or calendars.
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Pr er equ isi t es

l You must have Transaction Services.

l You must have the Web Configure Transaction privilege.

Overview

The following is a high-level overview of the tasks you need to perform to
create a document that uses Transaction Services. Each high-level step
describes where to find specific instructions for designing transaction-
enabled documents:

l In Developer, create a Transaction Services report using the Freeform
SQL Editor. For instructions, see the Advanced Reporting Guide.

l In MicroStrategy Web, create a dataset report that includes the attributes
and metrics you added to the Transaction Services report above. For
instructions, see the Report Services Document Creation Guide.

l In MicroStrategy Web, create a document for mobile devices that uses the
above dataset report, and link it to the Transaction Services report you
created above. For instructions, see the Report Services Document
Creation Guide.

For iOS devices, the document can include a transaction table, which
provides a structure to organize multiple input object controls for the same
transaction. For steps to create a transaction table, including an example,
see Organizing transactions with tables on iOS devices, page 191.

The values in documents you create using the above procedure can only be
edited by users who have the Execute Transaction privilege.

Allowing users to filter data: prompts

A prompt is a question that the system presents to a user when a report is
executed. The user's answer determines the data that is returned by the
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report. Specific prompts can be added to a report for use on an iPhone,
iPad, or Android device that has the MicroStrategy Mobile application.
These prompts are then displayed when the prompted report, or a document
that uses the prompted report as a dataset, is executed on the device.

You can use prompts to customize the data within an app to the user. For
example, an app contains information on sales and inventory for all stores of
a company nationwide, with a prompt asking for which store(s) the user
would like to view data. Store managers in different regions typically want to
see data for different stores. Including a prompt allows you to create one
app that all store managers can use.

If an app or document has more than one prompt, you can filter the options
available in the second prompt based on the user's answers in the first
prompt. To do this, add the first prompt as a filter on the second prompt. For
steps to create a filter, see the Basic Reporting Help.

For an introduction to prompts, the basic prompt types, prompt creation, and
adding a prompt to a report, see theBasic Reporting Help. For instructions to
add a prompt to a document, see the Document Creation Help.

For best practices when creating prompts for mobile devices, see Best
practices for creating prompts for mobile devices, page 176.

For steps to answer prompts in MicroStrategy Mobile, see the MicroStrategy
Mobile Analysis Help.

You can display prompts on mobile devices in the following styles:

l Textbox: This prompt lets users type a value via a keypad to answer a
prompt.

l Slider: This prompt lets users select a numeric value on a horizontal
slider.

l Stepper: This prompt displays a numeric value. Users can tap the
increment and decrement buttons to increase or decrease the value for
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their prompt answer.

l Switch: This prompt lets users choose between two choices, On and Off.

l Wheel: This prompt displays a wheel or row of wheels that the user can
scroll through to specify a date or date and time. On Android devices, this
prompt is displayed as a stepper.

l Calendar: This prompt lets users select a date from a calendar.

l Geo Location: This prompt lets users filter results based on their current
geographical location. The prompt includes a request for permission to
enable a GPS-style locator. For more information, see Prompting users for
their location: Geo Location prompts, page 187.

l Barcode Reader: This prompt lets users answer a prompt by scanning or
typing a barcode. For more information, see Creating Barcode Reader
prompts, page 188.

l Tree: This prompt lets users answer a prompt by selecting objects in a
tree. Tapping one object in the tree displays all objects underneath it. For
more information, see Allowing users to choose elements from multiple
attributes: Hierarchy prompts, page 185.

Prompts for mobile devices are divided into four types: value prompts,
attribute element prompts, hierarchy prompts, and object prompts. Value
prompts require the user to select a single value, such as a date or number.
Attribute element prompts require the user to select from a limited list of
available attribute elements.

Hierarchy prompts require the user to select an attribute or attribute element
from a hierarchy of related attributes. For example, an app may display data
for a time period that the users specify. The app may include a prompt on the
Time hierarchy, which contains the Year, Month, and Day attributes. Users
can then choose to view data for a specific year, month, or day.

Object prompts require the user to select one or more objects from a list of
available objects. Objects prompts allow users to choose exactly what data
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they want to view. For example, a document may contain a grid with the
Region and City attributes. You can add an object prompt to allow users to
choose which metrics or filters to add to the grid.

Best practices for creating prompts for mobile devices
l Create prompts specifically designed for use on mobile devices. Some
examples of the prompt types are listed below:

o Slider, which allows users to answer the prompt by selecting a numeric
value on a slider.

o Stepper, which allows users to answer the prompt by using increment
and decrement buttons.

o Wheel, which allows users to answer the prompt by moving wheels to
specify a value.

o Geo Location, which allows users to filter results based on their current
geographical location.

o Barcode Reader, which allows users to answer the prompt by scanning
or typing a barcode.

l Prompts that are not specifically designed for mobile devices can stil l be
used. In general, use:

o The List style for single selections.

o The Shopping Cart style for multiple selections on iOS devices.

o The Geo Location style for geographical location data.

o The Barcode Reader style for barcode data.

Allowing users to filter data based on a single value: Value
prompts
A value prompt lets users select a single value, such as a date or specific
text string, and filter report data based on their selection. The different types
of value prompts are:
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l Date and time prompt: This prompt type asks users to type or select a
date, and returns data with the Date data type that matches the user's
selection. For example, the Date prompt can be useful when added to a
filter that screens data based on Year=2016. The prompt lets users select
a specific date within the year of the filter's condition. Date prompts are
used in filters that qualify on a date.

Date and time prompts are displayed as wheels on an iPhone or iPad, and
are displayed as a date/time stepper on an Android device.

l Numeric prompt: This prompt type asks users to type a numeric value.
Numeric value prompts accept integers or decimals up to 15 digits of
precision. Numeric prompts can be used in any filter that needs a number
input from the user. For example, a numeric prompt may be used to filter
results where the minimum value for Revenue is entered by the user.

Numeric prompts can be displayed as text boxes, numeric wheels, sliders,
steppers, switches to choose between two numeric values, and location
prompts.

l Text prompt: This prompt type asks users to type a string of text in a text
box.

Text prompts can be displayed as text boxes, or as barcode reader
prompts.

l Big decimal prompt: This prompt type asks users for a "big decimal"
value. Big decimal value prompts accept integers and decimals up to 38
digits of precision.

Big decimal prompts can be displayed as text boxes.

For more information about value prompts, see the MicroStrategy Web Help.
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To create a value prompt

1. On the MicroStrategy Web home page, click Create Prompt. The
Create Prompt page opens, with a list of the types of prompts you can
create.

2. Click Value Prompt. The New Prompt page opens.

3. Specify the type of value prompt, making your selection based on your
requirements:

l To let users filter for data related to either a specific date or a range
of dates, click Date and Time prompt.

l To let users filter numeric data, usually based on a metric, click
Numeric prompt.

l To let users filter text data, usually based on attribute forms, click
Text prompt.

l To let users filter data based on a big decimal value for a metric, click
Big Decimal prompt.

4. Click the General tab.

5. Specify a title and description for the prompt in the Title and
Instructions f ields.

To restr ict the prompt answers

6. To require users to answer the prompt before running the report, select
the Prompt answer is required check box.

7. To set the maximum and minimum values that can be entered by the
user, select the Minimum value and Maximum value check boxes and
type a value in the respective fields. You can specify a minimum value
even if you do not specify a maximum value.
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To specify the layout and display style of the prompt

8. Click the Style tab.

9. From the Display style drop-down list, specify a presentation style,
such as Textbox, for the prompt. This is how the prompt is displayed to
the user.

10. Depending on your requirements, choose the appropriate display style
and options by referring to the following table:

End Goal
Prompt Type
and Display
Style

Setup Recommendations and Requirements

Select a date
from a
calendar

Prompt type:
Date & Time

Display
style:

Textbox

Minimum value: Specify the earliest date that can
be used to answer the prompt.

Maximum value: Specify the latest date that can
be used to answer the prompt.

Select a date
and/or time
from a wheel

Prompt type:
Date & Time

Display
style:

Textbox

Minimum value: Specify the earliest date and time
that can be used to answer the prompt.

Maximum value: Specify the latest date and time
that can be used to answer the prompt.

Allow user to select time: Specify whether the
user can select a time as well as a date to answer
the prompt.

Interval (minutes): Specify the interval displayed
between each value on the wheel. For example, an
interval of 30 allows users to select times in 30-
minute intervals, such as 9:30 A.M., 10:00 A.M.,
10:30 A.M., and so on.

Type a Prompt type: Minimum value: Specify the lowest value that can
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End Goal
Prompt Type
and Display
Style

Setup Recommendations and Requirements

numeric value
to answer a
prompt

Numeric

Display
style:
Textbox

be used to answer the prompt.

Maximum value: Specify the highest value that
can be used to answer the prompt.

Use a switch
to choose
between two
numeric
values

Prompt type:
Numeric

Display
style: Switch

On value: Specify the numeric value used when
the switch is set to its On position. The default is 1.

Off value: Specify the numeric value used when
the switch is set to its Off position. The default is 0.

Select a
numeric value
on a
horizontal
slider

Prompt type:
Numeric

Display
style: Slider

Minimum value (required): Specify the lowest
selectable value in the slider.

Maximum value (required): Specify the highest
selectable value in the slider.

Interval: Specify the interval displayed between
each value on the slider. For example, an interval
of 10 allows users to specify values in increments
of 10, such as 10, 20, 30, and so on.

Use a stepper
to increment or
decrement a
numeric value

Prompt type:
Numeric

Display
style:
Stepper

Minimum value: Specify the lowest value that is
displayed in the prompt.

Maximum value: Specify the highest value that is
displayed in the prompt.

Interval: Specify the interval used to increment or
decrement values in the stepper. For example, if
the stepper's minimum value is set to 100, and the
interval is 10, users can increment the stepper
value to 100, 110, 120, and so on.

Select a
numeric value
from a wheel

Prompt type:
Numeric

Minimum value: Specify the lowest value that is
displayed in the prompt.
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End Goal
Prompt Type
and Display
Style

Setup Recommendations and Requirements

Display
style: Wheel

Maximum value: Specify the highest value
displayed in the prompt.

Interval: Specify the interval displayed between
each value on the wheel. For example, an interval
of 30 allows users to specify values in increments
of 30.

Filter data
based on a
user's current
location

Prompt type:
Numeric

Display
style: Geo
Location

Mobile preferences: Select the Latitude or
Longitude option to filter data based on the
current latitude or longitude.

For Geo Location prompts, you must create
one prompt for the longitude, and one for the
latitude.

For a detailed description of the Geo Location
prompt, see Prompting users for their location: Geo
Location prompts, page 187.

Type text to
answer a
prompt

Prompt type:
Text

Display
style:
Textbox

Minimum number of characters: Specify the
minimum required length of the prompt answer.

Maximum number of characters: Specify the
maximum allowable length of the prompt answer.

Scan or type
an item's
barcode

Prompt type:
Text

Display
style:
Barcode
Reader

Minimum number of characters: Specify the
minimum required length of the barcode.

Maximum number of characters: Specify the
maximum allowable length of the barcode.

For a detailed description of the Barcode Reader
prompt, see Creating Barcode Reader prompts,
page 188.
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End Goal
Prompt Type
and Display
Style

Setup Recommendations and Requirements

Type a large
number to
answer a
prompt

Prompt type:
Big Decimal

Display
style:
Textbox

Minimum value: Specify the lowest value that can
be used to answer the prompt.

Maximum value: Specify the highest value that
can be used to answer the prompt.

For examples of each prompt display style, see Allowing users to
filter data: prompts, page 173.

To save the prompt

11. To save the prompt, click Save As. The Save As dialog box opens.

12. Specify a name, description, and the location in which to save the
prompt and click OK. The Save As dialog box closes, and the prompt is
saved.

Allowing users to choose from a list of attribute elements:
Attribute element prompts
An attribute element prompt lets users select prompt answers from a limited
list of specific attribute elements.

The table in the steps below provides a list of attribute element prompt types
that you can create in MicroStrategy Web for use on a mobile device. To
create a prompt that accomplishes a specific goal, find the task you want to
perform in the first column in the table, then see the remaining columns for
the display style, recommendations, and requirements to create the prompt.
For images of each prompt display style, see Allowing users to filter data:
prompts, page 173.

For more information about attribute element prompts, see the
MicroStrategy Web Help.
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To create an attr ibute element prompt

1. On the MicroStrategy Web home page, click Create prompt.

2. The Create Prompt page opens with a list of the types of prompts that
you can create. Click Attribute Element List.

3. To determine the attribute whose elements the user can choose from,
click Select Attribute. Select the attribute whose elements are
displayed in the prompt and click OK.

4. To define the elements that a user can choose from, choose one of the
following options:

l To display all the attribute elements to users while they are
answering the prompt, choose List all elements (no restriction).
This option is recommended only if there are a small number of
elements for the attribute.

l To create a list of attribute elements from which users can choose,
select Use a predefined list of elements. This option is
recommended if users need to choose from a specific set of
elements.

To select the elements, click Add, then click OK. To remove an
object, highlight it and click Remove. To remove all items, click
Clear.

l To narrow the list of available attribute elements by using a filter,
choose Use a filter to reduce the number of elements. This option
is recommended for attributes with a large number of elements.

For example, you can restrict the Customer attribute by only showing
the top 100 customers. Browse to and select the filter.

Filtered attribute element prompts apply to iOS devices. On Android
devices, all attribute elements are displayed.
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5. Click the General tab.

6. Specify a title and description for the prompt in the Title and
Instructions f ields.

7. To require users to answer the prompt before running the report,
specify whether the prompt requires an answer. Select the Prompt
answer is required check box.

8. Optionally, set the maximum and minimum number of prompt answers
allowed. Enter these numbers in the Minimum number of answers and
Maximum number of answers f ields.

9. Click the Style tab.

10. You can determine the presentation style used to display the prompt to
the user. The default is Shopping Cart. From the Display style drop-
down list, select the presentation style you want to use.

11. Depending on your requirements, select the appropriate display style
and options by referring to the following table:

End Goal
Display
Style

Setup Recommendations and Requirements

Select a date-
based attribute
element from a
calendar

Calendar

Minimum date: Specify the earliest date that users can
select.

Maximum date: Specify the latest date that users can
select.

Select an
attribute element
from a list

List

Show search box: Specify whether users are presented
with a search box to filter the list of attribute elements.

Make search required: Specify whether to require that
users search for elements.

Use the current
geographical
location to filter

Geo
Location

Select location mapping level: Select the level at
which to filter attribute elements. For example, if this
option is set to City, the attribute elements will be
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End Goal
Display
Style

Setup Recommendations and Requirements

attribute
elements

filtered to include only those in the current city.

Select location mapping attribute: Select the attribute
to use to filter the element list. The location mapping
attribute must contain attribute forms for latitude and
longitude, and these attribute forms must be visible on
the template.

For a detailed description of the Geo Location prompt,
see Prompting users for their location: Geo Location
prompts, page 187.

Scan or type the
barcode of an
item to search for
an attribute
element

Barcode
Reader

Show search box: Specify whether users are presented
with a search box to filter the list of attribute elements.

Make search required: Specify whether to require that
users search for elements.

Barcode mapping attribute form: Select the attribute
form used to look up barcode information.

For a detailed description of the Barcode Reader prompt,
see Creating Barcode Reader prompts, page 188.

12. To save the prompt, select Save As. The Save As dialog box opens.

13. Specify a name, description, and the location in which to save the
prompt and click OK.

Allowing users to choose elements from multiple attributes:
Hierarchy prompts
Users can answer a prompt on an iPad or iPhone by selecting attribute
elements from all of the attributes in a hierarchy, using the Hierarchy
prompt.
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Use Hierarchy prompts when users want to view or compare data for
different types of attribute elements. For example, a user wants to analyze
sales information across all the products in his store. The user wants to be
able to analyze sales data for specific items in his store and analyze sales
data across different product categories. You can create a Hierarchy prompt
on the Product hierarchy, which contains both the Item and Category
attributes, and add it to the report.

For steps to create a Hierarchy prompt, refer to the Basic Reporting Guide.

Allowing users to choose from a list of objects: Object prompts
Users can answer a prompt on an iPad or iPhone by selecting from a list of
objects. The object prompt is more flexible than the attribute element
prompt. Instead of choosing from a list of attribute elements, users can
choose from a list of objects, such as attributes, metrics, and custom
groups. Users can also choose which filter to apply to a report or document.

Use Object prompts when users want to control what data they view in a
report or document. For steps to create an Object prompt, refer to the Basic
Reporting Guide.
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Prompting users for their location: Geo Location prompts
The Geo Location prompt lets users answer a prompt by using their device's
current geographical location. Geo Location prompts are typically used to
filter data in a Map widget. For example, a Map widget displays several
locations as markers on the map display. You can choose to display only
those map markers that are in the user's current city.

The location name that is returned by a Geo Location prompt is based on
Google's geocoding. The prompt determines the user's longitude and
latitude using the mobile device's GPS receiver, and passes this information
to Google Maps to return information about the user's location.

You can also use an attribute element prompt to filter attribute elements
based on the location of the mobile device. To support attribute element
prompts, your MicroStrategy schema must include a location mapping
attribute that includes attribute forms for latitude and longitude information.

For example, to filter a list of stores by the state in which the mobile device
is located, provide a location mapping attribute that contains attribute forms
for the state name, latitude, and longitude.

The attribute that provides the list of attribute elements that are filtered and
displayed by the Geo Location prompt, also called the display attribute, does
not have to be the same as the location mapping attribute. For example, the
Customer State is both the display attribute and the location mapping
attribute. When the prompt is displayed on a mobile device, the list of
prompt answers is filtered to display the current state, as shown in the
image below. Instead, if the display attribute is the Store attribute, and the
location mapping attribute is Customer State, the list of prompt answers is
filtered to display the stores in the current state, as shown in the image
below on the right. Users can select stores from the list for which to display
data.

You can:
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l Create a prompt that automatically uses the device's current latitude and
longitude. While creating the prompt, you must define two value prompts,
one for latitude and one for longitude.

For steps to create value prompts, see To create a value prompt, page
178.

l Create a prompt that fi lters an attribute element list using the current
geographical location, by defining an attribute element prompt with the
display style set to Geo Location.

For steps to create an attribute element prompt, see To create an
attribute element prompt, page 183.

Creating Barcode Reader prompts
The Barcode Reader prompt lets users scan or type an item's barcode using
the device to answer a prompted report or document.

You can add a Barcode Reader prompt to a report or document by defining a
prompt and setting its display style to Barcode Reader. The prompt is then
displayed as a Barcode Reader when the report or document is executed, as
shown below:
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Some examples of how you can use the Barcode Reader prompt are:

l To spontaneously view a product's sales and inventory information.

l To view other locations where the product is stocked, as stored in your
database.

l To compare the product's popularity with other products in the same
category or with the same brand name.

The Barcode Reader prompt supports the following types of barcodes:

l QR code

l UPC-A

l UPC-E

l EAN-8

l EAN-13

You can do the following:
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l To allow iPhone, iPad, and Android users to filter report results based on a
product barcode, you can define a value prompt with the display style set
to Barcode Reader.

For steps to create a value prompt, see To create a value prompt, page
178.

l To allow iPhone, iPad, and Android users to search for an item in an
attribute element list, you can define an attribute element prompt with the
display style set to Barcode Reader. If an item's barcode matches the
scanned or typed barcode, its name is returned in the search and can be
selected to answer the prompt.

For steps to create an attribute element prompt, see To create an attribute
element prompt, page 183.

To support the scanning of barcodes using MicroStrategy Mobile, you must
store the barcode data used in the associated prompt with a database data
type that supports text data. MicroStrategy recommends using the varchar
data type for your database to store the barcode data. For details about
storing data in your warehouse, see the Project Design Guide.

Allowing users to filter data using filter panels

You can allow users to filter data within a dashboard-style document using a
panel of selectors, called a filter panel. Users select different options in the
filter panel, which changes the data that is displayed in the document.

You can customize the filter panel so that each filter in the panel is
collapsible, similar to the Filters panel in dashboards. For steps, see the
procedure below.

Mobile Analysis Guide



Copyright © 2024 All Rights Reserved 191

To make each filter in a filter panel collapsible

1. In MicroStrategy Web, open the document containing the filter panel in
Design or Editable Mode.

2. Right-click the filter panel and select Properties and Formatting.

3. Under the Panel Stack area, select the Show as collapsible panel
(Mobile only) check box.

Organizing transactions with tables on iOS devices

A transaction-enabled document contains embedded write-back functionality
for the purposes of decision-making or initiating a transaction. Transaction
Services-enabled documents allow you to update, delete, or create new
entries in your database from within your Mobile app.

If you have multiple input object controls on a document displayed on an iOS
device, you can create a transaction table to group and organize those
controls. For general background information on transaction-enabled
documents, including the prerequisites needed to work with them, see the
Transaction-enabled Documents chapter of the Report Services Document
Creation Guide.

You can create a transaction table that is displayed at all t imes in the
document, or that pops up as an Information Window when a user taps an
object.

The image below gives an example of a transaction table in an app for store
inspectors. The inspector fil ls in all the fields to complete the transaction
table, and then taps Submit to submit the changes.
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The high-level steps to create and enable a transaction table are described
below:

1. Create a transaction table, as described in Creating a table, page 195.

2. Link the transaction table to a Transaction Services-enabled report.
Data from the input objects defined in the Transaction Services report
is displayed in the table cells for users to edit.

3. Link each input object on the Transaction Services report to a cell in the
transaction table.

4. Determine what type of input object control is displayed to users when
they view the Transaction Services-enabled document. Analysts use
these input object controls to edit the data displayed in a document. For
example, users can type text in a text field, turn a switch on and off to
specify a numeric value, select a value from a list, and so on.

The following input control types are displayed as a list in a transaction
table:

l Check box

l Likert Scale
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l Radio List

l Toggle

Only the MicroStrategy Mobile-specific procedure for creating a
transaction table is included in this guide. For detailed procedures for
the remaining steps to create transactions, including descriptions of the
available input object controls, see the Transaction-enabled
Documents chapter of the Report Services Document Creation Guide.

The parts of a table
A transaction cell is the basic component of a transaction table. A
transaction cell contains an input object control, which are the objects that
allow analysts to edit the data displayed in a document. For example, users
can type text in a text field, turn a switch on and off to specify a numeric
value, select a value from a list, and so on.

An example of a transaction table in Design Mode is show below:

A transaction cell displays a title and a placeholder, as described below:

l Cell title: The title or description of the cell. An input object control cell
displays the value entered by the user. In the example above, Name,
Email, and Year are cell tit les.

l Cell placeholder text: A hint for the user about the format for an input
object control. In the example above, "Last, First" and
"Name@domain.com" are placeholders. A placeholder is optional. In the
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example, "Make and Model" does not have a placeholder.

If an input object control is required, the placeholder text displays
"Required" automatically for the user on a mobile device. If the
placeholder is not empty, the text "(Required)" is added to the placeholder
text. When you configure the transactions, you select whether the control
is required.

A transaction table contains at least one group. Groups collect related cells
together under a descriptive title. The example above contains two groups,
Customer and Vehicle, which separate and give context to the cells that
require customer information and cells that require vehicle information.

You can create a group that is displayed to the document designer but
hidden from users. For example, you may create a cell that contains a macro
to gather the mobile device's ID. Since no input is required from the user,
only the mobile device, you may want to hide the group. To hide a group,
name the group hidden.

A transaction table also displays a Clear button and a Submit button, or
Cancel and Submit if the transaction table is used as an Information
Window.

l The Submit button submits the data in the transaction table. If the
transaction table is displayed as an Information Window, the Information
Window is also closed.

l The Clear button erases all the information added to the transaction table,
allowing the user to start again.

l The Cancel button closes the Information Window without submitting the
data in the transaction table.

You can customize the button names, but they are referred to as Clear and
Submit throughout this chapter. By default, changes are cleared or
submitted automatically, as soon as the button is tapped. You can require
that a confirmation message is displayed after the Clear or Submit button is
tapped.
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Creating a table

Prerequisites

l You must have Transaction Services.

l You must have the Web Configure Transaction privilege.

l The Transaction Services report that you want to link to the Grid/Graph or
text fields has already been created. This report must contain the input
object for each value that you want to allow users to change. For steps to
create a Transaction Services report, see the Advanced Reporting Guide.

The high-level steps to creating a table are listed below, with links to the
appropriate steps.

1. Add a table. See Adding a table to a document, page 196 for steps to
create and format a table. The new table contains a single cell in a
single group, and the Clear and Submit buttons. You can customize the
actions and name of the buttons, as described in the procedure.

2. Add groups to the table. A group is a collection of related cells. You can
add as many groups as needed to the table. If the table contains
multiple groups, you can change the order that the groups are
displayed in. For steps, see Adding and moving groups in a table, page
203.

3. Add transaction cells to the table. You can add as many transaction
cells as needed. If the table contains multiple cells, you can change the
order that the cells are displayed in. For steps, see Adding or moving
cells in a table, page 204.
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Adding a table to a document

To add a table

1. In MicroStrategy Web, open the document in Design Mode or Editable
Mode.

2. From the Insert menu, select Table Control (Mobile). When you move
the cursor to the Layout area, the pointer becomes crosshairs. Click in
the desired location in the Layout area. If you click and drag in the
Layout area, you can size the table. An empty table container is added
to the document, with a single cell in a single group, and the Clear and
Submit buttons, as shown below:

To change the group tit le

3. To change the group title from the default of Title, double-click the
group title text, and type your title. Press ENTER to add the text.

l If you do not want to display a title for this group, double-click the
group title text and delete the text.

l If you want to hide this group from users, type hidden as the title.
The title is not case-sensitive, so you can use Hidden or HIDDEN as
well.

To display the table as an Information Window

A transaction table can either be displayed at all t imes in the
document, or it can pop up as an Information Window when a user
taps an object. To use an Information Window, follow the steps
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below. To display a transaction table at all t imes in the document,
skip to Creating a table, page 195.

4. Add the text field, image, or button that will open the transaction table
in an Information Window.

5. Right-click the newly added object, and select Properties and
Formatting. The Properties and Formatting dialog box opens.

6. From the left, click General.

7. From the Panel Stack drop-down list, select the panel stack to use as
the Information Window.

8. Click OK to save your changes.

9. Right-click the table and select Properties and Formatting. The
Properties and Formatting dialog box opens.

10. From the left, click General.

11. Select the Use as Information Window check box.

12. To display a title bar in the Information Window, complete the following
steps:

a. Select the Show Title Bar check box.

b. From the Title drop-down list, select Custom Title.

c. Type a title in the Title f ield. This text is used as the title of the
Information Window.

13. To specify how to open the Information Window on an iPad, select one
of the following Window mode options:

l To open the Information Window by popping it up, select Appear
(default).
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If you select Appear, you can specify the location of the
Information Window on an iPad. Select one of the following
options from the Placement drop-down list:

l To display the Information Window in the best position, select
Automatic (default).

l To display the Information Window at the position of the panel
stack, select Fixed.

l To display the Information Window above the selected object (for
example, the item in the selector or the attribute in the grid), select
Above.

l To display the Information Window below the selected object,
select Below.

l To display the Information Window to the left of the selected object,
select Left.

l To display the Information Window to the right of the selected
object, select Right.

l To open the Information Window by flipping it up, like turning over a
card, select Flip Up.

l To open the Information Window by gradually increasing its size,
select Scale Up.

l To open the Information Window by sliding it from an edge of the
screen, select Slide.

If you select Slide, you can specify which edge to slide the
Information Window from, on an iPad or iPhone. Select one of the
following options from the Position drop-down list:
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l Right (default)

l Left

l Above

l Below

To customize the buttons' name and act ions

14. If the Properties and Formatting dialog box is not open, right-click the
table and select Properties and Formatting. The Properties and
Formatting dialog box opens.

15. From the left, select Buttons.

16. You can change the name displayed on the Submit button, by replacing
the default text in the Display text f ield in the Submit button area.

17. You can choose to display a message asking for confirmation when a
user taps the Submit button, before the user's changes are submitted.
Do one of the following:

l To display the confirmation message, select the Require
Confirmation check box in the Submit button area.

l To submit changes without displaying a confirmation message, clear
the Require Confirmation check box in the Submit button area.

18. You can determine which action is performed after a user submits his
changes. Select one of the following under Subsequent Actions:

l To return to the document without performing any additional actions,
select the No subsequent action option.

l To refresh the display of the document, select the Refresh the
current document option.

l To run a specific report or document, complete the following steps:
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a. Select the Run a new report or document option. Click ... (the
browse button), navigate to and select the report or document
you want to run, and click OK.

b. Specify whether the report or document will be executed using
data cached on the mobile device. Do one of the following:

l To run the report or document without using data cached on
the mobile device, select the Force Live Execution check
box.

l To run the report or document using data cached on the mobile
device, clear the Force Live Execution check box.

c. You can choose to use the same prompt answers that were
chosen in the source document to answer the prompts in the
target report or document. To use the same prompt answers,
select the Answer prompts with the same answers as the
source check box. If both the source and target report/document
contain the same prompts, the user will not be asked to provide
prompt answers. The user will sti l l be prompted for any prompts
that exist in the target but that do not exist in the source.

l To display a custom confirmation message after changes are
submitted, select the Display message after submitting option.
Type the message in the field below the option.

l A Transaction Services-enabled document that is pre-cached is run in
the background, and its results are stored on the mobile device on
which it is executed, improving the speed with which the document is
run. You can choose to update document results cached on a mobile
device after the user submits his changes, by using the Invalidate
Mobile Device Cache setting to mark a document's results as in need
of updating.
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If the document is defined to be pre-cached, the document will be
automatically pre-cached each time the user submits his changes. If
the document is not defined to be pre-cached, the document will be
automatically executed using data cached on the Intelligence Server
the next time the document is run, or executed against the data
source if no cached data is available. For background information on
pre-caching, see Administering MicroStrategy Mobile. Do one of the
following:

l To have the document pre-cached each time the user submits his
changes, select the Invalidate Mobile Device Cache check box.

l To allow the user to submit his changes without marking the data
cached on the mobile device as in need of updating, clear the
Invalidate Mobile Device Cache check box.

19. You can change the name displayed on the Clear button (or Cancel
button, if the table is displayed as an Information Window), by replacing
the default text in the Display text f ield in the Clear button area (or
Cancel button area).

20. You can choose to display a message asking for confirmation when a
user taps the Clear button (or Cancel button, if the table is displayed as
an Information Window). Do one of the following:

l To display the confirmation message, select the Require
Confirmation check box in the Clear button area (or Cancel button
area).

l To discard changes without displaying a confirmation message, clear
the Require Confirmation check box in the Clear button area (or
Cancel button area).
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To format the table

21. In the Properties and Formatting dialog box, from the left, select Color
and Lines.

22. From the first drop-down list at the top of the dialog box, select Table.
The next drop-down list is then automatically displayed as Body.

23. To change the background fil l of the table, select the color from the
Color drop-down list.

24. To change the border around the table, select one of the following from
the Borders options:

l To hide the table border, select None.

l To use a single color for the entire border, select All. From the first
drop-down list, select the type of border (thick, thin, and so on). From
the second drop-down list, select the border's color.

l To use different colors on different sides of the table, select Custom.
For each side (Top, Bottom, Left, and Right), select the border type
and the border color.

25. From the left, select Font.

26. You can change the font for the cell tit le and value for all cells in the
table, and for all the group titles. For each part that you want to format,
follow the steps below:

a. From the first drop-down list, select Cells or Groups.

b. From the second drop-down list, select the part of the table to
format. Your options are:

l Title (available for cells and groups)
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l Value (available for cells)

c. Format the font, including the font type, color, size, and so on.

27. Click OK to save your changes.

Adding and moving groups in a table

A group organizes cells related to each other so that they appear together in
a table. A table can contain multiple groups or only a single group.

Prerequisite

Before you can add a group to a table, you must have already created a
table, as described in Adding a table to a document, page 196. When you
create a table, a group is automatically created in the table.

To add or move a group in a table

1. In MicroStrategy Web, open the document in Design Mode or Editable
Mode.

2. Click the Add new group button in the table. A new group is added to
the table, with a single cell.

3. To change the group title from the default, double-click the group title
text, and type your title. Press ENTER to add the text.

If you do not want to display a title for this group, double-click the
group title text and delete the text.

4. If you have multiple groups in a table, you can change the order that the
groups are displayed in the table. Select a group to move, by clicking
the group, not the group title or a cell. Then drag and drop the group to
its new position. As you drag the group, a blue arrow is displayed to
indicate its new position.
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Deleting a group

Prerequisite

The table must contain at least two groups to delete a group, because a
table must always have at least one group.

To delete a group from the table

1. In MicroStrategy Web, open the document in Design Mode or Editable
Mode.

2. Right-click the group to delete, and select Delete Group.

The Delete Group option is not available if the table contains a single
group.

Adding or moving cells in a table

You can add as many cells as necessary. If you add multiple cells, you can
change the order of the cells.

Prerequisites

l Before you can add a cell to a table, you must have already created a
table, as described in Adding a table to a document, page 196.

l If you want to add the cell to a group in the table, you must have already
created the group. See Adding and moving groups in a table, page 203 for
steps.

When you create a table or a group, a default cell is added as well. You
can configure the cell as though you added it yourself, by following the
procedure below, skipping over the step to add a new cell.
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To add or move a cell in a table

1. In MicroStrategy Web, open the document in Design Mode or Editable
Mode.

2. Hover the cursor over the group to add the cell to. Click the Add new
cell button that is displayed. A new cell is added to the table,
displaying Title and Placeholder in the cell.

3. The cell tit le is the description for the cell. To change the cell tit le from
the default, double-click the Title text, and type your title. Press
ENTER to add the text.

4. The placeholder text contains a hint for the user about the format for an
input object control. For example, if the input object control is a login,
the placeholder text can be domain/user or user@domain.com. To
change the text from the default, double-click the Placeholder text, and
type the new text. Press ENTER to add the text.

To move a cell

5. Select the cell to move, by clicking the cell, not the cell tit le or other
component. Then drag and drop the cell to its new position. As you drag
the cell, a yellow bar is displayed to indicate its new position.

After you have created the table, you need to enable transactions for the
document, as described in the Transaction-enabled Documents chapter of
the Report Services Document Creation Guide.
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Disp laying dat a as in t er act ive
visual izat ions: Widget s

A widget is a rich, graphical display of the results of data, which allows users
to visualize data in different ways than they can when using traditional
reports. Widgets are sophisticated visualization techniques that can
combine with interactivity to enable a better understanding of the data.

Use the following methods to define widgets for mobile devices:

l Display reports as widgets. This is recommended if you want to display
only one widget on the screen. Note that certain features, such as
Information Windows for the Map widgets, require you to create widgets in
documents.

To display reports as widgets, you need to use the Custom Visualizations
Editor in MicroStrategy Web. For steps, see the MicroStrategy Web Help.

l Add widgets to documents. This is recommended if you want to display
additional information on the same layout as the widget. Instructions are
included in this chapter to create and add widgets to documents.

Adding widgets and visualizations to documents for
mobile devices

The following table contains a list of mobile widgets, the mobile devices on
which they can be displayed, and links to background information for each
widget.

Widgets other than the mobile widgets in this table are displayed as grid or
graph reports on mobile devices.
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Widget Description
Displays
on

Link

Data Cloud
widget

Displays the names of attribute
elements in various font sizes to depict
the differences in metric values.

iPhone,
iPad

Displaying a
Data Cloud
widget, page 210

Date Selection
widget

Allows users to view data about events
on an interactive calendar.

iPad,
Android
tablet

Displaying an
interactive event
calendar: Date
Selection widget,
page 210

Graph Matrix
Visualization

Displays data using a variety of graph
styles, such as the line graph, bubble
graph, or grid.

iPad

Displaying data
in an interactive
graph: Graph
Matrix widget,
page 215

Heat Map
widget

Allows users to visualize data as
rectangles color-coded and sized to
depict the differences in metric values.

iPad,
Android

Displaying data
in a Heat Map
widget, page 216

Image Layout
widget

Allows users to visualize data as
colored areas or bubble markers
overlaid on an image.

iPad,
Android

Displaying data
as an overlay on
an image: Image
Layout widget,
page 217

Image Viewer
widget

Allows users to browse through a
collection of images.

iPhone,
iPad,
Android

Displaying
images: Image
Viewer widget,
page 219

Interactive Grid
widget

Displays data in a compact tabular
layout.

iPhone,
iPad,
Android

Displaying data
in rows and
columns:
Interactive Grid
widget, page 222

Map widget Allows users to search and view iPhone, Displaying
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Widget Description
Displays
on

Link

information for locations on a map.
iPad,
Android

geographical
data: Map widget,
page 227

Microcharts
widget

Allows users to analyze trends at a
glance using compact charts and line
graphs.

iPhone,
iPad,
Android

Visualizing
trends:
Microcharts
widget, page 249

Multimedia
widget

Allows users to download and view
multimedia files, such as videos, PDFs,
and ePub books.

iPhone,
iPad,
Android

Downloading and
viewing
multimedia files:
Multimedia
widget, page 254

Network widget
Allows users to analyze relationships
between items and clusters as a
network of connected nodes.

iPad

Visualizing
relationships:
Network widget,
page 256

Photo Uploader
widget

Allows users to upload images by taking
a new image or using an existing image
on their mobile device.

iPhone,
iPad,
Android

Uploading
images: Photo
Uploader widget,
page 257

RSS Reader
widget

Allows users to view and update an
RSS news feed.

iPhone,
iPad

Displaying RSS
feeds: RSS
Reader widget,
page 262

Survey widget

Allows users to interact with the survey
in a Transaction Services-enabled
document and submit their answers,
which are then stored in your data
source.

iPad

Gathering data
from users:
Survey widget,
page 267

Timeline
widget

Allows users to view events or
important milestones in the status of a

iPad
Displaying a
Timeline widget,
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Widget Description
Displays
on

Link

product. page 269

Time Series
widget

Displays data for a specific period of
time in a line graph.

iPhone,
iPad,
Android

Displaying data
trends: Time
Series widget,
page 275

Video Player
Play video directly in a document.
Videos can be cached for offl ine
viewing.

iPhone,
iPad

Downloading and
playing videos:
Video Player
widget, page 280

If you are designing widgets for an iPhone or Android device, you can
determine whether the widget takes up the entire screen. For steps, see
Displaying widgets using the entire screen on mobile devices, page 283.

Some widgets are also available as interactive visualizations, which allows
you to quickly create a customized, interactive dashboard.

In a dashboard, users can add or remove attributes and metrics, change the
type of visualization that is used, or create new filters and thresholds in the
dashboard on-the-fly. Consider using dashboards when your users want a
high degree of interaction with their data. Dashboards can be especially
helpful in strategic business meetings to spontaneously discover the answer
to any business queries that come up.

You can create visualizations that highlight or filter other visualizations in a
dashboard when a user taps on an attribute element in the visualization.

For steps to create a dashboard, see the MicroStrategy Web Help.

The following visualizations can be viewed in a dashboard on an iPad:

l Density Map visualization

l Grid visualization
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l Graph visualization

l Graph Matrix visualization

l Heat Map visualization

l Image Layout visualization

l Map visualization

l Map with Areas visualization

l Network visualization

Displaying widgets as grids or graphs
You can determine whether mobile widgets are displayed as widgets or grid
or graph reports on mobile devices.

Displaying a Data Cloud widget
A Data Cloud widget for the iPhone and iPad displays the names of attribute
elements in various font sizes to depict the differences in metric values
between the elements. This type of widget allows users to quickly identify
the most significant positive or negative contributions.

A Data Cloud widget is a list of attribute elements. The first metric on the
widget's template determines the font size for the attribute elements. A
bigger font for an element indicates a larger metric value.

You can also define an Information Window that displays when an attribute
element is tapped. For instructions on creating an Information Window, see
Providing additional information to users: Information Windows, page 149.

Displaying an interactive event calendar: Date Selection
widget
The Date Selection widget displays events in an interactive calendar in
either a Month, Week, or Day view on an iPad. An example of a Date
Selection widget is shown below:
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Use the Date Selection widget as a calendar of events or appointments
within your app. Users can select an event to display an Information Window
or open a link containing information on the event. If you have Transaction
Services, users can then edit or delete events.

For instructions on creating an Information Window, see Providing additional
information to users: Information Windows, page 149.

You can also use the Date Selection widget as a filter for the data in your
dashboard. Users can select an event on the widget and automatically
update the rest of the dashboard with data that relates to the event. To do
this, you define the Event attribute as a selector.

Pr er equ isi t es

For a Grid/Graph to be used as a Date Selection widget, it must include at
least two attributes on the rows. These attributes must meet the following
criteria:

l The first attribute represents each day displayed in the calendar, and must
contain elements of the Date data type.
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l The second attribute provides the events displayed in the calendar, and
uses the following attribute forms:

o The first attribute form contains a description of the event.

o The second attribute form (optional) contains the image displayed for
the event when the widget is shown in Day View. This attribute form
must be of the image data type.

o The third attribute form (optional) contains the image displayed for the
event when the widget is shown in Week View. This attribute form must
be of the image data type.

l The third attribute (optional) provides the category name of each event in
the calendar, and is used to color-code the events. It uses the following
attribute forms:

o The first attribute form contains the description of the category.

o The last attribute form (optional) contains the color in which to display
the category, stored as a hex value. The value must be of the form
0xFFFFFF or FFFFFF.

Additional attributes, if any, are displayed when a user taps on the event in
the calendar.

You can add objects from multiple datasets to the Grid/Graph containing the
widget. You must have the correct privileges and the project must allow
Grid/Graphs to use multiple datasets. For steps to allow Grid/Graphs to use
multiple datasets, see the Adding Text and Data chapter of the Document
Creation Help.
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To create a Date Select ion widget for mobile devices

1. In MicroStrategy Web, open the document in Design or Editable Mode.

2. From the Insert menu, point to Widgets, then Mobile, and select Date
Selection.

3. Click the location on your document where you want to place the
widget. The Grid/Graph containing the widget is displayed.

4. Optionally, resize the widget by clicking and then dragging its handles.

5. From the Dataset Objects panel on the left, select attributes and drag
them on to the widget. Place at least two attributes on the Grid/Graph's
rows, as described in the prerequisites above.

Formatting a Date Selection widget

You can format a Date Selection widget by:

l Selecting whether events in the Month view are grouped by day or week.
For steps, see To select the grouping of events in the Month view.

l Automatically assigning colors to event categories. The colors are based
on the elements of the categorization attribute of the widget's dataset. For
steps, see To automatically assign colors to event categories, page 214.

l Specifying the color of each event category. For steps, see To assign a
specific color to each category, page 214.

l Selecting which view (month, week, or day) the widget displays initially.
For steps, see To set the default display view.

Pr er equ isi t e

The following procedures assume that you have already created the Date
Selection widget you want to modify.
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To select the grouping of events in the Month view

1. Right-click the widget, then select iPad Properties. The iPad Date
Selection dialog box is displayed.

2. From the Month view is displayed by drop-down list, select one of the
following:

l Day: When the widget is shown in the Month view on an iPad, events
are grouped by day.

l Week: When the widget is shown in the Month view on an iPad,
events are grouped by the week.

3. Click OK to save your changes.

To automatically assign colors to event categories

1. Right-click the widget, then select iPad Properties. The iPad Date
Selection dialog box is displayed.

2. From the Color events by drop-down list, select Attribute.

3. From the Series color palettes, select the colors you want to use to
display the event categories. Each color will automatically be assigned
to a category and displayed when the widget is viewed on a mobile
device.

4. Click OK to save your changes.

To assign a specific color to each category

1. Right-click the widget, then select iPad Properties. The iPad Date
Selection dialog box is displayed.

2. From the Color events by drop-down list, select Attribute Form. The
events are color-coded based on the attribute form that contains the
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color for each category.

3. Click OK to save your changes.

To set the default display view

1. Right-click the widget, then select iPad Properties. The iPad Date
Selection dialog box is displayed.

2. From the Default View drop-down list, select one of the following:

l Month (default)

l Week

l Day

3. Click OK to save your changes.

Displaying data in an interactive graph: Graph Matrix widget
The Graph Matrix widget allows you to quickly analyze various trends across
several metric dimensions. The widget consists of several line graphs that
allow users to analyze and compare trends in metric data.

An example of the Graph Matrix widget is shown in the image below.
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You can also define an Information Window that displays when a graph is
tapped. For instructions on creating an Information Window, see Providing
additional information to users: Information Windows, page 149. You can
define a link in the widget to open a report or another document.

You can also use the Graph Matrix visualization in dashboards. For
information on creating analyses, refer to the MicroStrategy Web Help.

Displaying data in a Heat Map widget
The Heat Map widget for the iPad and Android tablet displays elements as
rectangles and lets users quickly grasp the state and impact of a large
number of variables at one time. An example of the Heat Map widget on the
iPad is shown below:
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You can also use the Heat Map visualization in dashboards. For information
on creating analyses, refer to the MicroStrategy Web Help.

By default, the header for each group in a Heat Map widget is displayed in
the middle of the group. For example, in the Heat Map widget above,
Northeast is displayed in the middle of all elements that belong to Northeast.
For steps to display headers at the top of the widget, see the procedure
below.

You can define an Information Window that displays when a rectangle is
tapped. For instructions on creating an Information Window, see Providing
additional information to users: Information Windows, page 149.

You can create a link on one of the attributes in the widget that opens a
report or another document.

Displaying data as an overlay on an image: Image Layout
widget
You can add an Image Layout widget to a document to display an image
overlaid with colored areas or bubble markers. For example, you can display
a map of the United States, with a bubble marker displayed over each state.
You can have states with a high number of stores displayed using large
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bubble markers, and states with a low number of stores displayed using
small bubble markers. As another example, you can display the layout of a
store in the widget, with each aisle displayed as a separate region, then
have MicroStrategy automatically color each aisle based on the number of
visits each aisle receives. The image below shows an Image Layout widget
with a map of a store, in which each section of the store is displayed as a
separate colored region.

You can display the Image Layout widget on an iPad or Android tablet with
MicroStrategy Mobile.

A shape file is an HTML file that contains the image that you want to display
in the widget, as well as the location of each bubble marker or area you want
to display on top of the image. MicroStrategy provides several default shape
files for you to choose from, including a map of countries of the world and a
map of states in the United States.

You can define your own shape file for use in the widget, such as the layout
of a store or floor in a building, using the same steps as you would to
customize an Image Layout visualization. You can also create multiple
shape files and have the user choose which shape file displays in the
widget.
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You can also define an Information Window that displays when a marker or
an area is tapped. For instructions on creating an Information Window, see
Providing additional information to users: Information Windows, page 149.

Displaying images: Image Viewer widget
You can use the Image Viewer widget to display images and image
description in a document on an iPhone, iPad, or Android device with
MicroStrategy Mobile. Users can zoom in and out of the images.

For iPhone and iPad, you can choose to display the images in a slide show,
filmstrip, or matrix layout, specify the captions to display for each image,
format the background and border color of the widget, and so on.

You can define:

l An Information Window that displays when an image is tapped. For
instructions on creating an Information Window, see Providing additional
information to users: Information Windows, page 149.

l A link in the widget to open a report or another document.

Prerequisites

You must create an attribute to place on the widget's Grid/Graph, with the
following attribute forms:

l The first attribute form contains the location in which each image is saved.

l The second attribute form contains a description of each image.

l The third attribute form contains the unique numeric ID of each image.

To add an Image Viewer widget to a document

1. Open the document in Design or Editable Mode.

2. From the Insert menu, point to Widgets, then point to Mobile, and
select Image Viewer.
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3. Click the location on your document where you want to place the
widget. The Grid/Graph containing the widget is displayed.

4. Optionally, resize the widget by clicking and then dragging its handles.

5. From the Dataset Objects panel on the left, select attributes and
metrics, and drag them on to the Grid/Graph, as described in the
prerequisites above.

To choose the attribute forms displayed for an attribute in the widget, right-
click the header of the attribute, point to Attribute Forms, then select the
attribute forms to display.

Con f igu r e t he w idget 's d isp lay p r oper t ies

1. Right-click the widget, then select Properties and Formatting. The
Properties and Formatting dialog box opens.

2. From the left, select Widget.

3. Click the Widget Properties icon. The Image Viewer Properties dialog
box opens.

4. From the Display Style drop-down list, select the display style to use
to show images in the widget, as follows:

l To display the images in an interactive slideshow, select Slideshow
(default). Users can switch between images by performing a horizontal
swipe motion on the mobile device.

l To display the images in a filmstrip layout, select Filmstrip. Users can
scroll through images vertically or horizontally, as determined by the
Scroll Direction option described below.

l To display the images in a table layout, with evenly spaced rows and
columns, select Matrix. You can specify the number of rows and columns
displayed in the table using the Number of Rows and Number of Columns
options described below.
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5. You can determine whether to display images in the widget in a vertical
or horizontal layout. This option is only available if the Display Style
option is set to Filmstrip. From the Scroll Direction drop-down list,
select one of the following:

l To display images in a vertical layout, select Vertical (default). Users can
perform a vertical swipe motion on the mobile device to scroll through the
images.

l To display images in a horizontal layout, select Horizontal. Users can
perform a horizontal swipe motion on the mobile device to scroll through
the images.

6. You can determine how many rows of images are displayed in the
widget. In the Number of Rows f ield, type the number of rows to
display. This option is only available if the Display Style option is set to
Matrix.

7. You can determine how many columns of images are displayed in the
widget. In the Number of Columns f ield, type the number of columns to
display. This option is only available if the Display Style option is set to
Matrix.

8. From the First Caption Line drop-down list, select the attribute form
that contains the first line of captions you want to display for images in
the widget.

9. From the Second Caption Line drop-down list, select the attribute
form that contains the second line of captions you want to display for
images in the widget.

10. You can specify the default action (such as dril l ing on an attribute or
opening a report or document) to perform when the user taps an image
caption in the widget. From the Default Action Form drop-down list,
select an attribute form. The action defined for this attribute form will
automatically be performed when the user taps the caption.
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11. From the Background Color palette, select the background color of the
widget by doing one of the following:

l To display a transparent background color, click No Fill.

l To display a solid background color, select the background color from the
palette. You can access additional colors by clicking More Colors.

12. From the Border Color palette, select the color of the border to display
around the images in the widget by doing one of the following:

l To display the borders as transparent, click No Fill.

l To display a solid border color, select the border color from the palette.
You can access additional colors by clicking More Colors.

13. From the Border Width drop-down list, select the thickness of the
border to display around the images. The default value is 5 pixels.

14. Click OK to return to the Properties and Formatting dialog box.

15. Click OK to save the changes.

Displaying data in rows and columns: Interactive Grid widget
The Interactive Grid widget allows you to display data in a compact tabular
layout on an iPhone, iPad, or Android device. Attributes and metric values
are displayed in columns in the widget, as shown below. You can specify
multiple display options for the widget, such as whether to apply banding to
the rows in the widget, whether to display multiple attributes or metrics in a
column as stacked together in a single row or allow users to toggle between
the values displayed in the column, and so on.
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You can allow users to directly edit the data displayed in the widget using a
mobile device. For example, you create a widget to display a list of time off
requests. A user can tap a button next to each request to display a check
mark for approved requests and an X for rejected requests, then submit their
changes to their data source. To accomplish this, you must link the widget's
Grid/Graph to a Transaction Services report. For steps and background
information about Transaction Services, see the Advanced Documents
chapter in the Document Creation Help.

You can allow users to perform an action when they tap an attribute or
metric in the widget on a mobile device. To do this, you must assign the
action to the attribute or metric on the widget's Grid/Graph in Web. For
example, if several customer regions are displayed in an Interactive Grid
widget, you can allow users to tap the name of a customer region to update
the data displayed in another grid in the document. Only one action can be
performed for each attribute or metric. If more than one action is enabled for
an attribute or metric, the action with the highest priority is performed. You
can enable the following actions for a value in the widget, in order of highest
to lowest priority:
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l Edit data for the attribute or metric, by displaying the attribute or metric as
an input object control in a Transaction Services-enabled document.

l Use an attribute or metric in the widget as a selector. To do this, you must
define the attribute or metric as a selector on the widget's Grid/Graph.

l Open a link to a report or document.

l Drill on an attribute element.

The steps to add an Interactive Grid widget to a document follow.

Prerequisites

For a Grid/Graph to be used as an Interactive Grid widget, it must meet the
following requirements:

l At least one attribute on the rows. The elements of this attribute are
displayed in the first column of the widget.

l At least one metric on the columns. The metric values are displayed in
additional columns in the widget.

You can add objects from multiple datasets to the Grid/Graph containing the
widget. You must have the correct privileges and the project must allow
Grid/Graphs to use multiple datasets. For steps to allow Grid/Graphs to use
multiple datasets, see the Adding Text and Data chapter of the Document
Creation Guide.

To create and add an Interact ive Grid widget to a document

1. Open the document in Design or Editable Mode.

2. From the Insert menu, point to Widgets, then Mobile, and select
Interactive Grid.

3. Click the location on your document where you want to place the
widget. The Grid/Graph containing the widget is displayed.

4. Optionally, resize the widget by clicking and then dragging its handles.
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5. From the Dataset Objects panel on the left, select attributes and
metrics, and drag them on to the Grid/Graph, as described in the
prerequisites above.

Con f igu r e t he w idget 's d isp lay p r oper t ies

1. Right-click the widget, then select Properties and Formatting. The
Properties and Formatting dialog box opens.

2. From the left, select Widget.

3. Click the Widget Properties icon . The Interactive Grid Properties

dialog box opens.

4. If you added more than one attribute to the widget, you can group the
data displayed in the widget based on the first attribute in the widget's
Grid/Graph. Do one of the following:

l To group the data displayed in the widget, do the following:

a. Select the Apply Grouping to check box. The first attribute on
the widget's Grid/Graph is automatically used to group the data
when the widget is viewed.

b. You can change the background color used for the attribute
elements in the grouping. From the Grouping background drop-
down list, select the color you want to use as the background for
the attribute elements. In the example image above, Grouping
background is set to gray.

c. To remove the grouping background you applied, select No Fill.

d. You can change the font size used for the attribute elements in
the grouping. From the Grouping Font Size drop-down list,
select the size of the font you want to use. In the example image
above, Grouping font size is set to 16.
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e. To change the font size of the column headings, from the Header
Font Size drop-down list, select the size of the font you want to
use.

f. To change the font size of the data displayed in the Interactive
Grid, from the Values Font Size drop-down list, select the font
size you want to use.

l To display the widget without grouping its data, clear the Apply
grouping to check box.

5. From the Color Theme drop-down list, select a color theme to use to
display the background color, border color, and header color of the
widget.

6. By default, the rows of the widget are not banded. To apply banding to
the widget, select the Banding check box.

7. By default, the width of the columns in the widget is automatically
determined. To manually specify the width of each column, clear the
Automatic column sizing check box. In the Width (%) f ields, specify
the width of each column as a percentage. The widths for all columns
should add up to 100.

8. You can select a default action (such as dril l ing on an attribute, opening
a report or document, or acting as a selector) to perform for attributes
and metrics that have no action defined on the widget's Grid/Graph.
From the Default Action Form drop-down list, select an attribute. The
action defined for this attribute will automatically be performed when a
user taps a value in the widget for which no action is explicitly defined.

It is recommended that you assign an action to only one attribute form
in the widget. For example, if you want one attribute to act as a
selector, ensure that dril l ing is disabled for the Grid/Graph, and that
the attribute does not link to another report or document.
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9. If you place multiple attributes or metrics in a column, you can choose
whether to display each attribute element or metric value stacked
together in a single row in the widget, or to allow the user to tap the
header of a column to change which attribute or metric value is
displayed. Do one of the following:

l To allow users to tap a column header to change which object is
displayed, select the Toggle check box.

l To display each object as stacked values in a single row, clear the
Toggle check box. Column headers are not displayed when values
are displayed as stacked.

10. You can create, rearrange, or delete columns in the widget:

l To rearrange report objects within the columns, click a report object
and drag it to a new location.

l To add a new column to the widget, click Add Column. The new
column is added and displayed.

l To delete a column, click to the right of the column.

The first two columns in the widget are added to the widget by
default and cannot be deleted.

11. Click OK to return to the Properties and Formatting dialog box.

12. Click OK to save the changes.

Displaying geographical data: Map widget
With a Map widget, users can search and view information for locations on a
map on an iPhone, iPad, or Android device. You can specify the
geographical location of each location on the map by either supplying the
location as a spatial point, or by providing separate values for the longitude
and latitude.

Mobile Analysis Guide



Copyright © 2024 All Rights Reserved 228

Locations on the map are displayed as map markers, bubble markers, color-
coded areas, or points along a path displayed on the map. Tapping a
location displays an Information Window with additional details about the
selected location, as shown below:

You can display data in the Map widget in the following ways:

l Display your data using static images as map markers. You can define a
threshold on this metric to change the image used for the map markers.
For information on defining thresholds on a metric, see the MicroStrategy
Web Help.

l Display your data using bubble markers. The size of each bubble marker is
automatically determined based on the value of the metric on the columns
of the widget. You can define a threshold on this metric to change the
color of the bubble markers. For information on defining thresholds on a
metric, see the MicroStrategy Web Help.

l For iPhone and iPad documents, display your data as areas color-coded
based on the population density of locations on the map. For example, you
can display areas with a high concentration of stores in red, and areas
with a low concentration of stores in blue.

l Display your data as points on a path displayed on the map. The line used
to represent the path is displayed as thicker for larger metric values and
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thinner for smaller metric values. For example, you can display ridership
at different stops along a train route, with the most popular stations
displayed with the thickest lines extending from the station.

l For iPhone and iPad documents, color-code geographical regions, based
on your data. For example, you can give each country displayed on a map
a different color, based on their type of government. MicroStrategy
provides maps with pre-defined regions, such as countries of the world or
states in the US.

l Create and format a custom Information Window, which is a pop-up
window that displays additional data, for the Map widget. For steps to
define an Information Window, see Providing additional information to
users: Information Windows, page 149.

l Filter the locations displayed on a Map widget to view only those locations
that meet certain criteria. For example, if store locations are displayed on
the widget, you can limit the displayed stores to only those within a
specified zip code. For more information on filtering by geographical
location, see Using the Geo Location prompt in the Map widget, page 241.

Mobile Analysis Guide



Copyright © 2024 All Rights Reserved 230

l For iPhone and iPad documents, once you create a Map widget, you can
display lines that show relationships between locations on the map. For
steps to use lines for relationships, see Using lines to display
relationships between locations in a Map widget, page 246.

To display your data in the Map widget, you must provide geographical
information for each location in the map using attributes or attribute forms.
You can provide this data in the following ways:

l During the import data process, you can define an attribute and assign it a
geo role to identify what type of geographical information it contains. For
example, you can create an attribute called City, which contains the
names of multiple cities, then assign it the City geo role. Web
automatically creates the City attribute with the attribute forms Latitude
and Longitude, which contain the latitude and longitude of each city. You
can then use the City attribute to provide latitude and longitude
information for locations in the widget. Web automatically adds latitude
and longitude information as attribute forms to data columns with the
Country, State, Zip Code, City, or Location geo roles. You can also use
attributes that have been assigned the Latitude or Longitude geo roles to
provide geographical information as attributes, as described in the
prerequisites below. For background information on importing data into
MicroStrategy Web, including steps to assign a geo role to an attribute,
see the MicroStrategy Web Help. For steps to assign a geo role to an
attribute in Developer, see the Developer Help.

l Your administrator can create attributes containing location data to
support the Map widget. Steps to create location data are included in the
Warehouse Structure for Your Logical Data Model chapter in the Project
Design Help.

Creating a Map widget

Prerequisites

The Grid/Graph for the Map widget must meet the following requirements:
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l Place the attribute or attributes containing the geographical information on
the rows. The attributes must provide this information in one of three
ways:

l If you want to display geographical regions on the map, you must
provide an attribute whose values match the names of regions in a map
provided by MicroStrategy. You select the map you want to use in the
steps below.

For example, MicroStrategy provides a map called Countries of
the World. To display a map that contains a colored area for each
country in which your company has sales representatives, you can
create an attribute called Country, which contains the names of
these countries, then use the Country attribute to provide location
information in a widget that uses the Countries of the World map.

l To provide the geographical information using attributes, you must
provide one of the following:

l One attribute that contains the latitude of each location and one
attribute that contains the longitude of each location. For example, you
can provide an attribute that has been assigned the Latitude geo role
and an attribute that has been assigned the Longitude geo role.

l One attribute that provides geographical information for each location
as a point.

l To provide the geographical information using attribute forms, you must
provide one of the following:

l One attribute, which provides the latitude and longitude of each
location using separate attribute forms. For example, you can provide
an attribute that has been assigned the Country, State, Zip Code, City,
or Location geo roles.

Mobile Analysis Guide



Copyright © 2024 All Rights Reserved 232

l One attribute that provides geographical information for each location
as a point, using a single attribute form.

If you are using attribute forms, be sure that the attribute forms
containing the geographical information are visible in the grid. Right-
click the header of the attribute, point to Attribute Forms, then select
the attribute forms you want to display.

l Place at least one metric on the columns. You can define a threshold on
this metric to change the display of markers on the map. For more
information on thresholds, see the MicroStrategy Web Help.

You can add objects from multiple datasets to the Grid/Graph containing the
widget. You must have the correct privileges and the project must allow
Grid/Graphs to use multiple datasets. For steps to allow Grid/Graphs to use
multiple datasets, see the Adding Text and Data chapter of the Document
Creation Help.

To create and add a Map widget to a document for mobile devices

1. In MicroStrategy Web, open the document in Design or Editable Mode.

2. Go to Insert > Widgets > Mobile > Map.

3. Click the location on your document where you want to place the
widget. The Grid/Graph containing the widget is displayed.

4. Optionally, resize the widget by clicking and then dragging its handles.

5. From the Dataset Objects panel on the left, select attributes and
metrics, and drag them on to the Grid/Graph, as described in the
prerequisites above.
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Configure the widget 's display propert ies

1. Right-click the widget, then select Properties and Formatting. The
Properties and Formatting dialog box opens.

2. From the left, select Widget.

3. On the right, ensure that the check boxes for the mobile devices you
are designing for are enabled, as applicable.

4. Click the Widget Properties icon . The Map Properties dialog box

opens.

5. You can replace map markers with static images, bubble markers,
color-coded areas based on the population density of locations on the
map, or geographical regions. Do one of the following:

l To use map markers to mark locations on the map, select the Use
Image Markers option. From the drop-down list, select the marker
image to use to display locations on the map. A preview of the
selected marker style is displayed to the right of the drop-down list.

l To use bubble markers to mark locations on the map, select the Use
Bubble Markers option. The size of each bubble marker is
automatically determined based on the value of the metric on the
columns of the widget.

l To use shades of color to indicate the concentration of locations on
the map, select the Use Density Maps option. From the drop-down
list, select the color theme to use to automatically color areas on the
map. A preview of the selected color theme is displayed to the right of
the drop-down list.

l To display locations on the map as points on a path, select the Use
as a Path on the Map option. From the drop-down list, select the
color of the line to use to display the map path.
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l To display geographical regions on the map, select the Show Areas
option. From the drop-down list, select the regions you want to use in
the map.

6. You can determine how to size bubble markers representing negative
metric values. From the Negative Values are Represented As drop-
down list, select one of the following:

l To use the absolute value of the metric to size the bubble marker,
select Absolute Numbers. For example, a bubble representing a
metric value of -2,500 will be displayed as the same size as a bubble
representing 2,500.

l To display bubble markers representing negative metric values as
bubbles with a size of 7 pixels, select Bubbles Sized at 7 Pixels.

7. You can determine whether to apply threshold formatting to image
markers or bubble markers in the widget. Do one of the following:

l To enable threshold display, select the Apply threshold for the map
check box.

l To disable threshold display, clear the Apply threshold for the map
check box.

8. You can choose to provide geographical information for the widget
using attributes or attribute forms. From the Use Attribute or Form
drop-down list, select one of the following:

l To provide geographical information using attributes, select Use
Attribute.

l To provide geographical information using attribute forms, select Use
Attribute Form.

9. You can determine whether to provide geographical information to the
widget as a point, or as separate latitude and longitude values. Do one
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of the following:

l To define the location as a point:

l From the Select Data Type drop-down list, select the Point option.

l If the Use Attribute or Form drop-down list is set to Use Attribute
Form, from the Select Attribute drop-down list, select the attribute
that contains the attribute form you want to use to display the
widget.

l From the Select Point drop-down list, select the attribute or
attribute form that contains the point information.

l To define the location as a latitude and longitude:

l From the Select Data Type drop-down list, select the
Latitude/Longitude option.

l If the Use Attribute or Form drop-down list is set to Use Attribute
Form, from the Select Attribute drop-down list, select the attribute
that contains the attribute forms you want to use to display the
widget.

l From the Select Latitude drop-down list, select the attribute or
attribute form that contains the latitude information.

l From the Select Longitude drop-down list, select the attribute or
attribute form that contains the longitude information.

10. From the Selection Display Attribute/Form drop-down list, select the
attribute to use to display data in the Information Window when the user
selects locations in the widget.

11. By default, if multiple locations in the widget have the same latitude and
longitude—for example, two stores located in the same building—a
separate map marker is displayed for each location. If you are
designing this widget to be displayed on an iPhone or iPad, you can
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choose to display a separate map marker for each store, or display a
single map marker for all of the stores at that location. Do one of the
following:

l To display a single map marker, select the For repeated rows,
display only one marker for same location check box. When the
user taps the map marker on the document, information for each
location at the selected latitude and longitude is displayed. If map
markers in the widget are displayed as bubble markers and a group of
locations are located at the same latitude and longitude, the bubble
marker for this group is sized and colored based on the last location
in the group, as displayed in the widget. If subtotals are displayed in
the widget, the subtotal for the group is used to size and color the
bubble marker.

l To display a separate map marker for each location, clear the For
repeated rows, display only one marker for same location check
box.

12. On a mobile device, tapping a map marker on the map displays
additional information about the location in an Information Window.

You can define a layout in the document to use as a custom
Information Window, and format its appearance. Select the Display
Information Window from document layout check box. For
instructions to configure the layout to use as the Information
Window, see To specify a layout as an Information Window in a Map
widget, page 239.

If you are designing the document for both iOS and Android devices, it
is recommended that you use a panel stack as the Information
Window. For detailed steps to define panel stacks as Information
Windows, see Providing additional information to users: Information
Windows, page 149.
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l From the Select Layout to use drop-down list, select the name of the
layout to use as the Information Window.

13. You can specify the display theme to use to display the widget. For
example, you can display the map as a satellite image, a map with
topographical details, and so on. From the Default View drop-down list,
select a display theme.

14. You can specify the type of magnification to apply to the map when the
user selects a location in the widget. From the Redraw Behavior on
Selector Action drop-down list, select one of the following:

l To maintain the widget's current level of magnification, select Keep
the Current Zoom.

l To refit the contents of the widget to the selected area, select Refit
the Content.

15. You can let users select areas, zoom in and out of the widget, and so on
using the map toolbar. Under Map Elements Visibil ity Options, choose
from the following:

l To display the map toolbar at the top of the widget, select the Map
toolbar check box. This option is selected by default.

l To allow the user to select which display theme to use to display the
map, select the Map view options check box. This option is selected
by default.

l To display a slider that allows the user to zoom in and out of the map,
select the Zoom bar (Web only) check box. This option is selected
by default.

l To allow the user to view a list of the areas he has selected in the
widget, select the Selection list bucket (Mobile only) check box.
This option is selected by default.
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l To display the Current Location icon, which allows MicroStrategy to
access an iPad user's current location, select the Current location
(Mobile only) check box. If this option is selected, the icon is
displayed even if the document does not have a Geo Location prompt.
This option is cleared by default.

Complete the widget

The plus sign (+) at the top of the interface allows you to add additional
datasets to the Map widget for display in MicroStrategy Web. For steps
to add additional datasets for Web, see the GIS Integration Help.

16. Click OK to return to the Properties and Formatting dialog box.

17. Click OK again to save changes.

Using a layout as an Information Window in a Map widget

When a user taps a map marker in a Map widget on an iPhone, iPad, or
Android device, a pop-up window is displayed. This Information Window
provides additional details about the location, such as the location name and
related metric values, as shown below:
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Information Windows are automatically displayed for all markers, using a
default layout and format. You can create and format a custom Information
Window to display for a Map widget. To define a custom Information
Window, you create a document layout, using either Developer or Web. You
then enable the layout to be displayed as an Information Window and specify
the layout as the Information Window in the Map widget's properties.
Layouts enabled as an Information Window are not displayed with the other
layouts in a document and are only displayed on mobile devices.

If you define an Information Window in a separate document, you can reuse
the Information Window layout by importing it into other documents. For
instructions on importing layouts, see the Document Creation Help.

Prerequisite

This procedure assumes you have already added a Map widget to the
document. For instructions, see To create and add a Map widget to a
document for mobile devices, page 232.

To specify a layout as an Information Window in a Map widget

1. In MicroStrategy Web, open the document that contains the Map widget
in Design Mode.

Create the layout to use as the Information Window

1. Choose Insert > Layout. The Insert Layout dialog box opens.

2. Do one of the following to define a style for the new layout:

l To define a layout style, click the Layout tab, then select a layout
style.

l To import a layout from a saved document, click the Document tab,
then select a previously saved document.

3. Click OK. The new layout is displayed.
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Add content to the layout

1. The content that you add to this layout is displayed in the Information
Window. You can add any controls to the layout, including text fields,
Grid/Graphs, images, shapes, and so on. For instructions, about
designing documents, see the Report Services Document Creation
Guide.

The container that displays the Information Window on the iPhone is
1.5 inches wide. Its height is defined to fit to the content, with a
maximum height of 1 inch.

Enable the layout to be displayed as an Information Window

1. From the Tools menu, select Document Properties. The Properties
dialog box opens.

2. From the Layout Properties section on the left, select Mobile.

3. Select the Use as Information Window check box.

4. Click OK. The layout is enabled as an Information Window.

Specify the Information Window layout to be displayed in the Map
widget 's propert ies

1. Select the tab of the layout that contains the Map widget, then right-
click the widget.

2. Select Properties and Formatting. The Properties and Formatting
dialog box opens.

3. From the left, select Widget.

4. Click the Widget Properties icon . The Map Properties dialog box

opens.
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5. Select the Display Information Window from document layout check
box.

6. From the Select Layout to use drop-down list, select the name of the
layout to use as the Information Window.

7. Click OK to apply the changes.

8. Click OK to return to the document.

Using the Geo Location prompt in the Map widget

The Geo Location prompt lets users answer a prompt by using the device's
current geographical location. In a Map widget, a Geo Location prompt is
typically used to filter data in the widget. For example, you can choose to
display only those map markers that are in your current state.

You cannot add a prompt directly to a document; you must define the
prompt on the dataset reports used for the document. For more information
on using prompts in documents, see the Document Creation Help.

You can create the Geo Location prompt to do the following:

l To automatically use the device's current longitude and latitude to filter
the widget's results, define value prompts with the display style set to Geo
Location. You must define two value prompts, one for latitude and one for
longitude. The prompts are then automatically answered and do not
display in the interface.

l To filter an attribute element list using the current geographical location,
you can define an attribute element prompt with the display style set to
Geo Location.

Geo Location prompts are defined in MicroStrategy Web. For instructions,
see Prompting users for their location: Geo Location prompts, page 187.
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Filtering data based on geographical distance from a mobile
device

You can filter data in a report to display information based on the distance
between a location on the report, and the current location of an iPhone,
iPad, or Android device. For example, in the image below, a report displays
a list of stores.

When the report is viewed on a mobile device, the user can choose to
display only stores within a ten mile radius, as shown in the image below.

If the report is displayed as a Map widget, only map markers for stores within
a ten mile radius are displayed, as shown below.
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To filter data based on the distance from a point of interest to a mobile
device, you must first create a metric to calculate this distance. The steps to
create this metric are described below.

Once you have created the distance calculation metric, you can use it to
filter data by creating a prompt or filter using the metric. For example, you
can:

l Create a prompt to allow users to display only data for locations within a
specified radius of the mobile device.

l Create a filter to automatically display data only for locations greater than
a certain distance from the mobile device.

l In a Map widget, display map markers only for locations within a specified
radius.

Prerequisites

l You must create an attribute with attribute forms containing the latitude
and longitude of each location to use for the distance calculation. For
example, the Store attribute in the example above has two attribute forms,
Latitude and Longitude, which contain the latitude and longitude
information for each store.

l You must create two Geo Location prompts, one each for the latitude and
longitude. The prompts must be created as value prompts, as described in
Allowing users to filter data based on a single value: Value prompts, page
176.

To create a metr ic to calculate the distance between locations and a

mobile device

1. In Developer, from the File menu, point to New, and then Metric. The
New Metric dialog box opens.
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2. Click OK to create a new metric. The Metric Editor opens.

3. In the Definition pane, type the formula of the metric you want to create.
Use the syntax in the table following this procedure for the metric's
definition.

4. Click Save and Close. The Save As dialog box opens.

5. In the Object name f ield, type the name of the new metric. Use the
name provided in the table below.

6. Navigate to the location in which you want to save the new metric, then
click Save. The new metric is created.

7. Repeat the appropriate steps above to create each of the metrics
required to calculate the distance to each store.

8. Once you have created the distance calculation metric, Point_Distance,
you can create any of the following prompts to use the metric:

l A Metric Qualification prompt. You can add the prompt to a report to
let users specify a distance radius for which to display data. For
information on creating Metric Qualification prompts, see the
MicroStrategy Web Help.

l A Metric Set Qualification filter. You can add the filter to a report or to
a dataset report in a document, to automatically fi lter the data using
the current location of the mobile device.

l A prompt or filter that will use the metric, added to a report displayed
as a Map widget, or to the dataset report of a Map widget in a
document. When the Map widget is displayed on a mobile device,
only the map markers for locations within the specified distance from
the mobile device are displayed.

Metric Name Metric Definition

Location_Lat Max(AttributeName@LatitudeFormName)
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Metric Name Metric Definition

Replace AttributeName with the name of the location attribute, and
replace LatitudeFormName with the attribute form that contains the
latitude information for each location. For example, for an attribute named
Store with the attribute forms Latitude and Longitude, create a metric with
the name Location_Lat, with the definition Max(Store@Latitude).

Location_
Long

Max(AttributeName@LongitudeFormName)

Replace AttributeName with the name of the location attribute, and
replace LongitudeFormName with the attribute form that contains the
longitude information for each location. For example, for an attribute
named Store with the attribute forms Latitude and Longitude, create a
metric with the name Location_Long, with the definition Max

(Store@Longitude).

DeltaLat/2

(Radians(([Location_Lat] - ?LatitudePromptName)) /

2)

Replace LatitudePromptName with the name of the value prompt for
latitude. For example, if the value prompt is named Latitude, the
definition is (Radians(([Location_Lat] - ?Latitude)) / 2).

DeltaLong/2

(Radians (([Location_Long] -

?LongitudePromptName))/2)

Replace LongitudePromptName with the name of the value prompt for
longitude. For example, if the value prompt is named Longitude, the
definition is (Radians(([Location_Long] - ?Longitude)) / 2).

A

((Sin([DeltaLat/2]) * Sin([DeltaLat/2])) + (((Cos

(Radians(?Latitude)) * Cos(Radians([Location_

Lat]))) * Sin([DeltaLong/2])) * Sin

([DeltaLong/2])))

C (2 * [Atan2](Sqrt((1-A)), Sqrt(A)))

Point_
Distance

(3959 * C)
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Metric Name Metric Definition

This value is based on the radius of the Earth, 3,959 miles or 6,371
km. To calculate the distance between the stores and the mobile
device using a different unit of distance, replace 3959 with the
radius of the Earth in the units you want to use to measure distance.
For example, to calculate distance in kilometers, the metric
definition is (6371 * C).

Using lines to display relationships between locations in a Map
widget

Once you create a Map widget for an iPhone or iPad, you can show
relationships between locations on the map when the widget is displayed on
the device. To do this, you display lines between the map markers. You can
choose to display these lines using different thicknesses or colors
depending on the relationship between locations.

Prerequisites

l The procedure assumes that you have created a Map widget. For more
information on the requirements for this widget, see Creating a Map
widget, page 230.

l If you provided the location of each map marker in the Map widget using
attribute forms, the Latitude, Longitude, and ID attribute forms of the
location attribute should be displayed in the Map widget.

l If you provided the location of each map marker in the Map widget using
attributes, you must include the lookup attribute on the Map widget.

l You must create a Grid/Graph that is used to display lines in the widget.
This Grid/Graph includes the metrics used to determine the color and
thickness of lines between map markers, and attributes containing the IDs
of the starting and ending locations of each line. The IDs provided must
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correspond to the IDs used to identify map marker locations in the Map
widget. The steps to create this Grid/Graph are below.

To display lines between map markers in a Map widget

1. Open the document in Design or Editable Mode.

To create the Grid/Graph for the relat ionships

1. From the Insert menu, select Grid/Graph.

2. Click the location on your document in which you want to place the
Grid/Graph. This Grid/Graph will not be visible when the widget is
displayed on the device, and should be in the same document section
as the Map widget.

3. From the Dataset Objects panel on the left, select attributes and
metrics, and drag them on top of the Grid/Graph, as described below:

l You must place two attributes on the rows of the Grid/Graph, which
must provide the IDs of the starting and ending locations of each line
in the widget. The IDs provided must correspond to the ID forms in
the attribute used to identify map marker locations in the Map widget.
Place the attributes as follows:

l The first attribute is the lookup attribute for the widget. It must
contain a single attribute form containing the ID of the starting
location for each line.

l The second attribute must be a single attribute form containing the
ID of the ending location for each line.

l Place at least one metric on the Grid/Graph's columns:

l The first metric automatically determines the thickness of each line
displayed in the widget, with thick lines representing large metric
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values. For example, if airports are displayed in the Map widget,
and the lines represent flights between each airport, you can add
the Passenger Count metric to the Grid/Graph. When the widget is
displayed on a mobile device, the flights with the most passengers
are displayed with thick lines, while flights with less passengers are
displayed with thin lines.

To display each line using the same thickness, you can provide a
metric with a constant value.

l The second metric is used to determine the color of each line in the
widget. By default, each line in the widget is displayed using the
default color. You can override the default color by defining a
threshold to change the font color of the metric values that meet the
threshold condition. For information on creating thresholds, refer to
the MicroStrategy Web Help.

If only one metric is placed on the columns, all l ines will display
using the default color.

4. The ID attribute form of each attribute must be displayed in the
Grid/Graph you just created. If they are not displayed, for each
attribute, right-click the header of the attribute, point to Attribute
Forms, then select the attribute forms you want to display.

5. If you provided the location of each map marker in the Map widget using
attributes, you must include the lookup attribute on the Grid/Graph that
you just created to display lines between the map markers. Place the
lookup attribute on the rows of the Grid/Graph, directly before or
directly after the attributes providing the latitude and longitude of each
map marker.
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To enable the line display

1. Right-click the Map widget, then select Properties and Formatting.
The Properties and Formatting dialog box opens.

2. From the left, click Advanced.

3. Clear the Enable incremental fetch on grid check box, and click
Apply.

4. From the left, select Widget.

5. Click the Widget Properties icon . The Map Properties dialog box

opens.

6. To enable the display of lines, select the Display Affinity Lines/Arcs
check box.

7. If the Use Attribute or Form option is set to Use Attribute, from the
Select Lookup Attribute drop-down list, select the lookup attribute.

8. From the Select Affinity Data drop-down list, select the Grid/Graph
that you created above.

9. From the Draw Arcs/Lines drop-down list, select Arcs to display
curved lines or Lines to display straight lines.

10. From the Max Line Thickness drop-down list, select the maximum
thickness that can be used to display lines in the widget. The thickness
of each line is automatically determined based on the value of the first
metric on the new Grid/Graph's rows. The default value is 5.

11. Click OK to return to the Properties and Formatting dialog box.

12. Click OK to save changes and return to the document.

Visualizing trends: Microcharts widget
The Microcharts widget for iOS and Android devices lets users visualize
trends in a metric at a quick glance. Depending on the number of metrics
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used in the underlying report, the Microcharts widget can display one, two,
or three microcharts. For example, bar and sparkline microcharts convey
trends in a metric, and bullet microcharts compare a metric's actual value to
its targets. An example of a Microcharts widget is shown below:

The Microcharts widget can be used in the following modes:

l Grid mode: This is the default setting. In this mode, all attributes except
the last one from the left are grouped and displayed as rows in the widget.

l You can display Grid mode in Tree mode, which groups the rows in the
widget logically. Users can collapse and expand the rows as needed to
see more detailed data.

l If the widget is displayed on an iPhone or iPad, users can sort the widget
based on a column in the widget. Users can sort the widget based on:

l Attribute elements or metric values

l Elements in a consolidation

l Attribute elements or metric values with thresholds applied

If your widget contains subtotals, you can control where the
subtotals are displayed when the widget is sorted. Edit the subtotals
to display at the top or bottom of each group. For steps, see the
Document Creation Guide.

l KPI List mode: In this mode, key performance indicators (KPIs), such as
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Profit, Revenue, and so on, are displayed in a list. Each KPI is
represented by its own row of microcharts.

Ticker mode and Vertical Scroll mode are not available for mobile devices.

You can also define Information Windows that display when the widget is
tapped. For instructions on creating an Information Window, see Providing
additional information to users: Information Windows, page 149.

Creating a Microcharts widget

Prerequisites

In a document, create a Grid/Graph that meets the following minimum
requirements:

l For a Microchart widget in Grid mode, the report must have at least two
attributes in the rows. The last attribute from the left is used as the X-axis
for the bar graph and sparkline microchart.

l For a Microchart widget in KPI List mode, the report must have only one
attribute in the rows.

l At least two metrics in the columns. The first metric from the left
determines the height of the bars for the bar microchart, and the peaks of
the sparkline microchart. The second metric displays a horizontal
reference line for both microcharts.

You can add objects from multiple datasets to the Grid/Graph containing the
widget. You must have the correct privileges and the project must allow
Grid/Graphs to use multiple datasets. For steps to allow Grid/Graphs to use
multiple datasets, see the Adding Text and Data chapter of the Document
Creation Help.
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Displaying the Microcharts widget in KPI List mode

By default, if the Grid/Graph has only one attribute row, the Microcharts
widget displays in KPI List mode. To configure other properties of the
widget, you must run the document in Flash Mode in MicroStrategy Web, and
then change the properties, as described in the steps below.

You must determine how many of the metrics to use for each KPI. For
example, if you specify three metrics for each KPI, the first three metrics
from the left are used for the first KPI, the next three for the second, and so
on.

To display the Microcharts widget in KPI List mode

1. In MicroStrategy Web, navigate to the document where you have
defined the Microcharts widget, and open it. The document should open
with the Microcharts widget displayed.

2. Right-click the Microcharts widget, and select Properties. The
Microcharts properties dialog box opens.

3. From the drop-down list at the top left, choose Mode. If your widget has
a single attribute row, the KPI List Mode check box is enabled by
default.

If the widget contains more than one attribute, the KPI List Mode
check box is disabled.

4. In the Metrics per KPI f ield, type the number of metrics to use for each
KPI.

5. Click OK.

6. Click Save to save the document.
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Enabling Smooth Scroll mode

You can enable Smooth Scroll mode to ensure that the metric columns
displayed in the widget on an iPad or Android with MicroStrategy Mobile
have enough space.

In Smooth Scroll mode, if there is enough space on the mobile device to
display all the attribute columns in the widget plus at least one metric, the
attribute columns are allowed to take up as much space as they require. If
space is limited, however, priority is given to displaying the metrics in the
widget, and attributes are displayed in the remaining space. Users can
perform a horizontal swipe gesture to view the metric columns that cannot fit
on a single page.

To enable Smooth Scroll mode for a Microcharts widget

1. Right-click the widget and select Properties. The Microcharts dialog
box opens.

2. From the drop-down list, select Mode.

3. Select the Enable Smooth Scroll Mode for Metrics (Mobile Only)
check box.

4. From the Metric Column Spacing drop-down list, determine how to
size and display columns in the widget by selecting one of the
following:

l To display columns as more compact in width, select Compact.

l To display columns using the default width, select Normal.

l To display columns as wider than the default, select Large.

5. Click OK to apply your changes.
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Selecting a display theme for the widget

You can select a display theme to use to display the Microcharts widget on a
mobile device. Display themes are used only for widgets displayed on mobile
devices.

To select a display theme for the Microcharts widget

1. Right-click the widget and select Properties. The Microcharts dialog
box opens.

2. From the drop-down list, select Options.

3. From the Choose Theme drop-down list, select a color theme to use to
display the widget, as follows:

l To display the widget using a light-colored theme, select Light
(default).

l To display the widget using a dark-colored theme, select Dark.

l To display the widget using custom color options that you define,
select Custom. The colors that you select for the widget in the
Microcharts dialog box will be used to display the widget on a mobile
device.

4. Click OK to apply your changes.

Downloading and viewing multimedia files: Multimedia widget
You can allow users to browse and view files in a web folder, such as
documents, images, and videos, using a Multimedia widget. When viewed on
a mobile device, the Multimedia widget displays a list of available files,
along with information about each file, including the file name, description,
and file type. Users can tap the Download icon next to a file displayed in the
widget to download and view the file. When the mobile device is offl ine,
users can view files that have been downloaded and automatically stored on
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their mobile device. Files that have not been stored on the mobile device are
grayed out and cannot be viewed offline.

Users can view the following types of files using the Multimedia widget:

l Audio and video files

l ePub files

l Excel

l HTML

l Image

l PDF

l Plain text

l PowerPoint

l Word

PDF files are displayed in-app using a native PDF reader.

Prerequisites

Before creating a Multimedia widget, you must perform the following tasks:

l Create the document in which to insert the Multimedia widget.

l Configure an XQuery database instance to retrieve web folder contents.
For steps to configure this database instance, see the Custom SQL
Queries: Freeform SQL and Query Builder chapter in the Advanced
Reporting Guide.

l Create an XQuery report to use to access the web folder that contains the
files to display in the widget. Add the XQuery report as a dataset report in
the document. For steps to create the XQuery report, see the Custom SQL
Queries: Freeform SQL and Query Builder chapter in the Advanced
Reporting Guide.
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To create and configure a Mult imedia widget

1. In MicroStrategy Web, open the document in Design or Editable Mode.

2. From the Dataset Objects panel on the left, click and drag the dataset
report to the area of the document in which to display the widget. The
attributes on the Grid/Graph of the dataset report should be displayed
in the following order:

l MW_URL

l MW_Name

l MW_ModifiedOn

l MW_ModifiedOnText

l MW_DBIGUID

l MW_ThumbnailURL

l MW_Description

3. Right-click the dataset report, then select Properties and Formatting.
The Properties and Formatting dialog box opens.

4. From the left, click Widget.

5. From the Widget drop-down list, point to Mobile, then select
Multimedia.

6. Click OK to save your changes and return to the document.

Visualizing relationships: Network widget
You can create a Network widget to allow analysts to quickly and easily
identify relationships between related items and clusters, such as when
visualizing a social network or displaying a market basket analysis. Attribute
elements are displayed as nodes in the visualization, with lines (called
edges) drawn between the nodes to represent relationships between
elements. Once the visualization is created, users can view characteristics
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of the nodes and the relationships between them, using display options such
as node size, edge thickness, and edge color.

You can also define Information Windows that display when a node is
tapped. For instructions on creating an Information Window, see Providing
additional information to users: Information Windows, page 149.

You can also use the Network visualization in dashboards. For information
on creating analyses, refer to the MicroStrategy Web Help.

Uploading images: Photo Uploader widget
Analysts can use the Photo Uploader widget to upload images from an
iPhone, iPad, or Android device. A user can choose to take a new photo to
use as an image, use an existing image on his mobile device, or delete
images.

For example, you can add the Store attribute to the widget's Grid/Graph, and
then add a prompt to the document to allow users to select a store. Users
can run the document, then select the store in which they are taking a
picture with their mobile devices. When the image is uploaded, the name of
the store is stored in the user's data source, along with the description of the
image and the location in which the image is stored. For steps to create
prompts, see Allowing users to filter data: prompts, page 173.

Prerequisites

l You must have Transaction Services.

l You must have the Web Configure Transaction privilege.

l This procedure assumes you have already created attributes and metrics
to place on the widget. The widget is used to store information about the
images before they are uploaded and must contain a placeholder row of
data for each image you want to upload. The data in these rows is updated
when users upload images. The following attributes and metrics must be
created:
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l One attribute that contains the following attribute forms:

l The first attribute form is the location in which each image is saved.
The values may be blank or placeholders, and are updated with new
paths when users upload images.

l The second attribute form contains a description of each image, as
provided by the user.

l The third attribute form (optional) contains a unique numeric ID of
each image that the user uploads.

Note the following:

l The number of placeholder rows in the widget determines the
maximum number of images users can upload. For example, if you
create a widget with 20 rows, users can upload a maximum of 20
images.

l To choose the attribute forms displayed for an attribute in the widget,
right-click the header of the attribute, point to Attribute Forms, then
select the attribute forms to display.

l Two metrics, as follows:

l The first metric is used to indicate whether the image has been
uploaded.

l The second metric (optional) contains the sum of the values in the first
metric, and is used to display the number of images the user has
uploaded.

l You can provide additional information about an uploaded image by
placing additional attributes and metrics on the widget. For example, you
can add the Store attribute to the widget, and then add a prompt to the
document to allow users to select a store. Users can run the document,
then select the store in which they are taking a picture with their mobile
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devices. When the image is uploaded, the name of the store is stored in
the user's data source, along with the description of the image and the
location in which the image is stored. For steps to create prompts, see
Allowing users to filter data: prompts, page 173.

l You can add objects from multiple datasets to the Grid/Graph containing
the widget. You must have the correct privileges and the project must
allow Grid/Graphs to use multiple datasets. For steps to allow
Grid/Graphs to use multiple datasets, see the Adding Text and Data
chapter of the Document Creation Help.

• This procedure assumes you have created a Transaction Services report
to link to the widget. There must be an attribute form or metric displayed
in the widget (described above) for each input object in the Transaction
Services report. For steps to create a Transaction Services report, see
the Advanced Reporting Help.

To add a Photo Uploader widget to a document

1. Open the document in Design or Editable Mode.

2. From the Insert menu, point to Widgets, then point to Mobile. Select
Photo Uploader.

3. Click in your document where you want to place the widget. A
Grid/Graph containing the widget is added to the document.

4. Optionally, resize the widget by clicking and then dragging its handles.

5. From the Dataset Objects panel on the left, select attributes and
metrics, and drag them on to the Grid/Graph, as described in the
prerequisites above.

6. To specify the size and quality of images uploaded through the Photo
Uploader, the camera used to take images, and other properties, right-
click the widget and select Properties and Formatting, then click the
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gear icon next to Widget Properties.

You can specify the following options:

a. The quality of the images that are uploaded. From the Image
Quality drop-down list, select High, Medium, or Low (default).

b. The size of the images uploaded. From the Image Size drop-down
list, select Small, Medium (default), Large, or Actual.

c. Whether users can upload multiple images at one time. From the
Allow Multiple Photos drop-down list, select Yes (default) or No.

d. Whether users can use photos already stored on their mobile
device. From the Allow Existing Pictures drop-down list, select
Yes (default) or No.

e. The camera used to take photos by default. Users can stil l switch
between the cameras. From the Default Camera drop-down list,
select Back (default) or Front.

7. To link the widget to the Transaction Services report, right-click the
widget's Grid/Graph, then select Configure Transaction. The
Configure Transactions dialog box opens.

8. Click … (the Browse button), then navigate to and select the
Transaction Services report to link to.

9. A list of the attributes and metrics that can be modified in the
Transaction Services report is displayed in the Transaction Input
column. Perform the following steps for each input object:

a. From the Grid Object drop-down list, select the attribute form or
metric to link to the input object.

b. You can choose whether users can edit the value of each input
object. Do one of the following:
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l To allow users to edit the value of the input object, select the
Editable check box.

l To prevent users from editing the value of the input object, clear
the Editable check box.

You must define the first metric on the columns of the widget to
be editable. This metric indicates whether the image has been
uploaded.

c. From the Transaction Input drop-down list, choose a control to
display the input as, such as a text box, slider, and so on.

10. Repeat the appropriate steps above to define and format the control to
display for each input object.

11. Click OK to save your changes and return to the document.

12. To create a button for users to submit a photo, from the Insert menu,
point to Selector, then select Action Selector Button.

13. Click the section of the Layout area in which you want to place the
selector. Right-click the selector, then select Properties and
Formatting. The Properties and Formatting dialog box opens.

14. From the left, click General, then in the Display Text f ield, type the
text you want to display on the button or link; for example, Submit.

15. By default, a descriptive title bar is displayed for the selector. You can
determine whether to display the title bar. Do one of the following:

l To display the title bar, select the Show Title Bar check box and type
the title you want to display in the field.

l To display the selector button or link without the title bar, clear the
Show Title Bar check box.
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16. From the left, click Selector. From the Action Type drop-down list,
select Submit.

17. By default, the selector button or link targets each Grid/Graph and
panel stack in the document section in which it is placed. You can
choose the targets of the selector manually instead. To do so, click
Click here, then use the right arrow to move the target Grid/Graph or
panel stack from the Available l ist to the Selected l ist. For additional
information on working with selectors, see the MicroStrategy Web Help.

18. Select the appropriate options to define the selector. For the full steps
to define an action selector button, see the Document Creation Help.

19. Click OK to save your changes and return to the document.

Displaying RSS feeds: RSS Reader widget
You can provide an RSS feed on the iPhone and iPad. RSS (Rich Site
Summary, or Really Simple Syndication) is a data format used to display
updated content from a website. An RSS document is called a feed. It
contains either a summary of the content from an associated website or the
full text.

The RSS Reader widget allows users to compare data in the dashboard with
information from external news feed sources. The widget retrieves news
from an RSS news feed and displays it alongside the other components of
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the dashboard. The RSS feed is automatically reloaded to display the most
up-to-date news about a variety of topics that you specify.

You can add an RSS Reader widget to a document, then display the widget
when the document is viewed on a mobile device, as shown in the image
above. Users can select an RSS feed to display a list of news items, then
select an item to display from the list.

Formatting an RSS Reader widget for mobile devices

You can format how the widget is displayed when viewed on the mobile
device. For example, you can change the color in which the titles of RSS
feeds are displayed, or the background color used for news items that are
selected in the widget.

The list below suggests formatting ideas and provides steps to format how
an RSS Reader widget is displayed on the mobile device.

Specify the URL of the RSS feed to display in the widget

1. In Flash Mode, right-click the widget and select Properties. The RSS
Reader dialog box opens.

2. On the General tab, type the URL of the RSS feed in the Default RSS
Field. To specify multiple URLs, type ?? between each URL. For
example:

http://www.businessweek.com/rss/bwdaily.rss??http://news.google.co
m/news?ned=us&topic=h&output=rss

3. Click OK to apply your changes.

Mobile Analysis Guide



Copyright © 2024 All Rights Reserved 264

Specify the t it le of the RSS feed displayed in the widget

1. In Flash Mode, right-click the widget and select Properties. The RSS
Reader dialog box opens.

2. On the General tab, type the title of the RSS feed in the RSS Reader
Title field. To specify tit les for multiple RSS feeds, type ?? between
each title. For example, you can type Business??World News to create
two RSS feeds, one named Business and the other named World News.

3. Click OK to apply your changes.

Select the color in which the t it les of RSS feeds are displayed

1. In Flash Mode, right-click the widget and select Properties. The RSS
Reader dialog box opens.

2. On the General tab, select a color from the RSS Reader Title Color
palette.

3. Click OK to apply your changes.

Select the background color of the widget

1. In Flash Mode, right-click the widget and select Properties. The RSS
Reader dialog box opens.

2. On the General tab, select a color from the Background Color palette.

3. Click OK to apply your changes.

Select the color of the widget 's border

1. In Flash Mode, right-click the widget and select Properties. The RSS
Reader dialog box opens.

2. On the General tab, select a color from the Border Color palette.

3. Click OK to apply your changes.
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Select the background color to use to display news items in the widget

1. In Flash Mode, right-click the widget and select Properties. The RSS
Reader dialog box opens.

2. On the NewsItem tab, select Colors from the first drop-down list.

3. Select Background from the second drop-down list.

4. Select a color from the Background color palette.

5. Click OK to apply your changes.

Select the background color displayed for news items when a cursor
hovers over the item in the widget

1. In Flash Mode, right-click the widget and select Properties. The RSS
Reader dialog box opens.

2. On the NewsItem tab, select Colors from the first drop-down list.

3. Select Rollover Background from the second drop-down list.

4. Select a color from the Rollover Background color palette.

5. Click OK to apply your changes.

Select the font color to use to display news items in the widget

1. In Flash Mode, right-click the widget and select Properties. The RSS
Reader dialog box opens.

2. On the NewsItem tab, select Colors from the first drop-down list.

3. Select Font from the second drop-down list.

4. Select a color from the Font Color palette.

5. Click OK to apply your changes.
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Select the font color to use to display news items when a cursor hovers
over the item in the widget

1. In Flash Mode, right-click the widget and select Properties. The RSS
Reader dialog box opens.

2. On the NewsItem tab, select Colors from the first drop-down list.

3. Select Rollover Font from the second drop-down list.

4. Select a color from the Rollover Font Color palette.

5. Click OK to apply your changes.

Select the font color to use for news items that have been read

1. In Flash Mode, right-click the widget and select Properties. The RSS
Reader dialog box opens.

2. On the NewsItem tab, select Colors from the first drop-down list.

3. Select Read Articles from the second drop-down list.

4. Select a color from the Read Articles color palette.

5. Click OK to apply your changes.

Select the background color to use to display news items that are selected
in the widget

1. In Flash Mode, right-click the widget and select Properties. The RSS
Reader dialog box opens.

2. On the NewsDetail tab, select a color from the Background Color
palette.

3. Click OK to apply your changes.
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Select the font color to use to display news items that are selected in the
widget

1. In Flash Mode, right-click the widget and select Properties. The RSS
Reader dialog box opens.

2. On the NewsDetail tab, select a color from the Font Color palette.

3. Click OK to apply your changes.

Gathering data from users: Survey widget
The Survey widget allows an analyst to interact with a survey on an iPad and
submit answers, which are then stored in your data source. You can create a
survey in a database or on a third-party survey creation website, then
display your survey in a Transaction Services-enabled document on an iPad.

The Survey widget provides an easy way to dynamically generate and
maintain surveys. If you want to modify the survey after its creation (for
example, by adding or editing survey questions), you can update the survey
information provided by the attributes and metrics placed on the widget's
grid. These changes will automatically be reflected and displayed in the
widget, without requiring any additional configuration changes to the widget
in the document.
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You can add a Survey widget to a document, then display the widget when
the document is viewed on a mobile device, as shown in the image above.

A Survey widget displayed on an iPad can contain the following question
types:

Question
Type

Description

Text field
A field consisting of one line in which users can enter text. Text
fields are suited for questions in which users provide a single
line of text, such as an email address.

Text area
A field in which users can type multiple lines of text. Text areas
are suited for comments sections in which users provide multiple
lines of written content.
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Question
Type

Description

Radio
button

A list of radio buttons, displayed in a table. Users can select one
radio button at a time.

Check box
A list of check boxes, displayed in a table. Users can select
more than one check box at the same time.

Drop-down
list

A list of options, displayed in a table. Users can select one
option from the drop-down list at a time.

Likert
scale

A series of radio buttons, displayed in a table, that users can
choose from to rate an item on a numeric scale. For example,
users can choose 1 to strongly disagree with a statement, or 5 to
strongly agree.

Drag and
drop
ranking

A list containing options that users can click and drag to rank
them from highest to lowest.

Star
ranking

A row of stars that users can use to submit a specific star rating
out of five stars (such as four out of five stars).

Group
question

When you display questions in a question group or table, you
specify which question is treated as the main question. The
main question is displayed as a header above the rest of the
questions.

In the example above, the second question is displayed as a table of
choices. The iPad displays the text "Required" for required questions (as
shown for First Name in the example).

Displaying a Timeline widget
The Timeline widget allows analysts using an iPad to view events or
important milestones in the status of a product. For example, the image
below shows a Timeline widget for a company that leases commercial jets to
different airlines.
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Each line represents a different commercial jet. An icon is displayed to mark
events in the jet's lifetime, such as a new lease, a lease expiring, a new
purchase, and so on. The metric values on the right are the key performance
indicators (KPIs) for each jet, and the values at the bottom are the KPIs for
each year.

Creating and adding a Timeline widget to a report or document

The following are instructions to define a Timeline widget for display on a
mobile device. You can also define Information Windows for the widget,
which can display additional information when users tap a section of the
timeline. You can define a link in the widget to open a report or another
document.

Prerequisites

l You must have a total of three datasets for the Timeline widget, which
contain data as follows:
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l A main dataset, which must have the following objects:

l One attribute on the rows. Each attribute element is shown as a row on
the Timeline widget. In the example above, the Asset attribute is
placed on the rows.

l The Year and Quarter attributes, in that order, on the columns.

l One metric for Status, with codes for the asset's status, such as
leased, sold, and so on. This metric determines the color of the
timeline for a particular status. You can define the colors using
thresholds on the Status metric.

l One metric for Event, with codes for events in the asset's timeline. You
can define the appearance of the event marker by defining a threshold
on the Event metric.

l Optionally, one metric for the count of events for each asset, which
contains the number of events that have occurred in a given quarter. If
this value is greater than 1 for a specific quarter, a number badge for
the quarter is displayed in the widget in place of an event icon. This
number badge contains the number of events that affected the asset
during the quarter.

l A dataset that relates the asset to the KPI metrics. The metrics are
displayed on the right side of the widget. The dataset must contain the
following objects:

l On the rows, the attribute for which timelines are displayed. In the
example above, this is the Asset attribute.

l On the columns, the metrics for the KPIs.

l A dataset that relates the Year to the KPI metrics. The metrics are
displayed at the bottom of the widget. The dataset must contain the
following objects:
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l On the rows, the Year attribute.

l On the columns, the metrics for the KPIs.

To create and configure the Timeline widget for mobile devices

1. In Web, open the document in Design or Editable Mode.

2. From the Insert menu, point to Widgets, then Mobile, and select
Timeline.

3. Click the location on your document where you want to place the
widget. The Grid/Graph containing the widget is displayed.

4. Optionally, resize the widget by clicking and then dragging its handles.

To define the grid for the main dataset

1. From the Dataset Objects panel on the left, place the objects from the
main dataset on to the widget. The requirements for these objects are
described in the prerequisites above.

2. To color-code the line for each asset in the widget based on the asset's
status, you must define a threshold on the status metric to change the
color in which metric values are displayed, as described below:

a. Right-click the widget, then point to Thresholds, and select
Visual. The Visual Threshold Editor opens.

b. Select the appropriate options to define your threshold. For
detailed steps to define a threshold, see the Formatting a Report
chapter in the Basic Reporting Guide.

3. To display an image icon when an event occurs to an asset in the
widget, you must define a threshold on the event metric to replace
metric values with the image you want to display, as described below.
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a. Right-click the widget, then point to Thresholds, and select
Visual. The Visual Threshold Editor opens.

b. Select the appropriate options to define your threshold. For
detailed steps to define a threshold, see the Formatting a Report
chapter in the Basic Reporting Guide.

To define the grid for displaying metr ics by asset

1. From the Insert menu, select Grid, then click the area in the Layout
area in which you want to place the grid.

This grid will not be visible when the widget is displayed.

2. From the Dataset Objects panel, drag the objects from the second
dataset, which relates the assets to metrics, on to the grid.

To define the grid for displaying metr ics by year

1. From the Insert menu, select Grid, then click the area in the Layout
area in which you want to place the grid.

This grid will not be visible when the widget is displayed.

2. From the Dataset Objects panel, drag the objects from the third
dataset, which relates the year to metrics, on to the grid.

To configure the widget

1. Right-click the Timeline widget, then select Properties and
Formatting. The Properties and Formatting dialog box opens.

2. On the left, click Widget.

3. In the Available l ist under Secondary Data Providers, select the grid
with the asset attribute, then click > to move it to the Selected list.
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Select the grid with the Year attribute and click > to move it to the
Selected list.

4. Click the Widget Properties icon . The Timeline Properties dialog

box opens.

5. You can choose the starting point from which to display data in the
timeline when the widget is displayed. From the Initial column display
properties drop-down list, select one of the following:

l To display data in the timeline starting with the most recent dates
available, select Right Justified.

l To display data in the timeline starting with the earliest dates
available, select Left Justified.

6. You can determine whether to show labels for each quarter displayed in
the timeline. Do one of the following:

l To show the labels for each quarter, select the Show labels check
box.

l To display the timeline without labeling each quarter, clear the Show
labels check box.

7. Click OK to save your changes and return to the Properties and
Formatting dialog box.

8. Click OK to save your changes.

Displaying additional information: Information Windows

You can define Information Windows, which are pop-up windows that display
additional information when the user taps an area in the widget when the
widget is displayed on the mobile device. To do so, you must first define a
panel stack containing the information you want to display, then define
specific attributes as selectors targeting the panel stack, as follows:

Mobile Analysis Guide



Copyright © 2024 All Rights Reserved 275

• To display an Information Window when the user taps a section of the
timeline for a specific asset and quarter, you must define the Asset, Year,
and Quarter attributes on the Timeline widget as selectors targeting the
panel stack.

• To display an Information Window when the user taps the name of an
asset in the widget, you must define the Asset attribute in the grid
containing the metrics to be displayed by Asset (the second Grid/Graph
you added to the document) as a selector targeting the panel stack.

For detailed steps to create Information Windows, see Providing additional
information to users: Information Windows, page 149.

Displaying data trends: Time Series widget
The Time Series widget displays data over a specific period of time on an
iPhone, iPad, or Android device. This widget is displayed as a line graph on
the device. You can configure the widget to display multiple data series on
the same graph. An example of a Time Series widget on an iPhone is shown
below.

You can configure the Time Series widget to provide data across multiple
time intervals. For example, in the image above, data is displayed for a one-
month time period. However, the widget can also display data for one year,
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several years, or for the entire time period. You can add intervals to a widget
by configuring the widget's properties.

The number of data points displayed in a Time Series widget is determined
by the maximum number of rows displayed in the grid on which it is based.
For steps to change the number of data points displayed in a Time Series
widget in a document, see To determine the maximum number of data points
displayed in a document, page 280.

For iPhones and iPads, you can define:

l Information Windows that display when the widget is tapped.

l A link in the widget to open a report or another document.

Prerequisites

For a Grid/Graph to be used as a Time Series widget, it must meet the
following requirements:

l At least one attribute on the rows. The attribute provides the values along
the horizontal axis of the widget, and should be time-based.

l At least one metric on the columns. The metric values are graphed in the
widget.

l To view data for multiple series, place at least one attribute on the
columns. The attribute elements are graphed on the widget's axis.

l Ensure that the row and column headers of the report are not merged.

You can add objects from multiple datasets to the Grid/Graph containing the
widget. You must have the correct privileges and the project must allow
Grid/Graphs to use multiple datasets. For steps to allow Grid/Graphs to use
multiple datasets, see the Adding Text and Data chapter of the Document
Creation Guide.
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To create and add a Time Series widget to a document

1. In MicroStrategy Web, open the document in Design or Editable Mode.

2. From the Insert menu, point to Widgets, then Mobile, and select Time
Series.

3. Click the location on your document where you want to place the
widget. The Grid/Graph containing the widget is displayed.

4. Optionally, resize the widget by clicking and then dragging its handles.

5. From the Dataset Objects panel on the left, select attributes and
metrics, and drag them on top of the widget, as described in the
prerequisites above.

Android devices can only display up to two metrics in a Time Series
widget.

To configure the widget 's display propert ies

6. Right-click the widget, then select Properties and Formatting. The
Properties and Formatting dialog box opens.

7. From the left, select Widget.

8. Click the Widget Properties icon . The Time Series Properties

dialog box opens.

To add an interval selector to the widget

Interval selectors let users select the time period for which they
want to view data in the widget, allowing them to analyze data at
different levels of detail. You can add, rearrange, or delete interval
selectors in a Time Series widget, as described below.
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9. To add an interval selector, complete the following steps:

a. Click Add. The new selector is added and displayed.

b. Type a name for the selector in the Name f ield.

c. From the Template drop-down list, select the control in the
document that contains the time-based attribute you want to use to
create the interval selector. The granularity is automatically
determined by the last (right-most) attribute on the Grid/Graph's
rows, as described above.

d. From the Interval unit drop-down list, select the units in which you
want to specify the length of the time interval. For example, to
define a six-month interval, you can select Month as the interval
unit.

e. Type the number of units you want to include in the interval in the
Interval size f ield. For example, if the Interval unit is defined as
Month, you can type 6 to specify a six-month time interval.

f. A summary of the interval selector's properties is displayed in the
bottom pane. Repeat the appropriate steps above to add additional
interval selectors.

10. You can rearrange the order in which an interval selector is displayed.
Click Move up or Move down to change the position of the selector.

11. To delete an interval selector, select the interval selector's name in the
Interval Selector l ist to the left, then click Remove. The interval
selector is removed.

To use the slider as a selector

12. You can use the slider to filter the data in your dashboard, so that only
the data selected in the slider is displayed. Select the Use slider as
selector check box.
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To format colors, labels, and the axis scale

13. Click the Formatting tab.

14. To change the background color of the widget, select a color from the
Background palette.

15. To change the color of the text and lines, select a color from the Line
and Text palette.

16. The color of each series is displayed in the Series palettes. To change
the color of a series, select a color from the corresponding palette.

17. From the Background transparency drop-down list, select a level of
transparency. The higher the percentage, the more transparent the
background is.

18. By default, axis labels are condensed, which means the widget
allocates more space to the chart area than to the labels. You can
change this behavior by clearing the Condense labels check box.

19. You can specify the minimum and maximum values of the axis, by
completing the following steps:

a. Select the Custom axis scale check box.

b. Type the Maximum axis value.

c. Type the Minimum axis value.

20. Click OK to return to the Properties and Formatting dialog box.

21. Click OK again to save changes.
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To determine the maximum number of data points displayed in a

document

Increasing the number of rows that can be displayed in a grid may affect
performance when the document is displayed.

1. Open the document containing the widget in Design or Editable Mode.

2. Right-click the widget's Grid/Graph and select Properties and
Formatting. The Properties and Formatting dialog box opens.

3. From the left, select Grid.

4. Select the Enable incremental fetch in Grid check box.

5. From the Count By drop-down list, select Individual Rows.

6. Type the maximum number of data points to display in the widget in the
Maximum number of rows per page f ield.

7. Click OK to save changes.

Downloading and playing videos: Video Player widget
On an iPhone or iPad, the Video Player widget loads and plays a video from
a remote location or from the local cache. The widget can display:

l An online video from a streaming service such as YouTube.

l An online video from a file server location.

l A cached video from the WebDAV cache, in offl ine mode. The WebDAV
cache can be populated by a manual download request.

If the mobile device is online, the Video Player widget loads the video from
the remote location, unless a local cache already exists on the device's
WebDAV cache store. Caching should be set up whenever possible.

When a user requests a video:
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1. The widget checks for a local copy stored on the device, regardless of
whether the device is connected. If a cached file is used, the widget can
start playing the video without loading the full f i le into memory.

2. If the video is not yet cached, then the widget requests the video from
the source. The video can be a streaming video, such as a YouTube
video, or a full video download file served by a web server.

l A streaming video is buffered and played as it downloads. By default,
the downloaded video file is discarded when the MicroStrategy Mobile
application is closed. You can ensure that the video is downloaded
and stored on the mobile device for offl ine use. For steps, see Pre-
caching online content on the mobile device for offl ine use.

l A file download video is downloaded fully to the client. Once the video
is fully downloaded, the video can be played. You can pre-cache the
video to download the video before the user requests it. This allows a
faster response time when the video is requested. For steps, see Pre-
caching online content on the mobile device for offl ine use.

The video is saved to the WebDAV Content Manager cache store so
that it can be shared by other instances of the Video Player widget or
the Multimedia widget. The video source URL is used as the key of the
cache so it can be matched by other requests to the same video.

You can configure the Video Player widget to use one source for online live
requests that are initiated by the user, and a second source for a full f i le that
can be downloaded and cached by a manual download request. For
example, the live source can be set to a YouTube location while the offline
cache source points to a URL that serves the full video file.

In a different scenario, such as a company that hosts its videos on its own
servers, both sources can use the same URL. For the live request, the
device directly accesses the video from the hosting web server, if a
matching cache is not found on the local cache.

For steps to configure a WebDAV folder, see the Advanced Reporting Guide.
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To create and add a Video Player widget to a document

1. In MicroStrategy Web, open the document in Design or Editable Mode.

2. From the Insert menu, point to Widgets, then Mobile, and select Video
Player.

3. Click the location on your document where you want to place the
widget.

4. Optionally, resize the widget by clicking and then dragging its handles.

5. Right-click the widget, then select Properties and Formatting. The
Properties and Formatting dialog box opens.

6. From the left, select Widget.

7. Click the Widget Properties icon . The Video Player Properties

dialog box opens.

8. Do one of the following to define the video's source:

l To stream the video:

a. Select Video streaming.

b. The Embed video HTML f ield is used for online live requests
initiated by users. Type or copy the HTML needed to embed the
video in a site. For example, the HTML for a MicroStrategy
Express demo on YouTube is:

<iframe width="560" height="315"

src="//www.youtube.com/embed/AH4Z9fEybF8"

frameborder="0" allowfullscreen></iframe>

c. The Alternate download URL is a cache source that serves the
full video file. Type the URL in the field.

l To download the video:

Mobile Analysis Guide



Copyright © 2024 All Rights Reserved 283

a. Select Video download.

b. Type the Video URL.

9. To display a thumbnail for the video, type the Video thumbnail URL.

If the video is streamed but an alternate URL is not provided, the Video
thumbnail URL field is not available.

10. Click OK to return to the Properties and Formatting dialog box.

11. Click OK to save changes.

Displaying widgets using the entire screen on mobile
devices

By default, when you add a widget to a layout in a document, the widget is
sized to take up the entire screen when displayed on an iPhone or Android
device. Any additional grids, graphs, or widgets you add to the layout are not
displayed. You can choose to display the widget without taking up the entire
screen, and allow the display of other grids, graphs, or widgets together in
the layout.

To determine whether to display a widget using the entire screen on a

mobile device

1. Open the document in Design or Editable Mode.

2. Right-click the Grid/Graph containing the widget and select Properties
and Formatting. The Properties and Formatting dialog box is
displayed.

3. From the left, select Widget. Do one of the following:
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l To size the widget to fit the entire screen, select the Full Screen check
box.

l To display the widget without taking up the entire screen, and allow the
display of other grids, graphs, or widgets in the layout, clear the Full
Screen check box.

Displaying widgets on iOS devices with a dark or light
theme

On the iPad and iPhone, you can display widgets using a dark or light theme.
To do this, change the theme of the document containing the widget. In the
image below, the date selection widget on the left uses the dark theme,
while the date selection widget on the right uses the light theme.

You can change the theme for the following widgets:

1. Map

2. Heat Map

3. Time Series

4. Date Selection

5. Survey

6. Microchart

Mobile Analysis Guide



Copyright © 2024 All Rights Reserved 285

For steps to change a document's theme, see Displaying documents on iOS
devices with a dark or light theme, page 141.
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Using l inks in docum en t s
You can create the experience of navigating through a native app by adding
links between documents. Each document becomes a page or panel in your
app, which a user can access from, for example, a button or tab bar.

You can also create links that perform actions or open other applications.
For example, a document designer can include a link that dials a store
phone number. The following topics are covered:

l Opening a device's installed applications from documents, page 287. You
can use links that interact with applications installed with mobile devices,
such as email or text messaging.

l Linking to reports and documents from a mobile document, page 294. A
link lets the user execute another document or report (the target) from a
document (the source). Parameters can be passed to answer any prompts
or set any selectors that are in the target.

l Using links to access features within the MicroStrategy Mobile application,
page 312. You can use links in a document to access specific features
within the MicroStrategy Mobile application for iPhone or iPad. Examples
are viewing a folder and emailing a screenshot of the document.

l Linking from documents with buttons and tab bars, page 316. A button can
send a user to the various screens, such as the Home screen or the Report
List, on an iPad, iPhone, or Android device. A button can open a web
page, or run a report or document. You can add a single button to a
dashboard, multiple buttons with different formatting in different locations
on the dashboard, or a bar of buttons that are all formatted the same,
called a tab bar.

l Storing links on NFC tags on Android devices, page 326. You can store a
link on Near Field Communications (NFC) tags to open a report, document,
or folder on an Android device.
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Opening a device's installed applications from
documents

A document displayed on an iPhone, iPad or Android device can interact
with the applications that are installed with the device. For example, a
document can send addresses to maps for directions or open a video. These
applications include:

l Web browser

l Email

l Phone (applicable to mobile phones only)

l SMS (applicable to mobile phones only)

l Maps

l Videos

To allow users to open an external application in a document, you must
create a hyperlink. The hyperlink connects a text field or an image to a web
page or application (the target). When the document is viewed on a device,
the user can click the control to navigate to the target.

For example, you create a document for the regional managers for a chain of
stores. This document contains information about each of the stores in the
manager's region, as shown in the image below.
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The information includes the store's address, phone number, the store
manager's email address, its inventory figures, and so on. When regional
managers view this document on their iPhones, they can:

l View a map of the store's location and get directions from their current
location

l Email the store manager

l Call the store

To create a link with a larger area that is easier to select, you can define a
link that includes both the text and the area around it, or create an image
button that users can select. To do this, you can:

l Create an image to use as the button and add a link to it.

l Insert a transparent image into the document, then enlarge and/or position
it to cover the desired link area. Link the transparent image to the target.
The user can then tap any area covered by the image to open the link. A
sample transparent image is located by default in
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C:\Program Files\MicroStrategy\Intelligence Server\

images\1ptrans.gif.

When you create a hyperlink to open an external application, you must use
the syntax outlined in the table below. Two examples are included for each
type of hyperlink. The first example replaces the italicized variables in the
syntax with specific, static text, while the second replaces it with an
attribute, so that the hyperlink can change according to the data in your
document.

To... Use This Syntax....

Email

<a href="mailto:EmailAddress">Name</a>

Examples:

<a href="mailto:jdoe@example.com">John Doe</a>

<a href="mailto:{StoreMgrEmail}">{StoreMgr}</a>

where StoreMgrEmail and StoreMgr are attributes

<a href="mailto:{Store@StoreMgrEmail}">

{Store@StoreMgr}</a>

where StoreMgrEmail and StoreMgr are attribute forms of the Store
attribute

Email with a s
ubject

<a href="mailto:EmailAddress?cc=EmailAddress&subject
=SubjectLine&body=Message">Text</a>

Example:

<a
href="mailto:jdoe@example.com?cc=msmith@example.com&su
bject
=Greetings%20from%20MicroStrategy!
&body=I%20have%20reviewed%20your%20store's%20sales%20r
esults%20and%20have
"%20the%20following%20feedback%20for%20you:>Contact
John Doe</a>

Call
(applicable to
mobile
phones only)

<a href="tel:PhoneNumber">PhoneNumber</a>

Examples:

<a href="tel:1-555-555-5555">1-555-555-5555</a>

<a href="tel:{StorePhone}">{StorePhone}</a> where
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To... Use This Syntax....

StorePhone is an attribute

Use SMS links
(applicable to
mobile phones
only)

<a href="sms:SMSNumber">Text</a>

Examples:

<a href="sms:1-555-555-5555">I'll be there soon</a>

<a href="sms:{MgrPhone}">New Message</a> where MgrPhone is
an attribute

Pass location
to Google
Maps

<a href="http://maps.google.com/maps?q=City">City</a>

Examples:

<a
href="http://maps.google.com/maps?q=Chicago">Chicago</
a>

<a href="http://maps.google.com/maps?q=

{CustomerCity}">{CustomerCity}</a>

where CustomerCity is an attribute

<a href="geo:38.915645,-77.220796">MicroStrategy

HQ</a>,
where the numbers in the link are the latitude and longitude respectively.

For links to maps.google.com on Android devices, you may be
asked to choose
whether to open the link using your default browser, or using Maps.

Get directions
from Google
Maps

<a
href="http://maps.google.com/maps?daddr=
Destination&saddr=Start
">Text</a>

Examples:

<a
href="http://maps.google.com/maps?daddr=Washington+,DC
&saddr=Chicago">Directions</a>

<a href="http://maps.google.com/maps?daddr=
{CustomerAddress}
&saddr={StoreAddress}">Directions from {StoreName} to

{CustomerName} location</a>
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To... Use This Syntax....

where CustomerAddress, StoreAddress, StoreName, CustomerName are
attributes

Open a video

Example:

<a
href="http://phobos.apple.com/WebObjects/MZStore.woa
/wa/viewAlbum?i=?id=375385132"> <img height="15"
width="61"
src="http://ax.phobos.apple.com.edgesuite.net/images/b
adgeitunes61x15dark.gif"
alt="Tech News Today"></img> </a>

Display a web
page in the
internal web
browser
(iPad)

By default,
web pages
open in Safari

WebPageURL?inApp=1

Replace WebPageURL with the URL of the web page you want to display in
the internal web browser.
If the URL contains a ? (question mark) followed by a list of parameters,
such as
http://news.google.com/news?ned=us&topic=h&output=rss ,
type & (ampersand) followed by inApp=1. For example,
http://news.google.com/news?ned=us&topic=h&output=rss&

inApp=1.

Otherwise, the URL of the web page you want to display must end with a /

(forward slash), followed by ?inApp=1. For example, to link to the Google
web page,
the URL is http://www.google.com/?inApp=1.

You use the hyperlink properties to define links to the device's applications,
as described below.

To create a hyperlink to an applicat ion on the device

1. In MicroStrategy Web, open the document in Design Mode or Editable
Mode.

2. To use a text field for the hyperlink, complete the following steps (see
the next step for instructions to add an image instead):
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a. From the Insert menu, select Text.

b. Click in the section of the document where you want to place the
text field. If you click and drag in the section, you can size the text
field.

To ensure that the area of a link is large enough to recognize a
user selecting it, make sure it has a height and width of at least
40 pixels.

c. Type the text to be displayed to users into the text field. You can
add static text, dynamic text (in the form of data fields and auto
text codes), or a combination to the text field:

l To add static text, type the static text into the text field.

l To add a data field, drag and drop a dataset object from the
Dataset Objects panel into the text field.

l To add an auto text code, from the Insert menu, select Auto-
text, then select the code to insert.

For background information about adding text to documents,
see the Report Services Document Creation Guide.

3. To use an image for the hyperlink, complete the following steps:

a. From the Insert menu, select Image.

b. Click in the section of the document where you want to place the
image. If you click and drag in the section, you can size the image.
The Properties and Formatting dialog box opens.

To ensure that the area of a link is large enough to recognize a
user selecting it, make sure it has a height and width of at least
40 pixels.
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c. Type the address of the image file to insert in the Source f ield.
Navigate to and select the image file to insert in the document.

d. Click OK. The image appears in the document.

For background information about adding images to documents,
especially to ensure that the image is available as needed, see
the Document Creation Help.

4. Right-click the text field or image that you just added, and select
Properties and Formatting. The Properties and Formatting dialog box
opens.

5. From the left, click General, then select the Is hyperlink check box.

6. In the Hyperlink f ield, delete the "http://" text that is automatically fi l led
in. Following the syntax in the table on click here, type the hyperlink
into the Hyperlink f ield. You can type static text, dynamic text (in the
form of data fields and text codes), or a combination, as described
below:

l To add static text, type the static text into the text field.

l To add a data field (that is, an object from a dataset report), type the
object's name within braces, such as {Revenue} or {Region}. The
name must match either the name of an object in a dataset or its
alias. If either name contains spaces or special characters, you must
type it in square brackets [ ] within the braces; for example,
{[Manager Name]}.

A special character is any character other than a - z, A - Z, 0 - 9, #,
_, and . (period).

l To add an auto text code (that is, document and dataset report
information), type the code within braces. As with data fields, if an
object's name contains spaces or special characters, enclose it in
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square brackets within the braces. For background information about
available auto text codes, see the Document Creation Help.

7. Click OK to return to the document. Notice that the text field is now
underlined, indicating that it is a hyperlink.

Linking to reports and documents from a mobile
document

A link is a connection in a document to another document or a report. A link
lets a user execute another document or report (the target) from a document
(the source), and to pass parameters to answer any prompts that are in the
target. You can link from a text field, an image, or a button.

For example, if a user is viewing a document containing regional sales, he
can select a particular region to execute another document that displays
sales for the stores in that region. This is a form of dril l ing, where the user
has dril led from region to store. If the document contains a selector, the user
can select a specific region in the selector, then tap a link to another
document that displays sales for the months in that year. The source
document could also link to the underlying dataset report, to display profit
and cost values as well.

Most links can be created using the Link Editor. If you want to specify the
page-by or report view (grid or graph) of a report, or specify the layout or
grouping of a document, use the hyperlink properties and create the link
URLs manually, by using the object ID and link syntax. For steps to create
links using the Link Editor, see Creating a link for a mobile document, page
295. For steps to create links using manual URLs, see Creating a link URL to
specify page-by, report view, layout, or grouping for the target, page 305.

Links you can create for iOS devices
You can use links to do the following on an iPhone or iPad:
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l Execute a report, specifying the page-by, prompt answers, and report view
(grid, graph, or both grid and graph).

l Execute a document, specifying the layout, grouping, prompt answers, and
selector values.

l A multi-layout document contains multiple documents, each in its own
layout, creating a "book" of documents. Each layout functions as a
separate document, with its own grouping, page setup, and so on, but
the layouts are generated into a single PDF document.

l Grouping a document helps users understand the data better. Grouping
the data sets up a type of hierarchy within the document, and an
inherent or implied sort order for the data.

You can change the grouping or layout for the currently displayed
document, or for a target document. If you change the grouping or layout
for the currently displayed document, you stil l must use the entire link
URL, including the document ID, event parameter, and so on.

l Reprompt a report or document.

l Display the Home screen, Shared Library, Report List, Settings screen,
Status screen, or Help screen.

Links you can create for Android devices
You can use links to do the following on an Android device:

l Execute a report, specifying whether it is displayed as a grid, a graph, or
both a grid and graph

l Execute a document

l Run a report or document from a different project or server

Creating a link for a mobile document
Prerequisites
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l The source document and any target reports/documents must be created.

l If the target report/document contains prompts, you must know what types
of prompts the targets require and how they will be answered by the link
(or by the user). For details on each prompt answer method, see
Specifying how prompts are answered in the target, page 302.

l If you want to pass selector values from the source document to the target
document, both the source and the target must contain the same selector.
This means that either both documents must contain a selector with the
same name (such as Region Selector), or both documents must contain a
selector that uses the same source object (such as Region).

To create a link for a mobile document

1. In MicroStrategy Web, open the document in Design Mode or Editable
Mode.

2. You can link from a text field, an image, or a button. Do one of the
following:

l To link from a text field, complete the following steps:

a. From the Insert menu, select Text.

b. Click in the section of the document where you want to place the
text field. If you click and drag in the section, you can size the
text field.

To ensure that the area of a link is large enough to recognize a
user selecting it, make sure it has a height and width of at least
40 pixels.

c. Type the text to be displayed to users into the text field. You can
add static text, dynamic text (in the form of data fields and auto
text codes), or a combination to the text field:
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o To add static text, type the static text into the text field.

o To add a data field, drag and drop a dataset object from the
Dataset Objects panel into the text field.

o To add an auto text code, from the Insert menu, select Auto-
text, then select the code to insert.

For background information about adding data fields and auto
text codes to documents, see the Document Creation Help.

d. Right-click the text field, and select Edit Links. The Links dialog
box opens.

l To link from an image, complete the following steps:

a. From the Insert menu, select Image.

b. Click in the section of the document where you want to place the
image. If you click and drag in the section, you can size the
image. The Properties and Formatting dialog box opens.

To ensure that the area of a link is large enough to recognize a
user selecting it, make sure it has a height and width of at least
40 pixels.

c. Type the address of the image file to insert in the Source f ield.

d. Click OK. The image appears in the document.

For background information about adding images to documents,
see the Report Services Document Creation Guide.

e. Right-click the image, and select Edit Links. The Links dialog
box opens.

l To link from a button, complete the following steps:
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a. Create the button, as described in Linking from documents with
buttons and tab bars, page 316.

b. Right-click the button, and select Properties and Formatting.
The Properties and Formatting dialog box opens.

c. Click to configure actions on the button. The Links dialog

box opens.

3. In the Links dialog box, if other links already exist on this document,
click the New icon to create a new link.

4. Type a name for the link in the URL display text f ield. Since the name
appears in the link, it should be descriptive and informative to help
users identify the target of the link.

5. Perform the appropriate steps below, depending on whether you are
linking to a web page or to a report/document:

l To link to a web page:

a. Select Navigate to this URL. This option is available only if you
selected to create a link from a text field or image.

b. Type the target URL in the field below Navigate to this URL.

c. Continue this procedure at To define additional links and
determine link behavior, page 301.

l To link to a screen on the mobile device:

a. Select Perform this.

b. From the Perform this drop-down list, select the screen to link
to.

c. Continue this procedure at To define additional links and
determine link behavior, page 301.
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l To link to a report or document:

a. Select Run this report or document.

b. Click the browse button (...) below Run this report or
document to find and select the target report or document.

To app ly p r om pt answer s t o t ar get s t hat con t ain p r om pt s

1. In MicroStrategy Web, open the document in Design Mode or Editable
Mode.

2. The box below Run this report or document contains a list of any
prompts included in the target report/document. Select a target prompt
from the box.

3. Select a prompt answer method from the drop-down list. For examples
of each prompt answer method, see Specifying how prompts are
answered in the target, page 302.

l Answer with the same prompt from the source: Select this option
if you want to use the same prompt answers for both the source report
and the target report/document. This option requires that both the
source and target documents use the same prompt.

l Prompt user: Select this option if you want the user to type prompt
answers after he taps the link to run the target report/document.

l Answer with an empty answer: Select this option if you want to
ignore the prompt in the target report/document. The prompt is not
answered. This option requires that the prompt in the target is not
required. If the prompt in the target is required, the user is prompted
to provide an answer.

l Use default answer: Select this option if you want the prompt in the
target to use the default answer defined by the prompt's designer.
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This option requires that a default answer is defined for the prompt in
the target.

The following methods are not intended to be used with buttons. For a
button, use one of the previous methods.

l Answer dynamically: Select this option if you want to answer the
prompt using the object selected in the source. This option is only
available for attribute element prompts and value prompts.

l Answer using current unit: Select this option if you want to answer
the prompt using the object selected in the source. This option is only
available for hierarchy prompts.

l Answer using all valid units: Select this option if you want to
answer the prompt in the target with any object to the left of or above
the object that the user selects in the source document. This method
passes all pertinent selections in the source, rather than just the
selection made for the link. This option is available only for hierarchy
prompts.

4. For each prompt in the target report/document, repeat the step above.

To speci f y t he p r om pt answer m et hod fo r p r om pt s no t in t he l ist

1. In MicroStrategy Web, open the document in Design Mode or Editable
Mode.

2. The box below Run this report or document contains a list of any
prompts included in the target report/document.

3. Any other prompts are those prompts that are not in the target
report/document when you are creating the link. For example, these
prompts can include prompts added to the target later. By default, the
Prompt user answer method is selected for these prompts, but you can
change the method. To do this, follow the steps below:
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a. Select Any other prompts in the list.

b. Select a prompt answer method from the list; these are the only
methods available for the Any other prompts option. For examples
of each answer method, see Specifying how prompts are answered
in the target, page 302.

l Answer with the same prompt from the source

l Prompt user (default)

l Answer with an empty answer

l Use default answer

To app ly select o r values t o a t ar get docum en t t hat con t ains select o r s

1. In MicroStrategy Web, open the document in Design Mode or Editable
Mode.

2. Choose a selector value method from the Pass all selector values
drop-down list. For an example of passing selector values, see Passing
selector values from the source to the target, page 304.

l To match selector values by the selector's source attribute (that is,
the object displayed in the selector), select Match Selectors by
Source Attribute.

l To match selector values by the name of the selector, select Match
Selectors by Control Name.

To def ine add i t ional l inks and det er m ine l ink behavio r

1. Repeat the steps above if you want to create additional links. You can
create multiple links on the same object.

2. Select the Open in new window check box to have the target
report/document open in a new window. This allows the target and the

Mobile Analysis Guide



Copyright © 2024 All Rights Reserved 302

source documents to be visible simultaneously. If this check box is
cleared, the target report/document or web page opens and replaces
the source document.

3. If the object has more than one link, select the link that you want to
make the default l ink, and click the Set as Default icon . When a

user taps the object, the default l ink is automatically used. To access
other links, the user tabs and holds the object, which displays a list of
links that he can choose from.

4. Click OK to return to the source document and to save your link.

Specifying how prompts are answered in the target

This section contains only a brief overview of prompt answer methods. For
more detailed descriptions of the different prompt answer methods,
including examples, see the Linking Documents chapter of the Document
Creation Help. For background information on prompts, see the description
of prompt types in Building Query Objects and Queries chapter in the Basic
Reporting Help.

To pass parameters to the target, the target must contain a prompt. When
you create a link, you define how the target's prompt is answered, by
selecting one of the following prompt answer methods:

l Answer with the same prompt from the source. The same prompt
answers that were used to execute the source are used in the target. This
option requires that the source and target use the same prompt. If the
same prompt does not exist in the source and in the target, the user is
prompted to provide an answer when the target is executed.

l Prompt user. When the target is executed, the user is prompted to
provide answers manually.

l Answer with an empty answer. The prompt in the target is ignored,
which means that the prompt is not answered. No prompt answer is
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provided from the source and the user is not prompted to provide answers.

The prompt must not be required, because if the prompt is required, the
user is prompted to provide an answer when the target report is executed
by clicking the link.

The Answer with an empty answer method, when used in conjunction
with the dynamic prompt answer method, allows a source document to
answer one prompt in a target with the user selection, while ignoring any
other prompts.

l Use default answer. The prompt is answered by the default prompt
answer for the prompt in the target. If the target prompt does not have a
default answer, the Answer with an empty answer method is used. In
this case, the prompt is not answered, unless it is required, in which case
the user is prompted to provide an answer.

The following prompt answer methods are not intended to be used with
buttons, since a button does not select an object in the source. If you use
one of them with a button, the user is prompted for an answer. For a button,
use one of the methods described above.

l Answer dynamically. The object selected in the source is passed to the
prompt in the target. If this object does not answer the target prompt, the
Answer with an empty answer method is used. In this case, the prompt
is not answered, unless it is required, in which case the user is prompted
to provide an answer.

Available only for attribute element prompts and value prompts.

l A hierarchy prompt allows users to select prompt answers from one or
more attribute elements from one or more attributes. This prompt gives
users the largest number of attribute elements to choose from when they
answer the prompt to define their fi ltering criteria. The Answer using all
valid units prompt answer method passes selections made on the source
document, rather than just the selection made for the link, to the target. To
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restrict the prompt answer to just the selected attribute element, use the
Answer using current unit prompt answer method. Like the Answer
dynamically method, only the attribute element that is selected is passed
to the target.

These two prompt answer methods are available only for hierarchy
prompts.

l Answer using current unit. The prompt is answered using the object
selected in the source. If the user selects an attribute header rather than
a specific attribute element, the Answer with an empty answer method
is used. In this case, the prompt is not answered, unless it is required, in
which case the user is prompted to provide an answer.

l Answer using all valid units. Any object to the left of or above the user
selection in the source is used as the prompt answer for the target. In
other words, this method passes all the selections made on the source,
rather than just the selection made for the link. If the user does not
select any valid objects (for example, the user selects an attribute
header rather than a specific attribute element), the Empty answer
method is used. That is, the prompt is not answered, unless it is
required, in which case the user is prompted.

You can select a prompt answer method for prompts that are not in the
target when you are creating the link. These can be either:

l Prompts added to the target after the link is created

l Prompts that are created as the result of an answer to one of the original
prompts in the target, such as a prompt-in-prompt answer

These prompts are listed as the Any other prompt option in the list of
prompts in the Link Editor.

Passing selector values from the source to the target
A selector allows each user to interact with a document to display only the
subset of data that he is interested in or only specific attribute elements or
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metrics.

The selector values that the user chooses in the source document can be
passed to the selectors in the target document.

For example, the Regional Revenue document contains a selector for
Region, so that the user can view revenue for a specific region. The
document contains a link to the Category Revenue by Region document,
which also contains a Region selector. If you select Central in the selector,
only the Central region, with its revenue, is displayed in the document. If you
tap the link for the Category Revenue by Region document, that document is
displayed. The selector is set to Central, the same as the selector in the
Regional Revenue document. Only Central's data is displayed, by category.

To pass selector values from the source document to the target document,
both the source and the target must contain the same selector. This means
that either both documents must contain a selector with the same name
(such as Region Selector), or both documents must contain a selector that
uses the same source object (the object displayed in the selector, such as
Region). When you create a link that passes selector values, you can
choose to match the selector values either by the selector name or the
source object.

Creating a link URL to specify page-by, report view, layout, or
grouping for the target
The Link Editor provides a quick and easy way to link to documents and
reports. For steps to create a link using the Link Editor, see Creating a link
for a mobile document, page 295.

For a document on an iPhone or iPad, you can specify a report's page-by or
report view, or a document's layout or grouping. For a document on an
Android device, you can specify a report's report view. (The report view is
whether a report is displayed as a grid, a graph, or both a grid and graph.)
To specify these parameters, use the hyperlink properties and create the
link URLs manually, by using the object ID and link syntax, as described
below.
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Prerequisites

Before creating links, create any target documents and reports, and use the
following procedure to obtain their IDs:

1. Navigate to the folder location of the report or document.

2. Right-click the report or document, and select Properties. The
Properties dialog box is displayed, with the object's ID displayed in the
ID field. You can highlight and copy this ID to use in a link URL.

To create a link using a manual URL

1. In MicroStrategy Web, open the document in Design Mode or Editable
Mode.

2. To use a text field for the hyperlink, complete the following steps (if you
are adding an image, skip this step):

a. From the Insert menu, select Text.

b. Click in the section of the document where you want to place the
text field. If you click and drag in the section, you can size the text
field.

To ensure that the area of a link is large enough to recognize a
user selecting it, make sure it has a height and width of at least
40 pixels.

c. Type the text to be displayed to users into the text field. You can
add static text, dynamic text (in the form of data fields and auto
text codes), or a combination to the text field:
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l To add static text, type the static text into the text field.

l To add a data field, drag and drop a dataset object from the
Dataset Objects panel into the text field.

l To add an auto text code, from the Insert menu, select Auto-
text, then select the code to insert.

For background information about adding data fields and auto-
text codes to documents, see the Document Creation Help.

3. To use an image for the hyperlink, complete the following steps:

a. From the Insert menu, select Image.

b. Click in the section of the document where you want to place the
image. If you click and drag in the section, you can size the image.
The Properties and Formatting dialog box opens.

To ensure that the area of a link is large enough to recognize a
user selecting it, make sure it has a height and width of at least
40 pixels.

c. Type the address of the image file to insert in the Source f ield.

d. Click OK. The image appears in the document.

For background information about adding images to documents,
see the Document Creation Help.

4. Right-click the image or text field, and select Properties and
Formatting. The Properties and Formatting dialog box opens.

5. From the left, click General, then select the Is Hyperlink check box.

6. Type the link URL in the Hyperlink f ield:

l To have the link execute a document, use the syntax:
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http://

MSTRMobileURL

?&src=

source

&evt=2048001&currentViewMedia=2&documentID=objectID

l To have the link execute a report, use the syntax:

http://

MSTRMobileURL

?&src=

source&evt=4001&reportViewMode=view&reportID=objectID

l To add additional parameters to the URL, such as providing answers
for the target document's prompts, see Using links to display
document layouts and group data, and run reports and documents on
other servers and projects, page 309.

Replace the italicized variables, as listed in the following table:

Variable Replace With

MSTRMobileURL

To use an absolute path to your Mobile Server, use one of the
following:

• For .NET

MobileServer/MicroStrategy/asp/Main.aspx

• For J2EE

MobileServer/MicroStrategy/servlet/mstrWeb

Replace Mobileserver with the name of your MicroStrategy
Mobile Server.

To use a relative path to your Mobile Server, use mstrWeb.

source
The page component that should handle the action and the
event:
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Variable Replace With

• For a document using J2EE format, mstrWeb.2048001

• For a document using .NET format, Main.aspx.2048001

• For a report using J2EE format, mstrWeb.4001

• For a report using .NET format, Main.aspx.4001

view

Report view mode:

• For grid view: 1

• For graph view: 2

• For grid and graph view: 3

objectID The object ID of the target document or report

7. Click OK to return to the document.

Using links to display document layouts and group data, and run
reports and documents on other servers and projects

Once you have created a link to run a report or a document on an iPhone or
iPad, you can add parameters to the URL to perform additional tasks, such
as providing answers for prompts in the linked document, or specifying the
layout to display when a document is run.

For Android and iOS devices, you can run reports or documents from a
different project or server. The project or server that you link to must be
defined in the mobile configuration for the device.

The table below lists the tasks you can perform, and the syntax for the link
parameters to perform them. You can add these parameters to a link URL by
separating each parameter with an ampersand (&). The link parameters are
case sensitive. For example, the following URL contains parameters to
display the first layout in a document:

Main.aspx?evt=2048001&currentViewMedia=2&documentID=E8663

E7A4D8CDF05C060129D0061692&layoutIndex=0
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Task Syntax

Run a report
or document
from a
different
project or
server

Server=

servername

&Project=projectname&uid=username&pwd=password

Replace servername, projectname, username, and password with
the name of the server, project, and the login name and password to use
to log in respectively.

By default, if the URL does not specify a server and project, the current
server and project are used. You can specify these parameters, called
session parameters, to execute a report or document in a different server
or project, and provide the appropriate login name and password.

For more information on session parameters, see the Customizing
MicroStrategy Web section in the Web SDK help, which is available from
the SDK page in MicroStrategy Community.

Display a
specific
layout in a
document

layoutIndex=layout

Replace layout with the number of the layout you want to display. The
first layout in the document is 0, the second is 1, and so on.

Specify the
group-by
element in a
document

groupByElements=

groupByUnitID;groupByUnitType;groupByElementID

Replace the italicized variables with the following:

• groupByUnitID: The ID of the group-by attribute or consolidation.
You can use {&AttributeName@GUID}, to provide the ID
automatically. Replace AttributeName with the name of the attribute
or consolidation.

• groupByUnitType: Use 12 for an attribute, or 47 for a consolidation.

• groupByElementID: The ID of the group-by element. You can use
{&AttributeName@LongElementID}, to provide the ID
automatically. Replace AttributeName with the name of the attribute
or consolidation.

You can specify multiple group-by elements by separating each set of
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Task Syntax

group-by parameters with a caret (^), as follows:

groupByElements=

groupByUnitID1

;

groupByUnitType1

;

groupByElementID1

^groupByUnitID2;groupByUnitType2;groupByElementID2

Specify the
page-by
element in a
report

pageByElements=

pageByUnitID;pageByUnitType;pageByElementID

Replace the italicized variables with the following:

• pageByUnitID: The ID of the page-by attribute or consolidation. You
can use {&AttributeName@GUID}, to provide the ID automatically.
Replace AttributeName with the name of the attribute or
consolidation.

• pageByUnitType: Use 12 for an attribute, or 47 for a consolidation.

• pageByElementID: The ID of the page-by attribute or consolidation.
You can use {&AttributeName@LongElementID}, to provide the ID
automatically. Replace AttributeName with the name of the attribute
or consolidation.

You can specify multiple page-by elements by separating each set of
page-by parameters with a caret (^), as follows:

pageByElements=

pageByUnitID1

;

pageByUnitType1

;

pageByElementID1

^pageByUnitID2;pageByUnitType2;pageByElementID2
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Task Syntax

For information about finding the ID of an individual attribute element, see
To obtain the ID of a specific attribute element in a document, page 312.

To obtain the ID of a specific attr ibute element in a document

1. To obtain the ID of a specific element in an attribute, you must first
obtain the ID of the attribute. Navigate to the folder location of the
attribute.

2. Right-click the attribute, then select Properties. The Properties dialog
box is displayed, with the attribute's ID displayed in the ID field.

3. Highlight the ID, then copy it to the clipboard.

4. Open the document that contains the attribute in Editable Mode.

5. Right-click the header of the attribute in the Grid/Graph, then point to
Attribute Forms, and select ID. The ID of each element in the attribute
is displayed.

6. The full attribute element ID is the ID of the element's attribute,
followed by a colon (:) and the ID of the element displayed in the grid.
For example:

8D679D4B11D3E4981000E787EC6DE8A4:2

Using links to access features within the
MicroStrategy Mobile application

You can use links in a document to access specific features within the
MicroStrategy Mobile application for iPhone or iPad. For example, you can
add a link to display the My Reports folder or email a screenshot of the
document.
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You can use the Link Editor to quickly create the following links, instead of
typing the URL into a hyperlink, to display the:

l Help

l Home screen

l Report List

l Shared Library

l Status screen

l Settings screen

For steps, see Creating a link for a mobile document, page 295.

The procedure to create the following hyperlinks is identical to that for
creating hyperlinks to the device's installed applications. For steps, see To
create a hyperlink to an application on the device, page 291.

The table below lists the types of links you can create, and the URL to use to
create them.

Task URL

View a folder
mstr://?evt=2001&folderID=foldernumber

Replace foldernumber with the ID of the folder you want to display.

Display the
Shared Reports
folder

mstr://?evt=2001&systemFolder=7

Display the My
Reports folder

mstr://?evt=2001&systemFolder=20

Email a
screenshot of
the document

mstr://?evt=3037

The screenshot is added to the email as an attachment. To add a
subject to the email, add &emailSubject=subject to the end of the
URL, then replace subject with the subject. For example, to send an
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Task URL

email with the subject "Your requested report", type
mstr://?evt=3037&emailSubject=Your+requested+report .

Annotate and
Share the report
or document

mstr://?evt=3175

Print the current
document

mstr://?evt=3103

Print a target
document

mstr://evt=2048001&src=

source

.2048001&visMode=0&currentViewMedia=20&documentID=objectID

Where:

source is the page component that should handle the action and the
event.

objectID is the object ID of the target document.

Display the Help mstr://?evt=3994

Display the
Home screen

mstr://?evt=3995

Display the
Shared Library

mstr://?evt=3996

Display the
Reports or
Subscriptions
screen, as
applicable

mstr://?evt=3997

Display the
Status screen

mstr://?evt=3998

Display the
Settings screen

mstr://?evt=3999
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Task URL

Log out the user mstr://?evt=4000

Return to the
previously
viewed
document

mstr://?evt=3124

Select a specific
panel in a panel
stack

mstr://?evt=2048076&psName=PANEL_STACK_NAME&pName=PANEL_
NAME

Replace the italicized variables as follows:

PANEL_STACK_NAME: The name of the panel stack to target

PANEL_NAME: The name of the panel to select

To select panels from multiple panel stacks, use the following format:

mstr://?evt=2048076&psKey=
PanelStack1|PanelStack2|…&pKey=PanelK1|PanelK2|…

Replace the italicized variables as follows:

PanelStack1, PanelStack2, etc.: The names of the panel stacks to
target.

PanelK1, PanelK2, etc.: The names of the panels to select, in the
order of the panel stack. For example, PanelK1 is a panel in
PanelStack1.

Display a
specific
Information
Window

mstr://?evt=2048500&panelName=Name

Replace Name with the name of the panel stack you have created to
use as the Information Window.

Display a
selection screen
that allows you
to specify the
element to use
to group data

mstr://gb/?e={&AttributeName@ElementID}&a=
{&AttributeName@GUID}&s=style

Replace AttributeName with the name of the attribute you want to
use to group data. Replace style with one of the following:

To display the attribute elements in a directory-like list: 0

To display the attribute elements on a wheel: 1

Re-prompt the
document

mstr://pr
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Linking from documents with buttons and tab bars

A button can send a user to the various screens, such as the Home screen or
the Report List, on an iPad, iPhone, or Android device. A button can run a
report or document, or open a web page or Information Window. An
Information Window lets users view additional information in a pop-up
window. In MicroStrategy Web, a button can open a web page, or run a
report or document.

For example, the document shown below contains several buttons. Notice
that all the buttons are displayed in white.

A button can change its appearance after a user taps it. When a user taps
the Customer button, for example, the button changes to blue, as shown
below. This is referred to as its highlight state. The button's initial state
(when it is not selected) is referred to as its normal state.

A customer analysis document is displayed. If a user tapped the Sales
Analysis button instead, a regional sales document is displayed. If a user
taps the button with the envelope, the email program is launched.
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The different button styles determine whether a caption, icon, or both are
displayed. A caption is the text that describes the button's action. The icon
is a small image that represents the button's action. If both a caption and an
icon are displayed, the button style also determines where the caption and
icon are located in relation to each other. The icon can be to the left or the
right of the caption, or it can be above the caption.

You can also select the custom style, which allows you to select an image to
display as the button. The image can be any shape, size, and color. The
image is displayed on your mobile device without any additional formatting.
You can use two different images, one for the normal state and the other for
the highlighted state. The example above uses custom style buttons.

Each button can have more than one link. The same button can be linked to
multiple web pages, reports, and documents. If a default l ink has been
defined, that link is executed when the button is tapped. To open a list of
links, tap and hold the button. If a default l ink has not been defined, tapping
the button opens the list of links.

You can add a single button to a document, or add multiple buttons with
different formatting in different locations on the document; see Creating a
button to link from a Mobile document, page 322 for steps. For documents
displayed on an iOS device, you can create a bar of buttons that are all
formatted the same, called a tab bar. A tab bar displays at the bottom of the
screen, similar to tab bars in other iOS applications.

You create the tab bar as a navigation document, which contains only the
tab bar. This allows the tab bar to display all the time, even when a user
changes panel stacks or layouts on a document, or switches to a different
document. In effect, you are creating a navigation system for the set of
Mobile documents that are linked with the tab bar. The tab bar is shown only
when navigating the documents linked in the tab bar. The tab bar is not
displayed if either of the following cases:
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l A user opens a linked document from a folder, not from the navigation
document or tab bar.

l A user opens a document that is not linked in the tab bar.

The navigation document becomes the home page or launch site for this set
of documents. When a user opens the navigation document, the tab bar and
the document linked in the first button are displayed.

For example, a navigation document, called Store Dashboards, has been
created for a project. The user opens Store Dashboards, and the Overview
dashboard is displayed, along with the tab bar, as shown below:

Notice that the button for Overview is selected in the tab bar. The user taps
the button for Customer, which causes that document to display, as shown
below:
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Notice that the button for Customer is selected in the tab bar, and there is no
Back button at the upper left.

Creating a tab bar to hold buttons
A tab bar is a bar of navigation buttons, displayed at the bottom of an iOS
document. The tab bar is displayed all the time, even when a user changes
panel stacks or layouts on a document, or switches to a different document.
In effect, you are creating a navigation system for a set of Mobile
documents.

You create the tab bar as a navigation document, which contains only the
tab bar. You can customize the background tint of the tab bar, and the color
of the selected button's icon (the highlight state). When the tab bar is
displayed on a mobile device, the caption and icon colors use a generic iOS
format to enhance readability. In the examples above, the background of the
tab bar has a tint of black, with the selected button's icon highlighted in blue.
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The selected button's caption is automatically displayed in white, while the
captions of the other buttons automatically remain gray.

You can add buttons to the tab bar, remove buttons from the tab bar, and
move the buttons around on the tab bar. For each button on the tab bar, you
define the link and the icon. If you define more than five buttons for an
iPhone document or eight for an iPad document, a button labeled More is
automatically added to the tab bar.

Take into account the height of the tab bar, which is 49 points, when you
design a document that will be linked from a tab bar.

Best pract ices for creat ing the button image

The button's image is used by iOS to create the icon that is displayed in
Mobile, so you do not need to create a full-color image for the button. Some
best practices to create the image for the button include:

l Use pure white with the appropriate alpha transparency.

l Do not use a drop shadow.

l Use anti-aliasing.

l Bevels should be 90°. The bevel should look like a light source is
positioned at the top of the image.

To ensure that the tab bar icon renders sharply on devices with different
resolutions, follow these suggestions:

l If you are designing the tab bar to be displayed on a high-resolution (retina
display) device, design your button icon to be about 60 x 60 pixels. Add
the text @2x as the suffix of the image name, for example, icon@2x.jpg.
For devices with high-resolution screens, such as the iPhone 6 Plus and
newer, use the suffix @3x. The image is shown as designed on a high
resolution device, without any stretching or shrinking at the pixel level. On
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low resolution devices, the image is scaled to support the lower resolution.

l If you are designing the tab bar for low-resolution devices, design your
button icon to be about 30 x 30 pixels. Do not include the @2x suffix in the
image name. The image is shown as designed on low resolution devices,
without any stretching or shrinking at the pixel level. On high resolution
devices, the image is scaled to four times its original size at the pixel
level, causing the image to look blurry.

To add a tab bar for an iPad or iPhone document

1. In MicroStrategy Web, click the MicroStrategy icon at the top of any

page and select New Document. The Create Document page opens.

2. Select either Navigation for iPad or Navigation for iPhone, and click
OK. The Document Editor opens in Design Mode. A tab bar is already
displayed in the document template, with two buttons, in the Document
Footer. No other document sections are available.

To select the tab bar's colors

3. Right-click the tab bar (not a button) and select Properties and
Formatting. The Properties and Formatting dialog box opens.

4. From the left, select Color and Lines.

5. From the Color drop-down list, select the tint of the tab bar's
background.

6. From the Highlight state color drop-down list, select the color of a
button's icon after it is tapped. All buttons on the tab bar use the same
color in their highlight state (after being tapped).

7. Click OK to save your changes and return to the document.
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The tab bar and buttons do not change color in Design Mode; the colors
apply when the document is displayed in MicroStrategy Mobile.

Now you can add buttons to the tab bar, as described in Creating a button to
link from a Mobile document, page 322 below. You can add as many buttons
as necessary. If you define more than five buttons for an iPhone document
or eight for an iPad document, a button labeled More is automatically added
to the tab bar.

Creating a button to link from a Mobile document
Prerequisites

l If you are adding a button to a tab bar, you must have already created the
tab bar. For steps, see Creating a tab bar to hold buttons, page 319.

l If you are using an icon on the button, you need to know the location of the
images to be used. You can specify a single image, or you can specify an
image to display before the button is tapped and a different image after it
is tapped. If the button is part of a tab bar, the images should be
monochromatic for the best display.

To add a button

1. In MicroStrategy Web, open the document in Design Mode or Editable
Mode.

2. You can add a stand-alone button or add a button to a tab bar:

l To add a stand-alone button, from the Insert menu, point to Button,
and then select a style. When you move the cursor to the Layout area,
the pointer becomes crosshairs. Click in the desired location in the
Layout area to add a button of the default size. If you click and drag in
the Layout area, you can size the button.
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l To add a button to a tab bar, click the Add Button icon on the tab

bar. A new button is added to the tab bar, with the correct size.

3. If the selected button style displays a caption, double-click the caption
text box. Type the caption to display, and press ENTER.

4. Right-click the button, and select Properties and Formatting. The
Properties and Formatting dialog box opens.

5. From the left, select Button.

You can change the button style, if the button is stand alone.

6. If the selected button style displays an icon or a custom image, specify
the source of the images.

l The normal state is displayed before the user taps it. Type the
location and file name of the image to display in the normal state, in
the Normal state source f ield.

l The highlighted (or selected) state is displayed after the user taps it.
Type the location and file name of the image to display in the
highlighted state, in the Highlight state source f ield.

If the button is displayed in a tab bar, the images should be
monochromatic.

7. If the button style is set to Caption only, you can determine whether the
button is displayed as highlighted only:

l To display the button as highlighted only after a user taps it, clear the
Show button in highlight state by default check box.

l To display the button as highlighted only, select the Show button in
highlight state by default check box. When a user taps the button,
the action is triggered, but the button does not change.

8. Click OK to save your changes and return to the document.
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Next, you define the link or the Information Window for the button. For steps
to define the link, see Creating a link for a mobile document, page 295. For
steps to define an Information Window, see Providing additional information
to users: Information Windows, page 149.

Formatting a stand-alone button

To format a stand-alone button, you can:

l Size the button

l Select the button's background color before and after it is tapped

l Select whether to display a border around the button when the document
is viewed in MicroStrategy Web

l Format the font of the button's caption

l Select the button's caption font color before and after the button is tapped

This formatting applies to a stand-alone button, because a tab bar specifies
the same formatting for all of its buttons. Steps to format the tab bar's colors
and the caption's font are included in the procedure to create a tab bar; see
To add a tab bar for an iPad or iPhone document, page 321. For a button
with a custom style, you can size the button, but all other formatting comes
from the image that you select.

Prerequisite

Before you can format a stand-alone button, you must have created the
button. For steps, see Creating a button to link from a Mobile document,
page 322.

To format a stand-alone button

1. In MicroStrategy Web, open the document in Design Mode or Editable
Mode.
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2. Right-click the button and select Properties and Formatting. The
Properties and Formatting dialog box opens.

To size the button

3. From the left, select Layout.

4. In the Size area, type the Width and Height in the fields. The icon and
caption, if both are used, are automatically resized to maintain their
proportions in the button.

To select the button's colors

These options are unavailable for a button with a custom style, since
the image is displayed as is.

5. From the left, select Color and Lines.

6. From the Style drop-down, select one of the following:

l Flat

l Glossy

7. From the Normal state color drop-down, select the button's color
before it is tapped.

8. From the Highlight state color drop-down, select the button's color
after it is tapped.

9. Determine whether the button has a border, by doing one of the
following:

l To hide borders, select None.

l To display borders, select All. From the drop-down list, select the
color of the borders around the button.
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To format the caption's font

These options are unavailable for a button with a custom style, since
the image is displayed as is.

10. From the left, select Font.

11. Select the Font, Style, and Size of the caption text.

12. From the Normal state color drop-down, select the caption's color
before the button is tapped.

13. From the Highlight state color drop-down, select the caption's color
after the button is tapped.

14. Click OK to save your changes.

Storing links on NFC tags on Android devices

You can store a link on Near Field Communications (NFC) tags to open the
Home screen, Settings screen, Help screen, or the contents of the Shared
Library folder on an Android device through MicroStrategy Mobile. An NFC
tag is a small piece of hardware that broadcasts short-range wireless signals
to compatible devices. When a Mobile user places her NFC capable Android
device within the required range of the NFC tag, a link is broadcast to her
device. This link opens MicroStrategy Mobile on the Android device and
displays the specified screen.

A Mobile user can only view the projects that her device has been
configured to access. When creating a link for NFC tags, ensure that your
target audience is using a mobile configuration that provides access to the
specified report, document, or folder.

To store a link on your NFC tags, use a third-party NFC programming app on
an NFC capable Android device. The table below lists the types of links you
can create on NFC tags, and the URL to use to create them. The URLs in the
table open the default MicroStrategy Mobile application. If your organization
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has a customized version of MicroStrategy Mobile, replace mstr:// with
your customized URL prefix.

Task URL

Display the Home screen mstr://?evt=3995

Display the Settings screen mstr://?evt=3999

Display the Help screen mstr://?evt=3994

Display the contents of the Shared Library folder mstr://?evt=3996

Display the previously viewed screen (Back) mstr://?evt=3124
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